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About this Guide
Welcome to HP SOA Systinet, the foundation of Service Oriented Architecture, providing an enterprise
with a single place to organize, understand, and manage information in its SOA. The standards-based
architecture of SOA Systinet maximizes interoperability with other SOA products.

HP Software controls access to components of SOA Systinet with a license. This document
describes the full functionality of SOA Systinet including licensed components. If your license
does not include these licensed components, their features are not available.

In this Guide
SOA Systinet User Guide describes the features and functionality of the product for normal users. It is
organized according to the user interface – a part for the common UI features and then a part for the features
and functionality of each tab.

This guide describes the default installation of SOA Systinet. The format and content of each
tab can be modified using HP SOA Systinet Customization Editor. All screenshots in this
guide are from the Service Publisher perspective.

The Administrator perspective displays additional functionality.

For details, see the HP SOA Systinet Administrator Guide.

The General perspective may not display all the functionality described in this guide.

This guide contains the following parts:

• Part I, “Getting Started”

An introduction to the features of the user interface and the common tasks that can be accessed from all
pages.
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• Part II, “Dashboard”

The features of the Dashboard and the tasks performed there.

• Part III, “Services”

A guide to the Services tab and the creation and management of services, lifecycles, and contracts.

• Part IV, “Policies”

Describes the Policies tab and the use and management of policies.

• Part V, “Tools”

A guide to the Tools tab and the governance and repository content management features accessed from
it.

Document Conventions
This document uses the following typographical conventions:

Script name or other executable command plus mandatory arguments.run.bat make

Command-line option.[--help]

Choice of arguments.either | or

Command-line argument that should be replaced with an actual value.replace_value

Choice between two command-line arguments where one or the other is
mandatory.

{arg1 | arg2}

User input.java -jar hpsystinet.jar

File names, directory names, paths, and package names.C:\System.ini

Program source code.a.append(b);

Inline Java class name.server.Version

Inline Java method name.getVersion()

Combination of keystrokes.Shift+N

Label, word, or phrase in a GUI window, often clickable.Service View
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Button in a user interface.OK

Menu option.New→Service

Documentation Updates
This guide's title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport logon page.

You will also receive updated or new editions if you subscribe to the appropriate product support service.
For details, contact your HP sales representative.

Support
You can visit the HP Software Support Web site at:

http://www.hp.com/go/hpsoftwaresupport

HP Software Support Online provides customer self-solve capabilities. It provides a fast and efficient way
to access interactive technical support tools needed to manage your business. As a valued support customer,
you can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest
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• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a
support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html
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Part I. Getting Started
This part explains how to access SOA Systinet, the features of the user interface, and the common functions
accessible from every page.

This part contains the following chapters:

• Chapter 1, Accessing the User Interface

• Chapter 2, Features of the User Interface

• Chapter 3, Managing Your Profile

• Chapter 4, Exploring the Repository

• Chapter 5, Graphical Navigator





1 Accessing the User Interface

Before attempting to use SOA Systinet, make sure that it is running on the server you want to access.

To access the web UI, use one of the web browsers listed in "Supported Platforms" in the HP SOA Systinet
Installation and Deployment Guide.

Enter the URL into your browser in the form:

protocol://server:port/context/web

• protocol is either http, or https if you want to create a secure connection using SSL.

• server, port, and context are determined during installation.

The default ports are 8080 for HTTP and 8843 to use HTTPS.

For example:

• http://mypc:8080/soa/web

• https://ourserver:8843/soa/web

This should display the sign-in screen. Use the credentials provided by your administrator to sign in.

By default, logins are case-insensitive. This can be changed by altering the configuration file
as described in "Configuring the User Store" in the HP SOA Systinet Installation and
Deployment Guide.

The user interface varies according to your role. The easiest way to identify which UI you use and which
user guide applies to you is to examine the UI tabs:

• Business Partner
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For details of the Partner UI, see the HP SOA Systinet Business Partner User Guide.

• Business Analyst

For details of the Analyst UI, see the HP SOA Systinet Business Analyst User Guide.

• All Other Roles

For details of the Standard UI for all other roles, see the HP SOA Systinet User Guide.
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2 Features of the User Interface

The SOA Systinet user interface has the same look and feel throughout, as shown in Figure 1, “Typical
SOA Systinet Page”.

Figure 1. Typical SOA Systinet Page

Every page contains the following common elements:

• Tabs

Access the main components of SOA Systinet, as described in Tabs on page 18.

• Search
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Search the repository content, as described in Full Text Search on page 24.

• Menu

Select component-specific links from each tab, as described in Menus on page 19.

• Account Status

Edit your user profile or view, or log out, as described in Profile Status on page 20.

• Product Information

Access product information and user documentation.

Tabs
The UI is divided into functional components. At the top of every page, the tabs access these components.

Figure 2. SOA Systinet Tabs

Clicking a tab opens the main page of that component.

• Dashboard

The first page you see when you start SOA Systinet. It contains portlets showing a customizable real-
time view of your SOA. The Dashboard is described in Chapter 6, Dashboard UI.

• Services Tab

The central location that shows all information about services, contracts, and lifecycles in one place to
provide easy access and simple management. The Services tab is described in Chapter 9, Services UI.

• Policies Tab

Enables you to validate your business services against company policy, and to manage those policies.
The Policies tab is described in Chapter 15, Policies UI.
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• Tools Tab

Gives access to Information Management, offering a generic low level view of the content of SOA Systinet
and access to administration and governance tools. The Tools tab is described in Chapter 19, Tools UI.

Menus
On the left side of each page is a section containing a menu of links specific to each SOA Systinet tab.

Figure 3. Menu

The context-specific menus for each SOA Systinet tab are described in the following sections:

• Dashboard Menu on page 47

• Services Menu on page 66

• Policies Menu on page 188
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• Tools Menu on page 250

Profile Status
At the upper-right of each page is a section allowing you to sign out, manage your profile, and change your
perspective in SOA Systinet.

Figure 4. Profile Status

• My Profile

Manage your profile, as described in Chapter 3, Managing Your Profile.

• Help

Access the product documentation.

• Sign Out

Log off SOA Systinet.

• Change

Move the cursor over change and select the perspective to alter your view of SOA Systinet.
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3 Managing Your Profile

When you first sign in, SOA Systinet creates a user profile for you based on your account in the external
user store.

Your can amend your profile details.

To change profile details:

1 Click My Profile to display your profile information.

2 Click Edit.

3 The parameters are split into the following sections:

• Basic Information

DefinitionParameter

Your profile name.Name

Your profile description.Description

The email used for notifications. Use Add and Remove for multiple entries.Email

Email can only be amended if SOA Systinet is not integrated
with an LDAP/AD user store.

• Personal Information

DefinitionParameter

Select a role from the list.Contact Role
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DefinitionParameter

Your IM details. Use Add and Remove for multiple entries.Instant Messenger

Your phone details. Use Add and Remove for multiple entries.Phone

Select a primary language from the list.Language Code

Set taxonomic categories for the search purposes.Categories

• Group Membership

Set a Primary Group from the list if you want artifacts you create to be owned by the group you are
a member of, instead of you.

• Address Details

Your postal contact details, including Geographical Location category setting.

• Related Repository Artifacts

Add any required relationships to existing repository artifacts.

For details, see Adding a Relationship on page 280.

4 Click Save to confirm the changes.
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4 Exploring the Repository

SOA Systinet provides numerous ways to locate the service or artifact you need:

• Full text search is available on every page.

For details, see Full Text Search on page 24.

• Advanced search is available on every page.

For details, see Chapter 22, Advanced Searches.

• Browsing by taxonomic category is accessible from the view menu on every page.

For details, see Category Browsing on page 27.

• The Services tab provides list views that enable you to browse and filter service artifacts by column
heading.

For details, see List Views on page 73.

• The Tools tab provides browse artifact pages with more sophisticated filtering. Artifacts in a browse view
can be filtered by column heading or by taxonomic categories assigned to them.

For details, see Browse Artifact Pages on page 258.

• Custom RSS views can be added to the Dashboard to provide periodically updated views of specific
artifact types.

For details, see RSS Content Feed Portlets on page 50 and Chapter 7, Adding a Content Feed.

• The REST interface enables you to browse the repository.

For details, see "REST Interface" in the HP SOA Systinet Developer Guide.
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• SOA Systinet integrates with IDEs, giving developers direct access to the SOA Systinet repository.

For details, see "IDE Integration" in the HP SOA Systinet Developer Guide.

• Additional service discovery options are available to import service infrastructure into SOA Systinet.

For details, see Chapter 11, Service Discovery.

Full Text Search
Full text search is the simplest way to find an item in the repository.

To use this functionality you must enable full text search on the database and in the
configuration.

For details, see "Configuring the Database for Full Text Search" in the HP SOA Systinet
Installation and Deployment Guide and "SOA Systinet Configuration Options" in the HP SOA
Systinet Administrator Guide.

The search input is located at the top of every page in SOA Systinet:

Advanced Search is not part of full text search. It enables you to create a custom search within a particular
artifact type set.

For details, see Creating an Advanced Search on page 323.

To perform a full text search in the SOA Systinet repository:

1 Type your full text search query in the input field.

The full text query string should conform to the following rules:

• A query is a list of words, phrases, and subqueries (collectively called terms) separated by spaces
or logical operators AND, OR, and NOT.
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• A word is a string of characters, numbers, and some special characters.

• A phrase is a list of words enclosed by quotation marks.

• Enclose search terms including special characters in quotes.

For example, "Adam's".

• Wildcards % and * can be used to represent zero or more arbitrary characters.

MSSQL only treats % and * as wildcards at the end of words.

• Wildcard _ represents one arbitrary character.

MSSQL does not support _ as a wildcard.

• %, *, and _ are not treated as wildcards in phrases.

• Logical operators AND and OR, which must be in uppercase, can be placed between terms. A space
between terms is a default AND.

• Logical operator NOT, which must be in uppercase, can only be placed before a term if there is at
least one preceding term connected by AND.

For example, a AND NOT b and a NOT b work, but NOT b and a OR NOT c do not work.

• A subquery is a query enclosed in brackets.

For example a AND (b OR c).

• For MSSQL, avoid searches using ` (backward apostrophe).
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• For MSSQL, to search for words containing < or > in XML/HTML documents, use &lt; or &gt;
instead.

2 Optionally, select an artifact type from the drop down list to restrict your search.

3 Click Search.

The results of your search appear as a listing that can be further reduced using filters, as described in
Full Text Search Results on page 26.

For example, the search string: C_st% service finds both Customer Service and Cost Pricing Service if they
exist in the repository.

The default functionality of full text search adds a % to the end of any input search string that
does not contain wildcards. For example, searching for acc finds all services that begin with
acc. The addition of the % can be disabled in the configuration file.

An exception can occur in the event of a wildcard resulting in excessive search terms. If this
occurs, resolve the problem with one of the following methods:

• Remove unnecessary wildcards (%,*,_).

• Prevent the implicit appending of a % by enclosing your search terms with quotes.

• Remove unnecessary words from the expression.

Full Text Search Results
You can reduce the scope of the search, as shown in Figure 5, “Search Results Page”.
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Figure 5. Search Results Page

Use Last Modified in or select a specific artifact type in Search Criteria to reduce the scope, and click
Search.

Alternatively, click one of the artifact types next to Results in Scope in the Search Results section.

Category Browsing
SOA Systinet enables you to search the repository based on taxonomic categories.

To browse by categories:

1 In the View section of the menu on any page in the Dashboard, Services, or Tools tabs, click Categories.
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The SDM page appears, displaying a list of taxonomies and categories from the SOA Definition Model,
and the number of artifacts in each taxonomy and category.

The number of items displayed next to each category in the list is approximate, and for
performance reasons, is evaluated ignoring the ACLs. The number represents the
cumulative number of items in all subcategories of the current category. The table
displayed under the list of subcategories contains only items categorized by the current
category. It does not contain items categorized by its subcategories.

2 Select a taxonomic category to view a list of artifacts classified by that category, or a taxonomy to
view a list of all artifacts classified by those taxonomic categories and the available categories in that
taxonomy.
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These pages also contain context menu options, enabling you to change the page display.

View Menu Options:

• "All Taxonomies" displays all taxonomies in the repository.

• A set of options enabling you to select a subset of taxonomies. For example, "UDDI" displays the subset
of taxonomies for UDDI registry categorization.

• "Manage Views" enables the administrator to select or edit the taxonomy views displayed in the Views
menu, and to create a new taxonomy view.

To create a new taxonomy view:

1 In the Manage Views page, click New to open the Create View page.

2 Enter a name and description for the taxonomy view.

3 Use add and Remove Selected to select the taxonomies to display in the view.

4 Set the Display Properties to control the format of the view.
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5 Click Save to create the new taxonomy view and add it to the Views menu.

The Tools→Display Properties option enables you to change the order of the taxonomies and the number
listed in each page.

The Filter and Actions functionality in the list of artifacts is the same as for Tools browse pages.

For details, see Browse Artifact Pages on page 258.
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5 Graphical Navigator

The Navigator displays a graphical representation of an artifact and its relationships to other artifacts.

Access the Navigator from the detail view of an artifact in the SOA Systinet UI. Click Navigator to open
the Navigator.

Figure 6. SOA Navigator

The Navigator consists of the following content:
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• The main part of the view is a graph of artifacts and their related artifacts.

For details, see Navigator Graph on page 32.

• A toolbar of navigator functions.

For details, see Navigator Toolbar on page 35.

•

The Navigator offers a set of custom perspectives focused on particular aspects of your SOA, with options
to create your own perspectives. For details, see Navigator Perspectives on page 36.

•

Open and close an information box for the currently highlighted node. For more details, see Node
Information Box on page 39.

•

View your selected navigator graph bookmarks. For more details, see Bookmarks on page 40.

The Navigator also provides an impact graph. For details, see Navigator Impact View on page 40.

Navigator Graph
The main purpose of the Navigator view is to provide an overview of an artifact and its relationships. The
artifact in focus is the larger icon and the graph consists of the artifacts directly related to it and then further
secondary relationships.

Each node in the artifact represents an artifact or a group of artifacts, denoted by an artifact icon.
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The icon for each artifact type is customizable. For details, see the HP SOA Systinet
Customization Editor documentation.

An artifact node can display in the following ways:

• A fully expanded node representing a single artifact with all its relationships expanded and shown in the
graph.

This diagram shows a SOAP Service with several outgoing and incoming relationships. View the
relationship type by placing the cursor over the small circle in the relationship arrow.

• A node highlighted in a box. This node is the subject of the Artifact Info box on the left.

• A collapsed node representing a single artifact with further relationships collapsed and hidden in the
graph.
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This diagram shows a WSDL with a number of incoming relationships. Further relationships are collapsed
and represented by (+). Double-click the node to expand it and view these relationships.

• A collapsed node representing a group of artifacts.

This diagram shows a set of operations. The operations are collapsed into a single group represented by
(x) where x is the number of operations in the group. Expand the node using the Expand Group context
action or the information box for the node.

The following node context actions are available by right-clicking a node:

Node Context Actions

DescriptionContext Action

Exit the Navigator view and open the artifact detail page in the SOA Systinet
UI.

View in Catalog

View the Navigator Impact tree for the artifact.Impact

Make the artifact the focus of the view and show its relationship graph.Center

Collapse outward relationships from this artifact. Alternatively, double-click an
expanded node to collapse it.

Collapse Tree

Expand • For groups, open the Information box to select the artifacts to expand using
the Artifacts to Expand dialog.

• For collapsed nodes, expand the relationships to hidden artifacts.
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Alternatively, double-click a group or collapsed node to expand it or click the
(+) of a collapsed node to expand it.

DescriptionContext Action

Expand all the artifacts in a group.Expand All

You can interact directly with the graph and artifact nodes using the following functionality:

Graph Functions

DescriptionFunction

Move the entire graph by dragging and dropping in an empty part of the graph.Move Graph

Move a node and its related sub-graph by dragging and dropping the artifact
node. Hold CTRL and drag and drop to only move the selected node.

Move Node

Navigator Toolbar
The Navigator toolbar contains the following functionality:

Navigator Toolbar Functions

DescriptionFunction

Select a zoom level from the drop-down box or use [+] or [-] to change the zoom
level.

Zoom

Click Fit on Screen to change the zoom to a level where the entire graph fits
on the screen.

Fit on Screen

Click Reset View to return to the default layout of the graph for the current
artifact in focus.

Reset View

Add the current graph layout to your bookmarks.

Create a screenshot of the current graph.
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DescriptionFunction

Open a full screen view of the current graph. Click the button again or press
Esc to return to the default navigator view.

Some functionality is disabled in the Full Screen view.

Click [X] to close the navigator and return to the page where the navigator was
accessed.

Close View

Navigator Perspectives
The Navigator provides a set of perspectives enabling you to focus on the artifacts that matter to your role
or to create your own custom perspective.

In role-specific UIs perspectives are restricted to those appropriate to the role.

To change navigator perspective:

1

Click  to open the Perspectives dialog.

2 Select the perspective you want to switch to.

SOA Systinet offers the following preset perspectives:

• All Artifacts

Shows all artifacts.

• Business Analyst

Focuses on artifacts related to service creation and consumption.
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• Business Partner

Focuses on artifacts related to service consumption.

• Service Developer

Focuses on artifacts related to service definition and implementation.

• Service Provider

Focuses on artifacts related to service provision.

You can also create your own custom perspectives.

To create a custom navigator perspective:

1

Click  to open the Perspectives dialog.

2 Select the perspective you want to use as the basis for your custom perspective.

3 Click Create to open the New Perspective dialog.

The default settings are a copy of the selected perspective.
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4 Type a name for your new perspective.

5 In the Artifact Types tab, select the artifact types to display and set an emphasis using the sliding
scale. Use Filter to search for a particular artifact type.

6 In the Relationships tab, select the relationships to display and set an emphasis using the sliding scale.
Use Filter to search for a particular relationship type. The available relationships are determined by
the selected artifact types.

7 Expand Show Advanced Settings and select from the following settings:

DescriptionSetting

Select to show only the last approved or the latest revision of artifacts in
lifecycle governance. Ungoverned artifacts display their last revisions.

Displayed Data

Select to display relationship labels in the graph.Annotate Relationships
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8 Click Save to create your new perspective.

9 To edit or delete a custom navigator perspective, select it and then click Edit or Delete.

Node Information Box

Click  to open the Information box for the currently highlighted node.

Depending on the node there are the following types of Information box:

• Artifact Info

For a single artifact, the Information box shows some artifact details, with the following options:

• Show in Catalog

Exit the Navigator and view the artifact details in the SOA Systinet UI.

• Center Artifact

Make the artifact the focus of the graph.

• Artifacts to Expand

For a group of artifacts artifact, the Information box shows a paged list of the individual artifacts, with
the following options:

• Expand

Select the artifacts to expand from the group and show individually in the graph. The check-box at the
top-left enables you to select all artifacts on the current page.

• Reset

Removes your selection and returns to the first page of the group.

• Filter
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Use the filter to locate a particular artifact in a group.

Bookmarks
The Graphical Navigator enables you to keep bookmarks of particular graph layouts for later reference.

To make a bookmark:

1 Do one of the following:

•
Click 

•

Click  to open the Bookmarks dialog box and click Save.

2 Enter a name, and click Save to create a bookmark of the current layout of the graph.

Saved bookmarks are available in the Bookmarks dialog box.

To access a bookmark:

1

Click  to open the Bookmarks dialog box.

2 Place the cursor over a bookmark to view a preview and either double-click a bookmark or select a
bookmark and click Load to open it.

Bookmarks are also accessible from the Dashboard in the Standard UI. For details, see "Bookmarks Portlet"
in the HP SOA Systinet User Guide.

Navigator Impact View
You can also view impact of a change to an artifact using the Navigator.
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To open the Navigator Impact view:

• Do one of the following:

• In the Navigator view, open the context menu of an artifact and select Impact.

• In the detail view of an artifact in the SOA Systinet UI, open the Tools context menu, and select
Impact Analysis (Navigator).

The Navigator opens showing an impact tree. The selected artifact is at the top and the artifacts it
impacts on are in the next row in the tree. The impacted artifacts may also impact on other artifacts
and so on through more levels of the impact tree.

You can return to the standard Navigator view by opening the context menu of an artifact in the impact
tree, and selecting Browse.

41



42



Part II. Dashboard
This part explains the features and use of the Dashboard, which is the initial page that opens when you
start SOA Systinet.

This part contains the following chapters:

• Chapter 6, Dashboard UI

Describes the user interface elements on the Dashboard.

• Chapter 7, Adding a Content Feed

Explains how to add a new RSS feed to the Dashboard.

• Chapter 8, Adding a Content Report

Explains how to add new report content to the Dashboard.





6 Dashboard UI

The Dashboard contains a customizable real-time view of your SOA data, as shown in Figure 7, “The
Dashboard Tab”.

Figure 7. The Dashboard Tab
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The Dashboard is divided into the menu on the left side of the page and a number of Portlets in the main
section of the page.

Portlets can be dragged and dropped to customize the look of your dashboard using the mouse.
You can also use the keyboard to move portlets.

To move portlets on the Dashboard with the keyboard:

1 Press F9 to display the movement keypad.

2 Use the arrow keys to navigate to the portlet you want to move.

3 Press Enter or 5 to select the portlet.

4 Use the arrow keys to move the portlet into position.

5 Press Enter or 5 to fix the portlet in place.

6 Press F9 to exit portlet navigation mode.

This chapter describes:

• Dashboard Menu on page 47

The items in the dashboard menu.

• RSS Content Feed Portlets on page 50

The RSS content feed portlets on the dashboard.

• Reuse Statistics Portlet on page 51

Displays statistics of service use.

• Activity Report Portlet on page 52

Displays artifact activity statistics.
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• My Task Results Portlet on page 54

Displays the results and progress of asynchronous tasks.

• Bookmarks Portlet on page 56

Displays bookmarks from the Navigator view.

• HP SOA Blog Portlet on page 57

Access the latest information and articles at the HP Communities blog, Making Sense of SOA.

Dashboard Menu
The Dashboard menu is split into collapsible segments.

Each segment is described in the following sections:

• Dashboard View Menu on page 48

A set of links to various aspects of service and contract management.

• Dashboard New Menu on page 48

Create new artifacts.

• Add Portlet Menu on page 49

Create new content feeds or add reports to the Dashboard.

• Validation Menu on page 190

Validate the policy compliance of an artifact.

• Recent Documents

Quick links to the last few artifacts viewed.
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Dashboard View Menu

The View menu in the Dashboard provides links to list views for service, and policy management.

Figure 8. Dashboard View Menu

The View menu contains the following links:

• Categories

Browse the repository by taxonomic category.

For details, see Category Browsing on page 27.

• Service List Views

Views of various aspects of service management.

For details, see List Views on page 73.

• Compliance Reports

A link to the list view of policy compliance reports.

For details, see Policy and Report List Views on page 195.

Dashboard New Menu

The New menu in the Dashboard provides quick links to create new artifacts.
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Figure 9. Dashboard New Menu

The New menu links to the following artifact creation pages:

• Application

Create a new application. For details, see Using Applications on page 121.

• Business Process

Create a new business process.

• Project

Create a new project. For details, see Creating Projects on page 181

• Service

Create a new business service. For details. see Creating Business Services on page 95.

• Business Policy

Create a new policy. For details, see Creating Business Policies on page 213.

Add Portlet Menu

The Add Portlet menu in the Dashboard enables you to add and restore content to the Dashboard.
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Figure 10. Add Portlet Menu

The Add menu contains the following functionality:

• Content Feed

Add a new RSS feed to the Dashboard.

For details, see Chapter 7, Adding a Content Feed.

• Content Report

Add a new Content Feed to the Dashboard.

For details, see Chapter 8, Adding a Content Report.

• Portlet Names

Any Dashboard portlets that you close appear in this menu.

Click the name to restore the portlet to the Dashboard.

RSS Content Feed Portlets
The Dashboard contains a number of content feeds that use RSS subscription to display up-to-date
information from a variety of sources, including the repository, as shown in Figure 11, “Services RSS Feed
Portlet”.
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Figure 11. Services RSS Feed Portlet

Visit feed home page takes you to the source of the content in the portlet.

Refresh reloads the content list.

Clicking one of the links in the list takes you to the page showing that item.

The tool icon accesses the feed portlet configuration, where you can change the number of list items and
the update frequency.

To remove the portlet from the Dashboard, click the window close icon [X].

To find out how to add new portlets to the Dashbaord, see Chapter 7, Adding a Content Feed.

Closing a portlet in the Dashboard makes it available in the "Add" section of the Dashboard menu.

Reuse Statistics Portlet
Contract Manager provides basic statistics of service use in the Reuse Statistics portlet on the Dashboard.
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Figure 12. Reuse Statistics Graph

The statistics show the percentage of services used by a given number of consumers. Basic intervals are
less than one, one or two, and more than two.

Click Refresh to reload the service statistics.

Click Contract Requests to Approve or My Contracts to open the relevant List View for that item.

For details, see List Views on page 73.

Closing the portlet makes it available in the Add section of the Dashboard menu.

Click one of the graph bars to view the services that fit the selected criteria. For each service, the table lists
all consumers.

Activity Report Portlet
The Activity Report enables you to view the most active artifacts in the repository.
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Figure 13. Activity Report Portlet

The portlet displays the five most active artifacts with a coloured activity bar for each artifact and a
corresponding key underneath.

The following time periods are available:

• DAY

Activity from the current calendar day starting at midnight (server time).

• WEEK

Activity for the current calendar week starting at midnight on Sunday.

• MONTH
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Activity for the current calendar month,

• YEAR

Activity for the current calendar year.

You can monitor either READ or WRITE operations:

• READ

Occurs whenever a user opens any view of the artifact.

• WRITE

Occurs whenever a user edits an artifact.

The activity report is generated automatically by the Activity Report Update Task, with the latest update
time displayed in the portlet.

Users with sufficient permissions can manually execute the task or edit it. For details, see Tasks and
Scheduling on page 316.

My Task Results Portlet
The My Task Results portlet on the Dashboard tabs is the quickest access point to asynchronous tasks such
as bulk operations, publishing, and BAC/UCMDB discovery and the results of their execution.
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Figure 14. My Task Results Portlet

The portlet displays a list of tasks that you executed with links to the result. If a task is currently in progress,
the portlet displays a progress bar.

Click the name of the task to view the report for that task.

Closing the portlet in the Dashboard adds a link to the Add section of the dashboard menu enabling you
to restore the portlet to the Dashboard at any time.

Click More to open the My Task Results page.

This page shows a complete list of completed tasks and tasks in progress.

This page contains a bulk stop task action. Select the tasks to stop, expand Select Action and select Stop
to stop the selected tasks.
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For more information about asynchronous tasks see the following sections:

• Publishing Services on page 127

• BAC/UCMDB Service Discovery on page 137

• Bulk Operations on page 275

Bookmarks Portlet
The SOA Navigator enables you to make bookmarks of selected graph layouts. These bookmarks are
available in the Navigator Bookmarks portlet.

Figure 15. Bookmarks Portlet

By default, the portlet shows the most recent bookmark. Click More to view the three most recent bookmarks.
Click a bookmark to open the Navigator showing the bookmarked layout.

For more details about the Navigator, see Chapter 5, Graphical Navigator.
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HP SOA Blog Portlet
The Blog portlet in the Dashboard provides access to the latest articles and information from the HP
Communities blog, Making Sense of SOA.

Figure 16. HP SOA Blog Portlet
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7 Adding a Content Feed

The Dashboard can display up-to-date information from external sources and from SOA Systinet.

To add a new RSS feed to the Dashboard:

1 In the Add section of the dashboard menu, click Content Feed to open a new content feed in the
Dashboard:

2 Complete the form with the following parameters.

DefinitionParameter

Address of the RSS feedFeed URL

To add a feed for repository content, use the URL from one
of the following views:

• RSS
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Access this view from the Common context menu in Browse
Artifact and detail view pages. For details, see Browse
Artifact Pages on page 258 and Tools View on page 262.

• RSS of Result

Access this view from the View context menu for a saved
search.

DefinitionParameter

Heading for the new feed portletTitle

Number of items to listEntries

Interval between feed updatesUpdate [min]

3 Click Save to access the feed and load the initial content.
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8 Adding a Content Report

The Dashboard can display content from specially designed reports.

SOA Systinet contains a standard set of dashboard reports, which you add using SOA Systinet
Report Editor. For details, see the SOA Systinet Report Editor Guide.

To add a new content report to the Dashboard:

1 In the Add section of the Dashboard menu, click Content Report to open a new content report in the
Dashboard:

2 Select a report from the list. If required, change the title.

3 Click Save to access the most recent report from the reporting server.

4 Click Reload to execute the associated reporting tool to generate a new version of the report.
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5 Click the tool icon to change the title or content of the portlet.
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Part III. Services
This part shows you how to use Services tab to organize and manage your SOA services.

This part contains the following chapters:

• Chapter 9, Services UI

The user interface elements of the services tab.

• Chapter 10, Creating Services

Create services, their implementation, and make them available for use.

• Chapter 11, Service Discovery

Populate SOA Systinet with service infrastructure from external sources.

• Chapter 12, Lifecycle Governance

Create governance processes to manage your SOA.

• Chapter 13, Managing Contracts

Establish and manage contracts between providers and consumers.





9 Services UI

The Services tab displays all information about your services and contracts in one place. From this central
location, you can access and manage your services quickly and easily.

Figure 17. The Services Tab

The Services tab is divided into the menu on the left side of the page and a number of collapsible sections:

• Services Menu

Describes the items in the Services Menu. For details, see Services Menu on page 66.
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• My Services

Displays the services that you provide that are ready for consumption.

• My Providers

Displays the services that you use.

• Recent Updates

Displays services that are newly available or modified.

From the Services tab, you can do one of the following:

• To view details about a service in the View Service page, click the service name in these lists.

For details, see Service View on page 75.

• To open a List View for that type of artifact, click More.

For details, see List Views on page 73.

Services Menu
The Services menu is divided into collapsible segments.

Each segment is described in the following sections:

• Services View Menu on page 67

Set of links to various aspects of service management.

• Services New Menu on page 68

Create new service artifacts.

• Contract Management Menu on page 69

Set of links to various aspects of contract management.
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• Lifecycle Menu on page 70

Access the lifecycle functionality in SOA Systinet.

• Service Discovery Menu on page 71

Discover and manage artifacts from an integrated BAC/UCMDB server.

• Saved Searches Menu on page 72

Quick links to user specified searches.

• Recent Documents

Quick links to the last few artifacts viewed.

Services View Menu

The View menu in the Services tab provides links to list views for service management.

Figure 18. Services View Menu

The View menu contains the following links:
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• Categories

Browse the repository by taxonomic category.

For details, see Category Browsing on page 27.

• Service List Views

Views of various aspects of service, lifecycle, project, and contract management.

For details, see List Views on page 73.

• Artifact Names

View the Tools browse pages for these artifact types.

For details, see Browse Artifact Pages on page 258.

Services New Menu

The New menu in the Dashboard provides quick links to create new artifacts.

Figure 19. Services New Menu

The New menu links to the following artifact creation pages:

• Application

Create an application artifact. For details, see Using Applications on page 121.
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• Business Process

Create a business process.

• Project

Create a project. For details, see Creating Projects on page 181.

• Service

Create a new business service.

For details. see Creating Business Services on page 95.

• Contract Request

Request a contract for consumption of a provided artifact.

For details, see Requesting Consumption on page 176.

• Upload Data Content

Publish service infrastructure from a service definition document.

For details. see Publishing Services on page 127.

Contract Management Menu

The Contract Management menu accesses list views for contract management and import functionality.
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Figure 20. Contract Management Menu

The Contract Management menu contains the following links:

• Contract List Views

Views of various aspects of contract management.

For details, see List Views on page 73.

• Import Existing Contract

Import a contract that exists outside SOA Systinet into the repository.

For details, see Importing Existing Contracts on page 178.

Lifecycle Menu

The Lifecycle menu in the Service tab enables you to access the lifecycle functionality in SOA Systinet.

Figure 21. Lifecycle Menu

The Lifecycle menu contains the following links:
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• Governance Dashboard

Opens an overview page of your current governance activity.

• Promotion Requests History

Opens an overview page of all resolved (historical) promotion requests.

For more details, see Chapter 12, Lifecycle Governance.

Service Discovery Menu

The Service Discovery menu provides access to services stored in products using a Universal Configuration
Management Database (UCMDB), specifically HP Business Availability Center (BAC), and their
representations in the SOA Systinet repository.

Figure 22. Service Discovery Menu

The Service Discovery menu contains the following links:

• BAC/UCMDB

Discover services stored in UCMDB used by BAC.

For details, see BAC/UCMDB Service Discovery on page 137.

• Discovered Service List Views

List views of services accessed from BAC/UCMDB and processed in SOA Systinet.

For details, see BAC/UCMDB Service Discovery on page 137.
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Saved Searches Menu

The Saved Searches menu in the Services tab contains quick links to user created saved searches.

Figure 23. Saved Searches Menu

The Saved Searches menu enables you to view and open saved searches:

• Saved Search Names

Click a stored search name to execute the search and view the search results . For details, see Chapter
22, Advanced Searches.

• More

Click More to view the full list of saved searches.

Service Pages
The Services tab contains two types of view pages, described in the following sections:

• List Views on page 73

Describes the index views of service artifacts.

• Service View on page 75

Describes the detailed view of service related artifacts in the Service Catalog.

• Governance Dashboard on page 85

Describes the lifecycle management page displaying an overview of your approval requests.
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List Views

Click one of the links in the Services tab View menu to open a list view of that type of artifact.

For example, My Services:

Figure 24. My Services List View

You can reduce the list of artifacts using Filter.

Click Filter to open a query window.

To filter the list, enter your search parameter, select a column, and then click Find.

Click Clear Filter to remove the filter and restore the list of artifacts, or open the Filter menu and select
Edit Filter to change the filter terms.

List views also enable you to carry out bulk operations on selected artifacts using the Actions menu.

The available bulk operations vary depending on the artifact type.

To perform a bulk operation:

• Select the service artifacts you require, and open the Select Actions menu.

The menu offers the following bulk operations:

• Edit Access Rights
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The owner of an artifact or administrator can edit the permissions of selected artifacts.

For details, see "Access Rights" in the HP SOA Systinet Administrator Guide.

• Edit Category Bag

Change the categorization for the selected artifacts.

For details, see Categorizing Artifacts on page 284.

• Change Owner

Change the person or group responsible for the artifact.

For details, see Changing Artifact Ownership on page 281.

• Synchronize

Perform change management on the selected artifacts.

For details, see Running the Synchronization Tool on page 311.

• Change Version

Create new versions of the selected artifacts.

For details, see Managing Versions on page 291.

• Delete

Mark the selected artifacts as deleted.

For details, see Deleting an Artifact on page 279.

• Export to Registry

Export the selected artifacts to an integrated UDDI Registry.

For details, see Exporting Data To Registries on page 297.
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Service View

Clicking the name of a service artifact in the Services tab opens the service view for that artifact:

For the purposes of documentation, service artifact refers to any artifact type that is available
to view in the Services tab. These include applications, business services, implementations,
endpoints, and operations.
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Figure 25. View Service Page

The service view is the central location for information about service artifacts.

This following sections describe the content and functionality of these pages:
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• Service View Context Actions on page 77

• Service View Page Content on page 81

• Sidebar on page 83

Service View Context Actions

The grey bar contains a set of context action menus and functions.

The actions vary depending on the artifact but they include:

• Views:

• Consumer View and Services View

Switch between the default view of the current revision and the last approved revision of the artifact
for artifacts subject to lifecycle management.

For more details, see Chapter 12, Lifecycle Governance.

This view selection is preserved if you navigate away from the page.

• Advanced View

Switches to the detailed view of the artifact in the Tools tab.

For details, see Tools View on page 262

• Revisions

View the revision history of the artifact.

For details, see Revision and Version History on page 270.

• Access Rights
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Opens a view of the access permissions for the artifact.

For details, see "Edit Access Rights" in the HP SOA Systinet Administrator Guide.

• Tools:

• Related Reports

A list of the reports related to this artifact.

For details, see Reports on page 321.

• Dependency Analysis and Impact Analysis

Execute the impact management tool on the artifact.

For details, see Impact Tools on page 304.

• Impact Analysis (Navigator)

Open the Graphical Navigator showing a visual representation of the impact of the artifact. For details,
see Navigator Impact View on page 40.

• Change Owner

The administrator or owner of the artifact to can transfer ownership to a different user.

For details, see Changing Artifact Ownership on page 281.

• Notify

Send a notification email to selected stakeholders for the artifact.

For details, see Notifications on page 285.

• Compliance:

• Validate Compliance

Validate the policy compliance of an artifact.
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For details, see Chapter 18, Validating Artifacts.

• Compliance Status

View the compliance status of the artifact.

For details, see Report Views on page 203.

• Effective Policies

View the business policies associated with the service artifact.

• Reset Compliance Statistics

Delete all compliance reports associated with the artifact.

• Version:

• Versions

View the version history for the artifact.

For details, see Revision and Version History on page 270.

• Version Navigation

Open specific next, previous, or last versions of the artifact.

• Governance

• Start Governance

Enter the artifact into a lifecycle process.

For details, see Starting Artifact Governance on page 164.

• Request Approval

Request approval of the current lifecycle stage.

For details, see Submitting an Approval Request on page 166.
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• View Stage Details

View the page showing the details for the current lifecycle stage.

• History

View the governance history of the artifact.

• Consumption:

• New Request

Request consumption of the artifact.

For details, see Submitting an Approval Request on page 166.

• Pending Requests

View the list of outstanding consumption requests for the artifact.

• Accepted Requests

View the list of accepted consumption requests for the artifact.

• Rejected Requests

View the list of rejected requests for the artifact.

• Navigator

Opens a graphical representation of the artifact and its relationships.

For details, see Chapter 5, Graphical Navigator.

• Edit

Change the attributes of the artifact.

• New Version

Create a new version of the artifact.
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For details, see Managing Versions on page 291.

• Delete

Mark the artifact as deleted with a further option to purge it from the repository.

Service View Page Content

The service view page contains a set of collapsible segments specific to each artifact type:

• Properties

Information about the service artifact specific to the artifact type.

• Contract Management

Service artifacts that are providers display contract information.

For details, see Chapter 13, Managing Contracts.

• Governance

Service artifacts subject to lifecycle management display the current stage and options to view the stage
details, view changes since the last approved version, and to initiate lifecycle transitions.

For details, see Chapter 12, Lifecycle Governance.

• Contacts

Shows the contacts for the artifact organized by type, with an option to add contacts.

For details, see Adding Contacts on page 97.

• Environments

This section for SOAP Services displays information about the environments and endpoints associated
with the SOAP Service. The section is organized by environment which usually represent specific stages
in a service lifecycle and the endpoints associated with the implementations servers used during those
stages.
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For more details, see Adding Endpoints on page 112.

• Related Artifacts Sections

SOA defines a set of relationships between service artifacts. These sections, including Documents,
Implementations, Service Level Objectives, Environments, and Operations enable you to manage
these relationships.

For more details, see Chapter 10, Creating Services.

• Registries

If you integrate SOA Systinet with UDDI Registries, this section displays each registry and the status of
the service artifact compared to that registry. There are synchronization options depending on the relative
status of the artifact with each registry.

For details, see Registry Integration on page 295.

• Service Quality

If you integrate SOA Systinet with HP Service Test Manager (STM), SOAP Services display a section
for service quality statistics from STM.

This section enables you to register a service with STM and then displays information about requirements,
tests, and defects from STM.

For details, see Service Test Manager Integration Features on page 91.

• Service Discovery

If you import a service artifact from an external source, such as HP Business Availability Center (BAC),
this section displays the source of the original service and its change management status. There are options
to display the discovery details, or import changes.

For details, see Synchronizing Discovered Services on page 143.

• Performance and Availability

The content of this section depends on which product you integrate SOA Systinet with.
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If you integrate SOA Systinet with HP Business Availability Center (BAC), this section displays
statistics generated by BAC and enables you to open the BAC view of the service artifact.

For integration details, see "Setting Up BAC/UCMDB Integration" in the HP SOA Systinet Administrator
Guide.

For feature details, see BAC/UCMDB Integration Features on page 86.

•

• If you integrate SOA Systinet with HP SOA Policy Enforcer (SPE), this section enables you to open
the SPE view of the service artifact if it is shared with SPE.

For integration details, see "Setting Up SOA Policy Enforcer Integration" in the HP SOA Systinet
Administrator Guide.

For feature details, see SOA Policy Enforcer Integration Features on page 89.

Sidebar

Additional information about an artifact may be available in the Sidebar to the right of the Service View.

Open and close the sidebar by clicking the white arrow.

If there is no relevant information, the Sidebar is not visible.
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Figure 26. Sidebar

The Sidebar contains the following sections when there is relevant information available:

• To Do

Displays outstanding and untracked tasks for a governed artifact for its current lifecycle stage.

Select the check-box for an outstanding task to mark it as completed.

Click Details to view the Stage Details page for the artifact.

For more details about lifecycle tasks, see Managing Associated Policies and Tasks on page 165.

• Compliance Status

Displays the current compliance status of the artifact. The compliance status is shown in parentheses if
the status is obsolete due to a change to the artifact.

If the compliance status is obsolete or unknown, click Recalculate to execute a compliance check and
refresh the compliance status.

Click Details to view the latest compliance status report.

For details about artifact compliance, see Compliance Status on page 239.
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Expand and contract sections of the Sidebar by clicking the section name.

Governance Dashboard

The Governance Dashboard page is part of lifecycle management displaying an overview of approval and
rollback requests and governed artifacts relevant to you.

Access the page from the Services tab Lifecycle menu with the Governance Dashboard link.

The page is split into the sections displaying different stages of service and lifecycle approvals, as shown
in Figure 27, “Governance Dashboard”.

Figure 27. Governance Dashboard

• Requests to Approve

Displays a list of approval and rollback requests that require your attention. These requests are associated
with services at a lifecycle stage that you are the approver for. Click a request to review it and approve
or reject.

For details, see Handling Approval and Rollback Requests on page 168.

• My Pending Promotion Requests.

Displays your outstanding approval and rollback requests that require review by the relevant approvers.

• My Governed Artifacts.
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Displays a list of all root artifacts that you own that are currently under governance.

BAC/UCMDB Integration Features

HP Business Availability Center (BAC) monitors run-time services and collects statistics their perfromance.
These statistics enable you to verify that a service meets its service level objectives. BAC uses a Universal
Configuration Management Database (UCMDB).

SOA Systinet enables you to discover services stored in BAC/UCMDB.

For details about BAC/UCMDB service discovery, see BAC/UCMDB Service Discovery on page 137

Before any data transfer takes place between SOA Systinet and BAC/UCMDB, a BAC/UCMDB
server artifact must be created.

For details, see "Setting Up BAC/UCMDB Integration" in the HP SOA Systinet Administrator
Guide.

SOA Systinet artifacts correspond to UCMDB entities as follows:

UCMDB EntitySOA Systinet Artifact

Business UnitOrganizational unit

Business Service for CatalogBusiness Service

Web ServiceSOAP Service

BAC/UCMDB cannot access services directly from SOA Systinet. You must integrate a UDDI
Registry with SOA Systinet and UCMDB enables you to access the service entities in the
UDDI Registry.

For details, see "Setting Up Registry Integration" in the HP SOA Systinet Administrator Guide
and the HP Business Availability Center documentation.

Any service artifact monitored by BAC has an extra section in Services and Tools detail pages:
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Figure 28. Performance and Availability Section

The Performance and Availability section displays statistics generated by BAC for the default time period.
Select Data Source to refresh the information for the selected time period. Clicking View Report in BAC
to display the BAC report for the selected time period.

The default time period is Past Week. You can change this default in the configuration. For
details, see "Configuring the Default BAC Reporting Period" in the HP SOA Systinet
Administrator Guide.
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Figure 29. BAC Health Report

88



This report is generated from synthetic data. Use BAC to view reports on real data. For more
details, see the HP Business Availability Center documentation.

SOA Policy Enforcer Integration Features

HP SOA Policy Enforcer (SOA PE) enables you to monitor the confomance of your run-time services
against your business policy.

If you integrate SOA Systinet with (SOA PE), the service information in SOA PE is accessible from the
SOA Systinet service view and SOA PE statistics are displayed for SOAP services..

Before you can access services in SPE from SOA Systinet, an SOA Policy Enforcer Server
artifact must be created.

For details, see "Setting Up SOA Policy Enforcer Integration" in the HP SOA Systinet
Administrator Guide.

After SOA PE integration is complete, policies you create in SOA PE are published directly to the SOA
Systinet repository.

For details, see the HP SOA Policy Enforcer documentation.

SOA Systinet artifacts correspond to SPE entities as follows:

SOA PE EntitySOA Systinet Artifact

PolicyWS-Policy

Business ServiceBusiness Service

Web ServiceSOAP Service

Services shared by SOA Systinet and SOA PE must have the same QName, defined by the
namespace of the WSDL describing the service and the local name stated in the wsdl-service-
name element.
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Apart from the SOA PE policy publishing, there is no direct import or export functionality
between SOA PE and SOA Systinet. You must integrate a UDDI Registry with SOA Systinet
and SOA PE enables you to access the service entities in the UDDI Registry.

For details, see "Setting Up Registry Integration" in the HP SOA Systinet Administrator Guide
and the HP SOA Policy Enforcer documentation.

Services and SOAP Services have an extra section in their service view:

Figure 30. Performance and Availability Section

For shared SOAP services the section displays SOA PE statistics.

For both business services and SOAP services, click SOA Policy Enforcer Service View and login to SOA
PE to view the Policy Enforcer view of the service:
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Figure 31. SOA Policy Enforcer Service View

Service Test Manager Integration Features

HP Service Test Manager (STM) is an HP Quality Center component that enables you to test services in
conjunction with Quality Center functionality.
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SOA Systinet enables you to register SOAP services in STM for testing. Statistics for the test results are
then available in the Services and Tools detail pages for SOAP services.

Before any data transfer takes place between SOA Systinet and STM, an STM server artifact
must be created.

For details, see "Setting Up STM Integration" in the HP SOA Systinet Administrator Guide.

SOA Systinet artifacts correspond to STM entities as follows:

STM EntitySOA Systinet Artifact

Web ServiceSOAP Service

After an STM server has been integrated with SOA Systinet, you can register SOAP services in STM.

SOAP Services have an extra Service Quality section in their Service and Tools detail view:

Figure 32. Service Quality Section

Expand Register in STM and click the STM server to export the SOAP service to.

The SOAP service you want to register must be created in SOA Systinet by uploading a WSDL
that defines it.

For details, see "Publishing Services" in the HP SOA Systinet User Guide.

The service is registered in STM using a URL pointing to an environment specific WSDL
containing only endpoints (wsdl:port elements) for the specified STM Server environment.
For more details, see the Download WSDL functionality in Adding Endpoints on page 112.
If the STM server is not categorized for an environment then the original WSDL content is
used.
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You must log in to Quality Center and the STM services page opens.

To be able to register services in STM you must install this HP Quality Center plug-in on the
client:

• Service Test Add-in for Quality Center 9.50

Microsoft Internet Explorer must be the default browser when accessing STM.

Access STM and allow the client code to install (ActiveX) to the browser.

A registered SOAP service displays testing statistics in the Service Quality section:

Figure 33. Service Quality Section

Use the requirement, test and defect links to open the relevant pages in STM.

STM enables you to import services directly from SOA Systinet. For details, see the STM
documentation.
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10 Creating Services

Service creation is one of the most important aspects of SOA Systinet.

SOA Systinet makes service creation simple by breaking the process down into a set of basic procedures:

This section assumes that Business Service is your primary service artifact for organizing your
SOA. SOA Systinet also enables you to manage your SOA at a higher level using Applications
or at a lower level using Operations.

For details, see Using Applications on page 121 and Using Operations on page 123.

• Creating Business Services on page 95

• Adding Contacts on page 97

• Adding Service Documentation on page 97

• Implementing Services on page 101

• Adding Service Level Objectives on page 117

• Making Services Available on page 121

Creating Business Services
You can create new business services from the Dashboard or the Services tab.

To publish a new service:

1 In the Dashboard or Services tab New menu, click Service to open the New Business Service page:
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2 Enter the following parameters:

DefinitionParameter

The name of the new business service.Name

A description of the new service which can include HTML formatting tags.Description

The initial version number of the service.Version

Select a service type from the drop-down list.Service Type

Select an impact from the drop-down list.Failure Impact
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DefinitionParameter

Optionally, add search terms for the service.Keywords

Select to make the service available to consumers (not visible in the General
perspective).

Consumable

3 Click Save to create the business service artifact.

Adding Contacts
SOA Systinet enables you to add contacts in specified roles for a service.

To add contacts for a service:

1 In the Services view of a service, in the Contacts section, place the cursor over Add Contact to view
the available contact roles.

2 Select a role for the new contacts.

3 Use Filter to search for the required contacts, select the contacts required, and click Add to add the
contacts in the selected role.

The available contact roles are determined by taxonomy
uddi:systinet.com:soa:model:taxonomies:jobRoles.

Use HP SOA Systinet Workbench Taxonomy Editor if you require different job roles. For
details, see the HP SOA Systinet Taxonomy Editor Guide.

There is a limitation on category values of 32 characters for this taxonomy.

Adding Service Documentation
Services often have associated documentation.
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To add documentation to a service:

• In the Services view of a service, in the Documentation section, place the cursor over Add Document
to view the following options:

• From Local File

Upload a document from your local file system.

For details, see To upload a document from your local file system:

• From Remote File

Upload a document from a remote location.

For details, see To upload a document from a remote location:

• Link to a Remote File

Create a link to a document on a remote location.

For details, see To link to a document on a remote location:

• From Catalog

Select a document from the collection in the repository.

For details, see To select from the list of the documentation artifacts in the repository:.

To upload a document from your local file system:

1 In the Services view of a service place the cursor over Add Document for view the available options.

2 Click From Local File to open the Local File dialog box.

3 Input the following parameters:
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DefinitionParameter

Input a path or use Browse to locate the file on your local file system.File

Select a document type from the drop-down list.Type

Input a description of the documentation artifact.Description

4 Optionally, expand Show Advanced Options and select the following options:

DefinitionParameter

Input a directory name to store the uploaded document in the repository.
View Server Folders enables you to browse the existing locations.

Server Folder

Input a name for the documentation artifact.Name

5 Click Save to upload the document, create a new documentation artifact, and create the relationships
between the service and the documentation artifact.

To upload a document from a remote location:

1 In the Services view of a service place the cursor over Add Document for view the available options.

2 Click From Remote File to open the Remote File dialog box.

3 Input the following parameters:

DefinitionParameter

Input the URL of the remote document.URL

If the remote location requires authentication to access, select Requires
Authentication, and input the username and password required to access
it.

Requires Authentication

Select a document type from the drop-down list.Type

Input a description of the documentation artifact.Description
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4 Optionally, expand Show Advanced Options and select the following options:

DefinitionParameter

Input a directory name to store the uploaded document in the repository.
View Server Folders enables you to browse the existing locations.

Server Folder

The part of the URL location to ignore when creating the publishing location.Base URL

Input a name for the documentation artifact.Name

Select a synchronization policy for change management. For more details,
see Synchronization Policy on page 310.

Synchronization

5 Click Save to import the document, create a new documentation artifact and the relationships between
the service and the documentation artifact.

To link to a document on a remote location:

1 In the Services view of a service place the cursor over Add Document for view the available options.

2 Click Link to a Remote File to open the Link to a Remote File dialog box.

3 Input the following parameters:

DefinitionParameter

Input the URL of the remote document.URL

Select a document type from the drop-down list.Type

Input a name for the documentation artifact.Name

Input a description of the documentation artifact.Description

4 Click Save to create a new documentation artifact with a link to the remote document and the
relationships between the service and the documentation artifact.

To select from the list of the documentation artifacts in the repository:

1 In the Services view of a service place the cursor over Add Document for view the available options.
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2 Click From Catalog to open the Browse Catalog dialog box.

3 Use Find to search for the required documentation artifact and click add to select the document from
the list.

Implementing Services
Business services are implemented in the Services tab.

The Services view of a business service contains an Implementation section:

Figure 34. Implementations Section

You can add the following implementations types:

• Add SOAP Service

for details, see Adding SOAP Services on page 102.

• Add XML Service

For details, see Adding XML Services on page 106.

• Add Web Application

For details, see Adding Web Applications on page 108.

A SOAP Service is normally defined by attaching a WSDL document to it.

For details, see Adding WSDLs on page 109.
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Implementations also require the creation of an endpoint to access the environment hosting the service. For
details, see Adding Endpoints on page 112.

Implementations consist of a set of methods represented in SOA Systinet as operations. For details, see
Adding Operations on page 114.

XML services can also be defined with an XML schema document. For details, see Adding an XML Service
Definition on page 115.

Adding SOAP Services

A common implementation of a business service is a SOAP service.

To add a SOAP service to a business service:

• In the Services view of a service, in the Implementations section, place the cursor over Add SOAP
service to view the following options:

• Add New SOAP Service

Create a new SOAP service associated with the business service.

For details, see To create a new SOAP Service:

• From Local File

Add a SOAP service defined by a WSDL in a local file system.

For details, see To add a SOAP service from your local file system:

This process uses the publisher functionality.

For details, see Publishing Services on page 127.

• From Remote File

Add a SOAP service defined by a WSDL in a remote location.
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For details, see To add a SOAP service from a remote location:

This process uses the publisher functionality.

For details, see Publishing Services on page 127.

• From Catalog

Select a SOAP service already in the repository.

For details, see To select a SOAP service from the repository:

To create a new SOAP Service:

1 In the Services view of the service, in the Implementations section, place the cursor over the Add
SOAP Service to view the available options.

2 Click Add New SOAP Service to open the New SOAP Service page.

3 Input the following parameters:

DefinitionParameter

The name of the new SOAP service artifact.Name

A description of the SOAP service artifact.Description

A version number for the SOAP service artifact.Version

Select to make the service available to consumers (not visible
in the General perspective).

Consumable

4 Click Save to create the new SOAP service and the relationships with the business service.
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This process only creates a SOAP service artifact. You must add a WSDL and then an
endpoint to the artifact in the service view of the SOAP service to make it a functioning
implementation.

For details, see Adding WSDLs on page 109.

To add a SOAP service from your local file system:

1 In the Services view of a service, in the Implementations section, place the cursor over Add SOAP
service to view the available options.

2 Click From Local File to open the Local File dialog box.

3 Input the path or use Browse to locate the WSDL file on your local file system.

You can reference a zip file containing several WSDLs, including referenced schemas.

4 Input a Server Folder directory location to store the uploaded document in the repository. View Server
Folders enables you to browse the existing locations.

5 Expand Show Advanced Options and select the Remove Unsynchronized artifact options to remove
relationships from previously related artifacts that are no longer defined in the new WSDL.

6 Click Save to start the publication process for the implementations contained in the WSDL file.

7 Depending on the content of the file the following additional pages may appear:

a If an archive contains multiple WSDLs, select the WSDLs to publish and then click Next.

b If the selected WSDLs define multiple services, select the services to create and then click Next.

8 Review the artifacts to be created, and then click Finish.
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The Services view of the service re-opens displaying the progress of the publishing task.

To add a SOAP service from a remote location:

1 In the Services view of a service, in the Implementations section, place the cursor over Add SOAP
service to view the available options.

2 Click From Remote File to open the Remote File dialog.

3 Input the url of the remote WSDL file.

You can reference a zip file containing several WSDLs, including referenced schemas.

4 If the remote location requires authentication to access, select Requires Authentication, and input
the username and password required to access it.

5 Input a Server Folder directory location to store the uploaded document in the repository. View Server
Folders enables you to browse the existing locations.

6 Expand Show Advanced Options and complete the dialog with parameters:

DefinitionParameter

The part of the URL location to ignore when creating the publishing location.Base URL

Select a synchronization policy for change management. For more details,
see Synchronization Policy on page 310.

Synchronization

Select to remove relationships from previously related artifacts that are no
longer defined in the new WSDL.

Remove
Unsynchronized

7 Click Upload to start the publication process for the implementations contained in the WSDL file.

8 Depending on the content of the file the following additional pages may appear:

a If an archive contains multiple WSDLs, select the WSDLs to publish and then click Next.
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b If the selected WSDLs define multiple services, select the services to create and then click Next.

9 Review the artifacts to be created, and then click Finish.

The Services view of the service re-opens displaying the progress of the publishing task.

To select a SOAP service from the repository:

1 In the Services view of a service, in the Implementations section, place the cursor over Add SOAP
service to view the available options.

2 Click From Catalog to view a list of SOAP services in the repository.

3 Click add next to the SOAP service you require to associate it with the business service.

Adding XML Services

You can also associate a business service with an XML service artifact.

To add an XML service to a business service:

• In the Service view of a service, in the Implementations section, place the cursor over Add XML
Service to view the following options:

• New XML Service

Create a new XML service to associate with the business service.

For details, see To create a new XML service:

• From Catalog

Select an XML service already in the repository.

For details, see To select an XML service from the repository:.
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To create a new XML service:

1 In the Service view of a service, in the Implementations section, place the cursor over Add XML
Service to view the available options.

2 Click New XML Service to open the New XML Service page.

3 Input the following parameters:

DefinitionParameter

The name of the new XML Service artifact.Name

A description of the XML Service artifact.Description

A version number for the XML Service artifact.Version

Select to make the service available to consumers (not visible
in the General perspective).

Consumable

4 Click Save to create the new XML service artifact and the relationships with the business service.

This process only creates an XML service artifact. You must add an endpoint to the
artifact in the service view of the XML service to make it a functioning implementation.

For details, see Adding Endpoints on page 112.

An XML schema document can also be added to an XML service.

For details, see Adding an XML Service Definition on page 115.

To select an XML service from the repository:

1 In the Service view of a service, in the Implementations section, place the cursor over Add XML
Service to view the available options.

2 Click From Catalog to view a list of XML services in the repository.
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3 Click add next to the XML service you require to associate it with the business service.

Adding Web Applications

You can associate the business service with a web application artifact.

To add a web application to a service:

• In the Services view of the service, in the Implementations section, place the cursor over the Add Web
Application to view the following options:

• New Web Application

Create a new web application associated with the business service.

For details, see To create a new web application:

• From Catalog

Select a web application already in the repository.

For details, see To select a web application from the repository:

To create a new web application:

1 In the Services view of the service, in the Implementations section, place the cursor over the Add Web
Application to view the available options.

2 Click New Web Application to open the New Web Application page.

3 Input the following parameters:

DefinitionParameter

The name of the new web application artifact.Name

A description of the web application artifact.Description

A version number for the web application artifact.Version
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DefinitionParameter

Select to make the service available to consumers (not visible
in the General perspective).

Consumable

4 Click Save to create the new web application and the relationships with the business service.

This process only creates an web application artifact. You must add an endpoint to the
artifact in the service view of the web application to make it a functioning implementation.

For details, see Adding Endpoints on page 112.

To select a web application from the repository:

1 In the Services view of the service, in the Implementations section, place the cursor over the Add Web
Application to view the available options.

2 Click From Catalog to view a list of web applications in the repository.

3 Click add next to the web application you require to associate it with the business service.

Adding WSDLs

A SOAP service is normally defined by a WSDL.

To add a WSDL to a SOAP service:

• In the Service view of a SOAP service, in the SOAP Service Properties section, expand Upload WSDL
to view the following options:

• From Local File

Add a WSDL from the local file system.

For details, see To add a WSDL from your local file system:
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This process uses the publisher functionality.

For details, see Publishing Services on page 127.

• From Remote File

Add a WSDL from a remote location.

For details, see To add a WSDL from a remote location:

This process uses the publisher functionality.

For details, see Publishing Services on page 127.

To add a WSDL from your local file system:

1 In the Services view of a SOAP service, in the SOAP Service Properties section, expand Upload
WSDL to view the available options.

2 Click From Local File to open the Local File dialog box.

3 Input the path or use Browse to locate the WSDL file on your local file system.

You can reference a zip file containing several WSDLs, including referenced schemas.

4 Input a Server Folder directory location to store the uploaded document in the repository. View Server
Folders enables you to browse the existing locations.

5 Expand Show Advanced Options and select the Remove Unsynchronized artifact options to remove
relationships from previously related artifacts that are no longer defined in the new WSDL.
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6 Click Save to start the publication process for the implementations contained in the WSDL file.

7 Depending on the content of the file the following additional pages may appear:

a If an archive contains multiple WSDLs, select the WSDLs to publish and then click Next.

b If the selected WSDLs define multiple services, select the services to create and then click Next.

8 Review the WSDLs, services, and artifacts to be published, and then click Finish.

The Services view of the service re-opens displaying the progress of the publishing task.

To add a WSDL from a remote location:

1 In the Services view of a SOAP service, in the SOAP Service Properties section, expand Upload
WSDL to view the available options.

2 Click From Remote File to open the Remote File dialog.

3 Input the url of the remote WSDL file.

You can reference a zip file containing several WSDLs, including referenced schemas.

4 If the remote location requires authentication to access, select Requires Authentication, and input
the username and password required to access it.

5 Input a Server Folder directory location to store the uploaded document in the repository. View Server
Folders enables you to browse the existing locations.

6 Expand Show Advanced Options and complete the dialog with parameters:

DefinitionParameter

The part of the URL location to ignore when creating the publishing location.Base URL
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DefinitionParameter

Select a synchronization policy for change management. For more details,
see Synchronization Policy on page 310.

Synchronization

Select the artifact options to remove relationships from previously related
artifacts that are no longer defined in the new WSDL.

Remove
Unsynchronized

7 Click Upload to start the publication process for the implementations contained in the WSDL file.

8 Depending on the content of the file the following additional pages may appear:

a If an archive contains multiple WSDLs, select the WSDLs to publish and then click Next.

b If the selected WSDLs define multiple services, select the services to create and then click Next.

9 Review the WSDLs, services, and artifacts to be published, and then click Finish.

The Services view of the service re-opens displaying the progress of the publishing task.

After you add a WSDL, the function changes to Update WSDL, enabling you to change the WSDL associated
with the SOAP Service as required.

Adding Endpoints

Implementations require an endpoint artifact to locate the actual implementation of the service.

During a service lifecycle, a number of different endpoints may be required to represent the different
environments hosting the service, for example, development, testing, and production servers.

To add an endpoint to an implementation:

1 In the Services view of an implementation, in the Environments section, click Add Endpoint to open
the Create New Endpoint dialog.

2 Input the following parameters:
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DefinitionParameter

The name of the new endpointName

A description of the endpointDescription

A version number for the endpoint artifact.Version

You can categorize the endpoint by selecting an environment
from the drop-down list.

Environment

The URL for the actual implementation of the serviceEndpoint Address

Port name defined by an associated WSDL.WSDL Port Name

Select to make the service available to consumers (not visible
in the General perspective).

Consumable

3 Click Save to create the new endpoint and the relationships with the implementation.

The new endpoint is added to the Environments section.

Figure 35. Environments Section

The environments section is arranged by environment category, which is normally associated with a particular
lifecycle stage.

Each environment category, contains a table of endpoints associated with implementation servers used at
that particular stage.
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The following functionality is available for environments and endpoints:

• Download WSDL

Creates a version of the WSDL, using the WSDL directly associated with the SOAP Service, and adds
appropriate definitions for the endpoints categorized for a particular environment.

• Clone

Enables you to create a copy of a particular endpoint, with an option to amend any properties.

Adding Operations

Implementations consist of a set of methods with specific functionality. These are represented in SOA
Systinet by operations.

To add an operation to an implementation:

• In the Service view of an implementation, in the Operations section, place the cursor over Add Operation
to view the following options:

• New Operation

Create a new operation to associate with the implementation.

For details, see To create a new operation:

• From Catalog

Select an operation already in the repository.

For details, see To select an operation from the repository:.

To create a new operation:

1 In the Service view of an implementation, in the Operations section, place the cursor over Add Operation
to view the available options.

2 Click New Operation to open the New Operation page.
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3 Input the following parameters:

DefinitionParameter

The name of the new operationName

A description of the operationDescription

Select to make the service available to consumers (not visible
in the General perspective).

Consumable

4 Click Save to create the new operation and the relationships with the implementation.

To select an operation from the repository:

1 In the Service view of an implementation, in the Operations section, place the cursor over Add Operation
to view the available options.

2 Click From Catalog to view a list of operations in the repository.

3 Click add next to the operation you require to associate it with the implementation.

Adding an XML Service Definition

XML service implementations can be defined by an XML schema document.

To add a definition to an XML service:

• In the Service view of an XML service, in the Definitions, place the cursor over Add Definition to
view the following options:

• From Local File

Upload an XSD file from your local file system.

For details, see To upload an XSD file from your local file system:

• From Remote File

Upload an XSD file from a remote location.
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For details, see To upload an XSD file from a remote location:

• From Catalog

Select an XML schema artifact from the collection in the repository.

For details, see To select an XML schema from the repository:

To upload an XSD file from your local file system:

1 In the Service view of an XML service, in the Definitions, place the cursor over Add Definition to
view the available options.

2 Click From Local File to open the Local File dialog box.

3 Input the path or use Browse to locate the XSD file.

4 Input a directory location name to store the uploaded document in the repository. View Server Folders
enables you to browse the existing locations.

5 Click Save to upload the XSD, create a new XML schema artifact and the relationships between the
XML service and the XML schema artifact.

To upload an XSD file from a remote location:

1 In the Service view of an XML service, in the Definitions, place the cursor over Add Definition to
view the available options.

2 Click From Remote File to open the Remote File dialog box.

3 Input the following parameters:

DefinitionParameter

Input the remote location of the file.URL

If the remote location requires authentication to access, select Requires
Authentication, and input the username and password required to access
it.

Requires Authentication
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DefinitionParameter

Input a directory name to store the uploaded document in the repository.
View Server Folders enables you to browse the existing locations.

Server Folder

4 Optionally, expand Show Advanced Options and input the following options:

DefinitionParameter

The part of the URL location to ignore when creating the publishing location.Base URL

Select a synchronization policy for change management. For more details,
see Synchronization Policy on page 310.

Synchronization

5 Click Save to upload the XSD, create a new XML schema artifact and the relationships between the
XML service and the XML schema artifact.

To select an XML schema from the repository:

1 In the Service view of an XML service, in the Definitions, place the cursor over Add Definition to
view the available options.

2 Click From Catalog to view a list of XML schema artifacts in the repository.

3 Click add next to the XML schema you require to associate it with the XML service.

Adding Service Level Objectives
Most services are offered with a set of terms describing the levels of performance the service provider
expects to meet.

This section describes adding an SLO to a business service. The functionality is the same for
any artifact that is defined as a provider.
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To add a service level objective to a service:

• In the Services view of a service, in the Service Level Objectives section, place the cursor over Add
SLO to view the following options:

• New SLO

Create a new service level objective to associate with the service.

For details, see To create a new service level objective:

• From Catalog

Select a service level objective already in the repository.

For details, see To select a service level objective from the repository:

To create a new service level objective:

1 In the Services view of a service, in the Service Level Objectives section, place the cursor over Add
SLO to view the available options.

2 Click New SLO to open the New SLO page:
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3 Input the following parameters which are split into sections:

SLO Properties:

DefinitionParameter

The name of the new SLO artifact.Name

119



DefinitionParameter

A description of the SLO artifact.Description

The initial version number for the SLO.Version

Select an impact from the list.Business Impact

Expected time of service delivery.Service Availability

Expected time of service termination.Service Termination

Select an option from the list, and then input start and end
times if required.

Hours of Service Operation

Hours of Provider Operation

Objectives:

DefinitionParameter

Number of messages.Expected Messages Per Day

Maximum Messages Per Day

Select an option from the list, and then input start and end
times if required.

Daily Peak Period

Expected messaging capacity.Peak [Msg/Min]

Key Performance Indicators:

DefinitionParameter

The number of calls to the service per minute.Throughput [Msg/Min]

The time for the service to respond.Response Time [sec]

The availability of the service in its operating hours.Availability [%]

A measure of the performance of the service.Performance [%]

4 Click Save to create the service level objective and the relationships to the service.
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To select a service level objective from the repository:

1 In the Services view of a service, in the Service Level Objectives section, place the cursor over Add
SLO to view the available options.

2 Click From Catalog to view a list of service level objectives in the repository.

3 Click add next to the service level objective you require to associate it with the business service.

Making Services Available
When you consider a service to be ready you can make it available for consumption.

To make a service available to consumers:

1 In the Services view of a service, click Edit.

The Edit page for the service opens.

2 Select Consumable.

3 Click Save to make the service available for consumption.

Using Applications
SOA Systinet enables you to organize your business services into a set of applications. You can use these
applications as the primary service artifact for the purposes of contract and lifecycle management.

The following sections describe how to use applications:

• Creating an Application on page 122

• Adding a Service on page 122

The following functionality for applications is the same as for a business service:

• Attaching documentation.

For details, see Adding Service Documentation on page 97.
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• Applying service level objectives.

For details, see Adding Service Level Objectives on page 117

• Making the application available to consumers.

For details, see Making Services Available on page 121.

Creating an Application

SOA Systinet enables you to create artifacts to represent your applications.

To create a new application:

1 In the Services tab New menu, click Application to open the New Application page.

2 In the New Application page, input the following parameters:

DefinitionParameter

A name for the application.Name

A description of the application.Description

The initial version number for the application.Version

An alias for the application.Alias

Select to make the application available to consumers.Consumable

3 Click Save to create the new application artifact.

Adding a Service

An application represents a set of business services.

To add a business service to an application:

1 In the Business Services section of the application view place the cursor over Add Business Service
to view the following options:
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New Business Service

Create a new business service as part of the application.

•

• From Catalog

Select a business service already in the repository.

2 Do one of the following:

• To create a new business service:

1 Click New Business Service to open the New Business Service page.

2 Input the business service parameters.

For details, see Creating Business Services on page 95.

3 Click Save to create the business service and the relationships to the application.

• To select a business service from the repository:

1 Click From Catalog to view a list of business services in the repository.

2 Click add next to the business service you want to associate with the application.

Using Operations
SOA Systinet enables you to use operations as the primary service artifact for contract and lifecycle
management.

To create a new operation:

1 In the Tools tab Catalog Browser, click Operations to open the Operations browse page.

2 Click New to open the New Operation page.
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3 In the New Operation page input the following parameters:

DefinitionParameter

The WSDL operation name (pt:plaintext). For example doGetCachedPage.Name

A description of the application.Description

Select taxonomic categories for the operation.Categories

The WSDL operation name (optional, pt:plaintext). For example
doGetCachedPage.

Operation name

The WSDL port type (optional, pt:plaintext). For example RegistrySearchPort.Port Type

The WSDL target namespace (optional, pt:plaintext). For example
ure:RegistrySearch.

Target Namespace

The XSD input message types (multiple pt:plaintext). For example
{http://www.w3.org/2001/XMLSchema}string.

Input Types

The XSD output message types (multiple pt:plaintext). For example
{http://www.w3.org/2001/XMLSchema}base64binary.

Output Types

The XSD fault message types (multiple pt:plaintext). For example
{urn:RegistrySearch}failure.

Fault Types

Select to make the operation available to consumers.Consumable

4 Click Save to create the new operation.

The Tools detail view for the operation opens. Switch to the service view to add implementations and
service level objectives.

The following functionality for operations is the same as for a business service:

• Adding implementations.

Operations can be added to implmentations.

For details, see Implementing Services on page 101.

• Applying service level objectives.
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For details, see Adding Service Level Objectives on page 117

• Making the operation available to consumers.

For details, see Making Services Available on page 121.
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11 Service Discovery

SOA Systinet enables you to publish entire service infrastructures based on a number of different
architectures.

These methods are described in the following sections:

• Publishing Services on page 127

Publish service infrastructures using definition documents that describe them.

• Importing Services from Registries on page 134

Import service infrastructure from a UDDI Registry.

• BAC/UCMDB Service Discovery on page 137

Import service infrastructure from a BAC/UCMDB server.

Publishing Services
SOA Systinet enables you to upload definition documents that describe service infrastructures. SOA Systinet
processes the content of the document and enables you to create or modify artifacts to represent this
infrastructure in SOA Systinet.

SOA Systinet can process the following definition document types:

• Web Service Definition Language documents (WSDL)

• Service Component Architecture documents (SCA 1.0)

• Business Process Execution Language documents (BPEL 1.1 and 2.0)

• XML Schema Definition documents (XSD)
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• Extensible Stylesheet Language Transformation documents (XSLT)

• Document Type Definition documents (DTD)

• Any other file type is treated as documentation.

• Archives containing the above types of files.

To publish service infrastructure definitions:

1 In the Tools tab menu New section, click Upload Data Content.

The Upload Data Content page opens.

2 Do one of the following:

• To upload from a local file system:

1 Select Local File.

2 Use Browse or input a file path.

3 Input the Server Folder to store the data content files in the repository.

Click View Server Folders to browse the repository workspace.

• To upload from a remote location:

1 Select Remote File.

2 If the remote location requires authentication to access, select Requires Authentication, and
input the username and password required to access it.

3 Input the URL for the remote file location.

4 Input the Server Folder to store the data content files in the repository.
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Click View Server Folders to browse the repository workspace.

3 Optionally, expand  Show Advanced Options and select from the following options:

DefinitionParameter

The final publishing location for remote resources is determined by the Input
URL, the Server Folder and the Base URL, as follows. If you publish a file

Base URL (Remote File
only)

from http://server/some/path/somefile.wsdl, select a server folder /mywsdls,
and set the Base URL to http://server/some, the final publishing location is
/mywsdls/path/somefile.wsdl.

Select a Synchronization policy for change management. For more details,
see Synchronization Policy on page 310.

Synchronization
(Remote File only)

Select a WSDL processing level from the following options:Decomposition

• Services

Process any WSDLs, create all defined content and create business services
to associate with any newly created implementations.

• Implementations

Process any WSDLs and create all defined content. Business services are
not created.

• None

Publish any WSDLs as artifacts with attached data content. The WSDL
files are not processed.
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DefinitionParameter

Select to extract an archive and publish all the content (default option). If
not selected, the archive is published as a Documentation artifact with
attached data content.

Process Archive Content

By default, this functionality supports ZIP, JAR, EAR, WAR,
and BPR. Other archive types are not processed by the
publisher and are published as documentation artifacts with
attached data content..

The archive types of archive that the publisher processes is
configurable. For details, see "Configuring Archive Publishing"
in the HP SOA Systinet Administrator Guide.

If a WSDL is republished the artifacts it references may change and
previously created artifacts may no longer be required. Select artifact types
to remove the relationships with these obsolete referenced artifacts.

Remove
Unsynchronized

4 Click Next.

The publisher analyzes the content of the selected files and services and the Publishing Overview page
opens. This page displays a list of the content of the file and a decomposition of any WSDLs. The page
displays the artifacts to create or modify and a publishing status compared to existing artifacts.

This process may take some time.

The content is listed with the following possible statuses:

• New

A new artifact will be created.

• Changed
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The artifact already exists and will be updated.

• Duplicate

A similar artifact exists, usually in a different publishing location.

• Error

The publisher encountered an problem processing this content.

• Identical

An identical artifact exists, usually in the same publishing location.

• Kept

An existing artifact referenced by a previous version of the defining document that retains any
existing relationships.

• Unsynchronized

An existing artifact referenced by a previous version of the defining document that loses any existing
relationships.

• Warning

Additional warnings reported.

It is possible for particular content to have multiple statuses.

If there are any publishing problems, a warning box displays and you can click Details to view the
specific problems for particular content.

5 Select the file content to publish and then click Finish.

Publishing may involve large numbers of artifacts. SOA Systinet executes publishing as an asynchronous
task.
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When publishing starts, the Publishing page opens with an information bar showing the progress of
the task.

Publishing executes asynchronously so you can continue with other work while the task finishes.

You can monitor tasks in progress in the Dashboard My Task Results portlet. For details, see My Task
Results Portlet on page 54.
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6 The Publishing Report displays the current status of the task, with an option to Stop the task if required.

The Report Data section displays the results for each published artifact.

Click Refresh to update the Report Data section while publishing is in progress..

7 After publishing is complete, there is an option to Undo Changes. Click Undo Changes to undo
changes to published artifacts. This also executes as an asynchronous task.

Undo only applies to the revision of the artifact created by publishing. Any subsequent
modifications of an artifact change its revision and the Undo option will not rollback
these artifacts.

SOA Systinet also uses the definition document processing functionality of the publisher if
you publish a document using the following functionality:

• Adding documents to SOA Systinet with an associated external resource.

For details, see Adding Documentation on page 288 and Managing Definition Data on page
290.

• Adding a SOAP Service implementation to a business service.

For details, see Adding SOAP Services on page 102.

• Adding a WSDL to a SOAP Service implementation.

For details, see Adding WSDLs on page 109.

• Adding an XSD definition to an XML service.

For details, see Adding an XML Service Definition on page 115.
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Importing Services from Registries
SOA Systinet enables you to import services and associated entities from a UDDI Registry.

Before any data transfer takes place between SOA Systinet and a UDDI registry, a registry
artifact must be created, registry certificates must be imported to SOA Systinet, and the
taxonomies must be synchronized.

For details, see "Registry Setup and Configuration" in the HP SOA Systinet Administrator
Guide.

To import data from a UDDI registry:

1 In the Tools tab menu, under Registry Content, click Import Registry Content to open the Import
Artifacts from Registry page.

2 In the Import Artifacts from Registry, select a registry from the drop-down list or click New, to create
a new registry artifact.

For details about creating a registry artifact, see "Creating a Registry Artifact" in the HP SOA Systinet
Administrator Guide.

Click Next to set the import details:
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3 Input the following parameters:

DefinitionParameter

The target registry to import data fromRegistry Name

Select a policy from the drop-down list. For more details see Synchronization
Policy.

Default synchronization
policy

Select entity type to populate the tableSelect the type of data

4 Use Find to filter that data set.

5 Select data from the registry to import and then click Next.
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6 In the summary page, verify the data to be imported, and then click Finish.

If you are importing a business entity, all its business services are imported as well, and
if you are importing a business service, all its binding templates are also be imported. If
a single business entity is imported then input a service name and description for the new
business service artifact to associate with the imported items.

Any imported endpoints are categorized according to the following rules:

• If the endpoint is categorized by a keyed reference in the registry, the same environment
category is applied to the endpoint in SOA Systinet.

• If the endpoint is uncategorized in the registry, if only one environment category
applies to the registry artifact in SOA Systinet, the same environment category is
applied to the endpoint in SOA Systinet. If the registry artifact is uncategorized or
categorized by multiple environments, no category is applied to the endpoint in SOA
Systinet.

When the import process begins, an import report is created. This process takes some time so click Refresh
every so often - you may have do this several times until the report is complete (and Refresh disappears).

When the import is complete, click one of the Registry Import Reports in the Sub report section to view
the import report details for that entity.

The most important part of the report is the Report Data section:

This report shows exactly what was imported, and the import status of all the imported items.
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DefinitionParameter

DescriptionStatestate

The item was successfully imported.IMPORTED

The item was successfully exported.EXPORTED

The item (Business Service or Binding Template) was deleted
from the UDDI registry during export because the
corresponding artifact had been deleted in SOA Systinet.

DELETED

An error occurred during the export/import of the item.FAILED

The UDDI entity type: Business Entity, Business Service or Binding Templatetype

The SOA Systinet artifact nameartifact name

The unique id of the corresponding UDDI entityuddi registry key

The synchronization status before the import/export was performedstatus

BAC/UCMDB Service Discovery
SOA Systinet enables you to import services from the Universal Configuration Management Database
(UCMDB) used by HP Business Availability Center (BAC).

BAC/UCMDB server must be integrated with SOA Systinet.

For details, see "Setting Up BAC/UCMDB Integration" in the HP SOA Systinet Administrator
Guide.

To import services from BAC/UCMDB:

1 In the Services tab menu Service Discovery section, click BAC/UCMDB .

The BAC/UCMDB Service Discovery page opens.

2 Click Start Discovery.

A task progress information bar opens with a link to the discovery process report.

137



The task consists of the following stages:

1 Read the data from the BAC/UCMDB server.

2 Store the discovered data in the SOA Systinet repository.

3 Update relationships between artifacts in the repository.

Discovery executes asynchronously so you can continue with other work while the task finishes. SOA
Systinet notifies you by e-mail when the task is complete.

You can monitor tasks in progress in the Dashboard My Task Results portlet. For details, see "My Task
Results Portlet".

You can view the progress and results of the discovery task by clicking Click here for detailed report in
the information section of the BAC/UCMDB Service Discovery page. The report shows a table of discovered
and stored artifacts and if the task is still executing, the task progress bar is displayed with an additional
option to stop the task.

To stop a running BAC/UCMDB discovery task:

1 In the BAC/UCMDB Service Discovery page, in the task progress information bar, select Click here
for detailed report.. The Report - BAC Discovery Tool page opens.

2 Click Stop.

The task does not stop immediately. The import of data stops, but SOA Systinet ensures that the data
imported is consistent by updating the relationships between stored artifacts.

If you execute discovery again, the data not imported the first time is re-discovered and then imported.
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You can schedule BAC/UCMDB Discovery to execute at a set time or on periodic basis. Click Schedule
Task and set the execution details. For details, see Setting a Schedule on page 318.

If a task already exists, Set Schedule is replaced with and information bar displaying the next scheduled
discovery execution time.

Figure 36. BAC/UCMDB Service Discovery

After a discovery task, the BAC/UCMDB Service Discovery page is populated with a list of services from
the BAC/UCMDB server that are not already in governance in SOA Systinet, or have not been marked as
rogue or infrastructure.

Any discovered endpoints are categorized with the same environment category applied to the
BAC/UCMDB server artifact.

You can process services imported from BAC/UCMDB.

For details, see the following sections:

• Governing Discovered Services on page 140

139



Put services into a governance lifecycle process.

• Marking Discovered Services as Rogue on page 142

Mark discovered services as unnecessary and ignore them in subsequent discoveries.

• Marking Discovered Services as Infrastructure on page 142

Mark discovered services as background services and ignore them in subsequent discoveries.

These functions are not available if there is a discovery task in progress.

After discovery, services are monitored for changes and can be synchronized.

For details, see Synchronizing Discovered Services on page 143.

In addition, you can use bulk operations on these services using the functionality in the Actions menu.

These actions are the same as those in Services list views.

Governing Discovered Services

You can start lifecycle management for the services imported from BAC/UCMDB.

The govern discovered service process checks the repository for matching artifacts and resolves potential
conflicts. The default rules for a conflict are determined by a configuration file. The default behaviour is
to check for artifacts with matching name properties. For SOAP Services, SOA Systinet checks for matching
serviceName and serviceNamespace properties before checking the name.

A matching Business Service, SOAP Service, or Organizational Unit in the repository is assumed to be the
same entity discovered in BAC/UCMDB. The artifact properties in the repository version are overwritten
by the properties of the discovered entity. These properties are defined by a mapping file.

Any existing relationships with the existing repository artifact are preserved with the exception of previously
discovered entities. For example, a Business Service created in SOA Systinet is implemented with a SOAP
Service previously discovered in BAC/UCMDB. The same business service in BAC/UCMDB has the SOAP
service removed and is then discovered. SOA Systinet removes the relationship to that SOAP Service.
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In the event that there are two or more artifacts in SOA Systinet that conflict with a discovered entity, you
must resolve the conflict manually as described in To govern discovered services:.

To govern discovered services:

1 In the Services tab menu Service Discovery section, click BAC/UCMDB.

The BAC/UCMDB Service Discovery page opens.

2 Select the services to enter into governance, and click Apply Governance.

The Govern Discovered Services page opens.

3 If the default governance process is not the correct process, use Change to select one.

4 Select the lifecycle stage at which to enter the governance process, and select Stage Completed if all
the requirements of the lifecycle stage are complete.

5 Do one of the following:

• If there are no unresolved conflicts, click Save to enter the service into the selected governance
process.

The BAC/UCMDB Service Discovery page re-opens and the newly governed service is removed
from the list of discovered services.

• If there are conflicts that require manual resolution, click Next.

The Resolve Ambiguities page opens.

6 Do any of the following:

• To leave the discovered entities ungoverned, select the entities and click Skip.

• To create a new artifacts without merging with existing ones, select the entities and click Mark as
New.

• To merge a discovered entity with an existing artifact, click Map to for the entity, select the artifact
to merge and click OK.
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Each action changes the Resolve as status.

7 Do one of the following:

• If there are conflicts for another artifact type, click Next and return to Step 6 for that artifact type.

• When all the conflicts are resolved, click Finish to perform your selected actions.

Marking Discovered Services as Rogue

Some of the discovered services may not be useful or necessary. Marking them as rogue makes them invisible
in the SOA Systinet UI and ignores them in subsequent discovery processes.

To mark a discovered service as rogue:

1 In the Services tab menu Service Discovery section, click BAC/UCMDB.

The BAC/UCMDB Service Discovery page opens.

2 Select the services to mark as rogue, and click Mark as Rogue.

The Govern Discovered Services page opens.

3 Review the list of services, and then click Mark as Rogue.

The BAC/UCMDB Service Discovery page re-opens and the rogue service is removed from the list
of discovered services.

Marking Discovered Services as Infrastructure

Some discovered services may be internal parts of third party products. Marking them as infrastructure
makes them invisible in the SOA Systinet UI and ignores them in subsequent discovery processes.

To mark a discovered service as infrastructure:

1 In the Services tab menu Service Discovery section, click BAC/UCMDB.

The BAC/UCMDB Service Discovery page opens.
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2 Select the services to mark as infrastructure, and click Mark as Infrastructure.

The Govern Discovered Services page opens.

3 Review the list of services, and then click Mark as Infrastructure.

The BAC/UCMDB Service Discovery page re-opens and the infrastructure service is removed from
the list of discovered services.

Synchronizing Discovered Services

Services discovered in BAC/UCMDB and entered into governance in SOA Systinet are monitored for
changes.

The Service Discovery section of the Services view of a discovered services displays the source of the
service, and it synchronization status:

Click details to view more information about the status and source of the discovered service.

Click import to update the SOA Systinet artifact with the latest changes from BAC/UCMDB.
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12 Lifecycle Governance

SOA Systinet provides functionality that enables you to manage the lifecycle of artifacts by creating
governance processes. Each artifact can then be associated with a different governance process.

SOA Systinet enables you to manage a hierarchy of artifacts, a governance tree. The root artifact is the top
level of a governance tree, related child artifacts are sub-artifacts in the governance tree. For example, a
business service and its implementations.

The governance tree enables you to move these related artifacts through the same governance process
together, while applying different task, policy, and approval conditions to root and sub-artifacts.

In the Services tab, the Lifecycle section gives access to these features:

• Governance Dashboard

Opens an overview page of governance records in which you have an interest.

• Approval Requests History

Opens an overview page of all resolved (historical) approval requests.

Governance processes are managed by the administrator and accessed using the Governance Processes
link in the Tools tab Administration menu.

The lifecycle process described in this chapter is based on the standard lifecycle taxonomy
provided with SOA Systinet. You can modify the lifecycle taxonomy with using HP SOA
Systinet Taxonomy Editor.
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For details, see the HP SOA Systinet Taxonomy Editor Guide.

The lifecycle management procedures are described in the following sections:

• Defining Governance Processes on page 146

• Managing Governance Processes on page 161

• Governing Artifacts on page 163

• Lifecycle Reports on page 172

Defining Governance Processes
Governance is a combination of processes, practices and tools which facilitate the lifecycle of artifacts.
SOA Systinet lifecycle governance enables the successful management of processes, their associated stages,
and the creation and management of approval processes, tasks, and policies.

Only the Administrator can manage governance processes, using the Governance Processes
link in the Administration menu.

The creation of a governance process is described in the following sections:

• Creating a Governance Process on page 147

Explains how to create an initial governance process.

• Defining Lifecycle Stages on page 152

Explains how to define lifecycle stages of root and sub-artifacts.

• Copying Lifecycle Stages on page 159

Shows how to copy previously defined lifecycle stages.

• Removing Lifecycle Stages and Definitions on page 160

Shows how to delete previously defined lifecycle stages.
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• Cloning a Governance Process on page 161

Describes how to clone an existing governance process.

Creating a Governance Process

The first stage in artifact lifecycle management is the creation of a governance process.

To create a new governance process:

1 In the Tools tab Administration menu, click Governance Processes to open the Governance Processes
page, and then click New.

The New Governance Process page opens, as shown in Figure 37, “New Governance Process”.
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Figure 37. New Governance Process

2 In the General section, enter a Name and Description for the governance process.

3 In the General section, define the lifecycle stages for the governance process, as follows:

• If you want this process automatically assigned to appropriate artifacts, select Automatically
assigned.

• The Starting Stage is automatically set to Kick-Off and all lifecycle stages are selected.

De-select the check-box of the lifecycle stages you do not need.
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To reorder lifecycle stages, drag and drop stages to the order you require.

4 In the Association Rules section, select the Root Artifact Types (required) and Sub-Artifact Types
(optional) to be governed.

To select artifact types, do the following:

a Click Edit to open a list of available artifact types.

b Browse or use the Quick Find box to select the artifacts you need and click OK.

5 Optionally, select In Categories and Not in Categories to select taxonomic association rules for the
automatic assignment of the governance process to artifacts based on their categorizations.

• In Categories: Artifacts must contain these categories to be automatically assigned to the governance
process.

• Not In Categories:: Artifacts must not contain these categories to be automatically assigned to the
governance process.

To select a category, do the following:

a Click Select Categories and do one of the following:

• Select Properties to view the taxonomies list with taxonomic properties of the Root artifact
types.

• Select Other Categories to view the taxonomies list with all taxonomies.

b Click Add to open the list of taxonomies.

c Select a taxonomy, to display a list of categories.

d Select the categories to add from the taxonomy, and then click Add.
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In cases where two or more automatically assigned governance processes apply for an artifact type,
SOA Systinet uses these association rules to assign the most appropriate governance process. For more
details, see "Governed Artifacts" in the HP SOA Systinet Concepts Guide.

6 Click Save.

The new governance process opens in the View Governance Process page, as shown in Figure 38,
“View Governance Process”.
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Figure 38. View Governance Process

This is a new governance process, so the default Published status is No.
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Defining Lifecycle Stages

Lifecycle stages represent important milestones in the governance process. Lifecycle stages and their order
are defined in the governance process definition.

Each lifecycle stage consists of a set of conditions described in the following procedure:

To define lifecycle stages:

1 In the Administration menu of the Tools tab, click Governance Processes to open the Governance
Processes page, and then click the name of the required process.

The Governance Process page opens.

2 Do one of the following:

• To set a stage definition for root artifacts:

• In the Stage Definitions pane, expand the root artifact to open the list of defined stages and
click Edit next to the stage you want to modify.

The Edit Stage Definition page opens.

• To set a stage definition for sub-artifacts:

1 In the Stage Definitions pane, navigate to and click Add Stage Definition to open the drop-
down list, and then select the name of the sub-artifact you want to define a stage for.

The New Stage Definition page opens.

2 In the Stage field, open the drop down list of available stages and select the one you want to
define.

3 In the Stage Definition Page, do any of the following:

• Set voters for approval and rollback.
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For details, see Defining Approval and Rollback Voters on page 154.

• Define tasks to complete before stage approval.

For details, see Setting Stage Definition Tasks on page 155.

• Set policies to comply with before stage approval.

For details, see Setting Stage Definition Policies on page 155.

• Define automatic actions to execute when a lifecycle transition occurs.

For details, see Defining Automatic Actions on page 156.

• Define the next stage in the lifecycle (root artifact types only).

For details, see Defining the Next Lifecycle Stage on page 159

• Specify whether to automatically promote on stage approval (root artifact types only).

For details, see Defining Automatic Promotion on page 159.

Click Save to save the Stage Definition and return to the Governance Process page.

A valid stage definition must contain at least one of the above conditions.

To view definitions of all stages of a specific artifact type, click the artifact name in the Stage
Definitions pane to open the Stage Definitions page.

All stage details are listed. You can edit or copy a stage definition using Edit or Copy.
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Defining Approval and Rollback Voters

For each lifecycle stage in a governance process you can define a unique set of approvers. The approvers
determine whether the artifacts governed by the process are complete for the current stage or for rollback
of the currently approved stage.

To define voters for approval or rollback:

1 Next to Approval or Rollback, click Set Approvers to open the Set Approvers page.

In the Set Approvers page, do any of the following:

• To add an individual voter:

1 Select the Users tab.

2 In the Search for field, enter the user name to locate (use an asterisk (*) as a wildcard), and then
select whether you want to search by Full Name or Login Name from the drop down menu.

3 Click Go to show matching search results.

4 Click Select next to the user name to add as an approver.

The selected voter is added to the Approvers list.

5 Select the Required check-box for an approver to make their voter mandatory.

• To remove individual voters, select the check-box next to their name, and then click Remove.

The selected voters are removed from the Approvers list.

• To add a group voter:

1 Select the Groups tab.

2 In the Search for field, enter the group name to locate (use an asterisk (*) as a wildcard).

3 Click Go to show matching search results.

4 Click Select next to the group to add as an approver.
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The selected group is added to the Approvers list.

5 In Required Votes, enter the number of votes required from group members.

• To remove groups, select the check-box next to the group name, and then click Remove.

The selected groups are removed from the Approvers list.

• To set a minimum number of votes, expand Show Advanced Options and set a required number
of votes in Minimum Total Votes.

2 Click OK to save the approvers and return to the Stage Definition page.

The Approval or Rollback field displays the new details.

Setting Stage Definition Tasks

You can define a set of manual tasks to perform as part of a lifecycle stage.

To add a task:

1 In the Tasks field, click Add to open the Add Task section.

2 Enter a name and description for the task.

3 Select Completion Tracking if the task must be complete prior to stage approval.

4 Click Add.

The new task is added to the Tasks field.

To edit an associated task, click Edit in the task row, edit the parameters as required, and then, click OK.

To remove tasks, select the check-box next to the task name, and click Remove.

Setting Stage Definition Policies

You can define a set of policies to validate artifact compliance as part of a lifecycle stage.
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To add a policy:

1 Click Add to open the Add Policy section.

2 In the Search for field enter the policy text to locate (use an asterisk (*) as a wildcard), and select
whether to search by name or description.

3 Click Go to show matching search results.

4 To add policies, select the check-box next to the policy name, and then click Add.

The selected policies are added to the Policies field.

5 Select Required for policies that must pass validation prior to stage approval.

To remove associated policies, select the check-box next to the policy name, and click Remove.

Defining Automatic Actions

When an artifact changes lifecycle status you may want to change some of its properties.

Automatic Actions enable you to define a number of property changes to trigger automatically when a
specified lifecycle change occurs.

The types of action available and the lifecycle events that trigger them are described in Table 1, "Automatic
Action Types" and Table 2, "Automatic Action Triggers".

Table 1. Automatic Action Types

DescriptionAction

Modify read and write access for artifacts governed by the
process.

Change Access Rights

Send notification e-mails to users about lifecycle status changes.Notify

Prevent the creation of new contracts.Disable Consumption

Allow the creation of new contracts.Enable Consumption

Modify the user responsible for the artifacts governed by the
process.

Change Owner
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Only events applicable to artifacts governed by the lifecycle process are available.

Table 2. Automatic Action Triggers

DescriptionTrigger

Execute actions when artifacts begin a new lifecycle stage.Entering Stage

Execute actions when an approval request is made.Approval Started

Execute actions when an approval request is cancelled.Approval Cancelled

Execute actions when approval fails because of failed
compliance or rejection by approvers.

Approval Failed

Execute actions when approval is successful and the artifact is
unlocked for editing.

Approval Succeeded

Execute actions when a rollback request is made.Rollback Started

Execute actions when a rollback request is cancelled.Rollback Cancelled

Execute actions when rollback fails.Rollback Failed

Execute actions when rollback is approved and the artifact is
unlocked for editing.

Rollback Succeeded

Execute actions when artifacts leave the current stage.Leaving Stage

Not all triggers are available for each action. Only triggers relevant for a particular event are
available, or in some cases automatically selected.

To add an automatic action:

• In the Actions section, expand Add Action and select one of the following actions:

• Change Access Rights

The Change Access Rights page opens.

For details, see "Access Rights" in the HP SOA Systinet Administrator Guide.
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• Notify

The Notification Message page opens.

For details, see Notifications on page 285.

• Disable Consumption

The Disable Consumption action is added to the lifecycle transition.

When the transition occurs, the automatic action changes the Consumable property to False, disabling
the creation of new contracts, typically on approval of the Retired stage.

For details, see Chapter 13, Managing Contracts.

Any existing contracts remain valid.

• Enable Consumption

The Enable Consumption action is added to the lifecycle transition.

When the transition occurs, the automatic action changes the Consumable property to True, enabling
the creation of new contracts, typically on approval of the Production stage.

For details, see Chapter 13, Managing Contracts.

Consumers of previous major versions of the artifact are automatically notified about
the availability of the new version.

• Change Owner

The Change Owner page opens.

For details, see Changing Artifact Ownership on page 281.
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To edit an action, click Edit in the action row to open the Edit page and see the relevant section for adding
that type of action.

To remove actions, select the check-box next to the action name, and click Remove.

Defining the Next Lifecycle Stage

By default, the order of lifecycle stages in a governance process is determined by the order of stages set
during process creation. For each individual stage, you can determine the next lifecycle stage for root artifact
types.

To define the next lifecycle stage:

1 In the Next Stage field, click Edit to open the Select a Stage section.

2 Select the next lifecycle stage, and then click OK.

The Next Stage field updates with the new details.

You can select multiple next stages. In this case, the stage to promote to is determined when
a Promotion is performed. For details, see Promoting and Demoting Artifacts on page 170.

Defining Automatic Promotion

By default, promotion is a manual process performed after stage approval. For each individual stage, you
can specify automatic promotion to a designated next lifecycle stage for root artifact types.

To specify automatic promotion:

• In the Promotion field, select Automatic to: and specify the stage to promote to from the drop-down
list. Only valid stages specified in Defining the Next Lifecycle Stage on page 159 are shown.

Copying Lifecycle Stages

SOA Systinet enables you to define lifecycle stages by copying details from one lifecycle stage to another.
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To copy a lifecycle stage definition:

1 In the Stage Definitions pane, expand the required artifact type to view available stages, and then click
Copy next to the stage that you want.

The Copy Stage page opens.

2 In the Destination pane, do the following:

• In the Stage field, click Edit to open a list of available stages, select the destination stages you need,
and then click OK.

• In the Artifact Type field, click Edit to open a list of available artifacts, select the destination artifacts,
and then click OK.

3 In the What To Copy pane, select whether to copy the associated approvals, rollbacks, tasks, policies,
or automatic actions from the source stage, and then click Save.

The destination stages are updated in the Stage Definition pane.

Removing Lifecycle Stages and Definitions

Lifecycle stages consist of two elements, the stage itself as a step in the lifecycle process and the stage
definition which describes the associated tasks, policies, and actions.

To remove a stage definition:

1 In the View Governance Process page, in the Stage Definitions pane, expand the artifact types to view
their stage definitions.

2 Select the check-boxes for the stages to remove and click Remove.

Root artifact stage definitions are reset to empty lifecycle stages with no associated tasks, policies, or
actions. The stage itself remains as a step in the governance process.

Sub-artifact stage definitions are removed from the process.
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To delete a lifecycle stage:

1 In the View Governance Process page, click Edit to open the Edit Governance page.

2 In the Process Details section, de-select any stages that the process does not require, and click Save.

Usually, the governance process is reset with the next stage for each lifecycle stage set to match the order
of the remaining lifecycle stages. However. if the currently defined next stages do not match the order in
which they are listed they cannot be automatically modified. You should review them and change them
manually if required.

Cloning a Governance Process

Creating governance processes can take some time. SOA Systinet includes a feature which enables you to
create a new governance process with parameters based on an existing governance process, enabling one
process to be used as a template in the creation of others.

To clone a governance process:

1 In the Administration menu of the Tools tab, select Governance Processes to open the Governance
Processes page.

2 Click the required process to open the Governance Process page, and click Clone.

3 To edit the cloned governance process, click Edit and follow the procedure from Step 2 of Creating
a Governance Process on page 147.

Managing Governance Processes
Before a governance process can be successfully used, you must publish it.

The publication and management of a governance process is described in the following sections:

• Publishing a Governance Process on page 162

• Deprecating a Governance Process on page 162

• Deleting a Governance Process on page 162
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Publishing a Governance Process

After creating a governance process, the next step is to make it available for the governance of artifacts.

To publish a governance process:

• From the Administration menu of the Tools tab, click Governance Processes to open the Governance
Process page, and then do one of the following:

• Select the check-box next to the name of the governance process you need and click Publish.

• Click the name of the governance process you need to open the Governance Process page, and click
Publish.

This governance process is now available to be used in the governance of root and sub-artifacts.

Deprecating a Governance Process

If you need to make a governance process unavailable for the governance of artifacts, you can deprecate
it.

To deprecate a governance process:

• From the Administration menu of the Tools tab, click Governance Processes to open the Governance
Process page, and then do one of the following:

• Select the check-box next to the name of the governance process you need and click Deprecate.

• Click the name of the governance process you need to open the Governance Process page, and click
Deprecate.

The governance process is deprecated and its status is changed to Deprecated and is not available for
the governance of artifacts until it is published.

Deleting a Governance Process

If a governance process is no longer being used in the governance of artifacts, you can delete it.
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To delete a governance process:

• From the Administration menu of the Tools tab, click Governance Processes to open the Governance
Process page, and then do one of the following:

• Select the check-box next to the name of the governance process you need and click Delete.

• Click the name of the governance process you need to open the Governance Process page, and click
Delete.

The governance process is deleted and is no longer available to be used in the governance of artifacts.

Governing Artifacts
During the process of artifact governance, each lifecycle stage represents an important milestone. Depending
on the configuration of the lifecycle stage, the completion of the current stage requires approval.

The Administrator has the ability to change governance processes, lifecycle stages, and to
force promotion without approval. A user with write permission is able to switch artifacts to
another governance process if the new governance process governs the same artifact structure.
You can do this from the Manage Governance page of the artifact Stage Details. The
administrator can also review all root artifacts governed by a particular process in the detail
page of the process using the View→Usage context action.

The overall process for artifact governance consists of the following processes:

• Starting Artifact Governance on page 164

Enter an artifact into governance, this may be automated for new artifacts.

• Managing Associated Policies and Tasks on page 165

Perform policy validation and task completion for a lifecycle stage.

• Submitting an Approval Request on page 166

Request approval for the current working stage.
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• Submitting a Rollback Request on page 168

Request rollback for the current approved stage.

• Handling Approval and Rollback Requests on page 168

Grant or deny approval and rollback requests.

• Promoting and Demoting Artifacts on page 170

Promote and demote the current working stage.

• Ending Artifact Governance on page 171

Take an artifact out of governance.

• Governance History on page 171

Starting Artifact Governance

This function enables the governance of an artifact that is not currently governed, and where the artifact
will act as the root artifact in an existing governance process.

SOA Systinet automatically assigns new artifacts to governance processes according to
association rules set when creating a governance process. For details, see Creating a Governance
Process on page 147.

To start governing an artifact:

1 From the browse page of any ungoverned artifact, open the Governance menu and select Start
Governance.

The Start Governance page opens.

2 In the Process field, select the process you want to use and click OK.
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Managing Associated Policies and Tasks

To ensure the approval of lifecycle stages, it is important that you successfully manage policies and tasks
associated with an artifact under governance.

To manage policies associated with a governed artifact:

1 From the detail page of any governed artifact, click the stage name in the Governance section.

The Stage Details page opens, as shown in Figure 39, “Stage Details”.

Figure 39. Stage Details

2 In the Policies pane, do one of the following:
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Click Run Validation next to the policy you need to validate.

If the result of validation is available, it is shown in the Last Result column of the Policies pane.

•

• Click Remove next to a policy name to delete it.

This option is only available if you are the Administrator.

To manage tasks associated with a governed artifact:

1 From the browse page of any governed artifact, navigate to the Governance pane and click Status.

The Stage Details page opens.

2 In the Tasks pane, depending whether the Completion column shows the task as incomplete or complete,
you can click Mark as Complete or Mark as Incomplete to change the status.

This functionality is also available from the To Do sidebar. For details, see Sidebar on
page 83.

To manage policies and tasks for related artifacts, click the artifact name in the Navigation pane and follow
the procedures To manage policies associated with a governed artifact: and To manage tasks associated
with a governed artifact:.

Submitting an Approval Request

When a working stage in the lifecycle for an artifact is complete, you should request approval.

Approval can only be requested on a root or a sub-artifact when all mandatory tasks are
complete on all related artifacts. The approval applies to the whole governance tree that the
artifact is part of.
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To submit an approval request:

1 In the details page of a governed unapproved artifact, in the Governance section, click Request
Approval to open the Request Approval page, as shown in Figure 40, “Request Approval”.

Figure 40. Request Approval

2 Review any changes made to the artifacts in the governance tree, and then click Submit Request to
create the approval request for the users and groups listed in the Approvers section for the current
lifecycle stage.

As part of the approval process, SOA Systinet automatically validates any policies associated with the
current working stage. A progress bar shows the validation progress in the relevant artifact view pages.

If policy validation fails, SOA Systinet cancels the approval request. Access the report from the artifact
view page.

If policy validation succeeds, the approvers are notified of the request by e-mail.

While waiting for approval, the governance tree is locked and cannot be edited or deleted.
Artifacts in the governance tree are unlocked when approval is granted or denied.

To check the status of an approval request, open the Stage Details page of the artifact and click View
Approval Request.
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Submitting a Rollback Request

SOA Systinet enables you to rollback the approved lifecycle stage.

Rollback can only be requested on a root artifact when the current working stage is the same
as the current approved stage.

To submit a rollback request:

1 From the detail page of any governed root artifact, navigate to the Governance pane and click the stage
name.

The Stage Details page opens.

2 Select Administration→Rollback STAGE, and then click OK.

Rollback requests are sent automatically to the designated rollback approvers for the current approved
lifecycle stage.

While awaiting rollback approval, the artifact is locked and cannot be edited or deleted.

To check the approval status of a rollback request, open the Stage Details page of the artifact, and click
View Rollback Request.

Handling Approval and Rollback Requests

A request requiring your approval appears in the Requests to Approve page.

To approve or reject a request:

1 In the Governance Dashboard Requests to Approve section, click the name of the request to open the
stage Approval or Rollback Approval page, as shown in Figure 41, “Approval Request”.
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Figure 41. Approval Request

2 Review the request and any responses made by other approvers, and then do any of the following:

• View Changes

View any changes made to the artifact since the last approval.

• Approve
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To approve the request. Enter your comments, and click Save.

This option is only available if you are an Approver.

• Reject

To reject the request. Enter your comments, and click Save.

This option is only available if you are an Approver.

• Notify Approvers

To make comments on the request without approving or rejecting the request.

This option is only available if you are the Administrator or a Maintainer.

The comments are sent to all approvers by e-mail.

• Cancel Request

To cancel the request.

This option is only available if you are the Administrator or a Maintainer.

A notification e-mail is sent to the owner, maintainers, approvers, and artifact stakeholders with the result
of the approval request (approved, canceled, or rejected). If Automatic Promotion is set, the governance
tree is promoted to next working stage when the current stage is approved. For details, see Defining Automatic
Promotion on page 159.

Promoting and Demoting Artifacts

When the current stage is approved, you can initiate the next working stage in the lifecycle for an artifact.
This process is referred to as Promotion.

You can automate promotion. For details, see Defining Automatic Promotion on page 159.
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To manually promote an artifact to the next working stage.

• In the details page of a governed approved artifact, in the Governance section, click Promote to STAGE.

SOA Systinet promotes the governance tree for the artifact to the next stage in the lifecycle and performs
any automatic actions associated with the transition.

You may want to cancel a promotion and return an artifact to the previous working stage.

To demote and artifact to the previous working stage.

1 In the details page of a governed unapproved artifact, in the Governance section, click the stage name
to open the Stage Details page.

2 Open the Administration context menu, and select Demote to STAGE.

SOA Systinet demotes the governance tree the artifact belongs to to the previous stage in the lifecycle
and performs any automatic actions associated with the transition.

Ending Artifact Governance

This function enables you to end the governance of an artifact.

To end artifact governance:

1 From the browse page of any governed artifact, navigate to the Governance pane and click Details to
open the Stage Details page.

2 Expand Administration→End Governance to open the End Governance page.

3 Click OK.

The artifact is no longer governed.

Governance History

The history of approvals and rollbacks is available from the detail page of any governed artifact and also
from the stage details page.
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To open the governance history of an artifact:

• Do one of the following:

• In the detail view of an artifact, open the Governance menu, and select History.

• Open the Stage Details view for an artifact, open the Views menu, and select History.

Click View Request for a particular stage to view the detailed tasks, policies, and approval information.

Lifecycle Reports
SOA Systinet enables the production of lifecycle statistics reports.

Two reporting tasks can be scheduled, one running a report hourly and the other running a report daily.

The resulting report is dependant on the details specified. An example report is shown below.
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The available report is always the last scheduled report completed successfully.

To save a copy of a report, you can export it to PDF format.

For details on creating and running reports, see Reporting Tools on page 308.

For details on scheduling tasks, see Tasks and Scheduling on page 316.

For details on searching for reports available to produce, see Reports on page 321.
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13 Managing Contracts

SOA Systinet enables contracts to be set up between providers and consumers with associated service level
objectives (SLO).

Contract Manager is an additional component of SOA Systinet. If your license does not include
Contract Manager these features are not available.

By default the following artifact types are defined as providers and consumers:

Consumer Artifact TypesProvider Artifact Types

• Application• Application

• Business Service • Business Service

• Implementation• Implementation

• SOAP Service • SOAP Service

• XML Service• XML Service

• Web Application • Web Application

• Contact• Endpoint

• User Profile• Operation

• Organizational Unit
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The set of provider and consumer artifacts is configurable.

For details, see "Configuring Consumer and Provider Artifacts" in the HP SOA Systinet
Administrator Guide.

Contract management is enabled by the following set of procedures:

• Requesting Consumption on page 176

• Processing Consumption Requests on page 178

• Importing Existing Contracts on page 178

• Revoking an Active Contract on page 179

At each stage in the request process SOA Systinet sends mail notifications to the following users:

• Users with write permission for the provider artifact.

• Users with write permission for the consumer artifact.

• Any additional e-mails listed in the provider artifact stakeHolderEmails property.

• The administrator is not notified unless they are specifically granted write permission from another source.

Requesting Consumption
To consume a provider artifact you must make a request to the provider.

You can make a request if you have write permission for the consumer artifact (the owner, a member of
the owning group, a user with ACL write permission, or the administrator).

To request consumption of a provider artifact:

1 Do one of the following:

• In the Services tab menu New section, click Consumption Request.
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• In the service or detail view of a provider artifact that is available for consumption, open the
Consumption context menu and select New Request.

Skip to Step 4

The New Consumption Request page opens.

2 Select the provider artifact type from the list and then click Next.

If there are no available provider artifacts for the selected type SOA Systinet warns you.

3 Use Filter to find the provider artifact.

Select the provider from the list and then click Next.

4 Select the consumer artifact type from the list and then click Next.

If there are no available consumer artifacts for the selected type SOA Systinet warns you.

5 Use Filter to find the consumer artifact.

Select the consumer from the list and then click Next.

6 If required, select Select Specific SLO, select an SLO from the list, and then click Next.

7 Optionally, modify the name and description of your consumption request and click Next.

8 Review the request details and click Finish to place your request.

You can view your consumption requests from the Services tab View menu with the My Consumption
Requests link.
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Processing Consumption Requests
When consumers request a provider artifact you must either approve or reject their request.

You can approve or reject a request if you have write permission for the provider artifact (the owner, a
member of the owning group, a user with ACL write permission, or the administrator).

To process consumption requests:

1 In the Services menu View section, click Requests to Approve to open the list view of requests that
require your attention.

2 Click the request name to open a view of that request.

3 To accept or reject a request, click Accept or Reject and confirm your decision.

If a request is accepted it becomes a contract between the consumer and provider artifacts.

A contract becomes invalid under the following conditions:

• The provider artifact is deleted.

• The consumer artifact is deleted.

• The associated SLO, if there is one, is deleted.

Importing Existing Contracts
There may be existing contracts between providers and consumers that are not stored in the repository.

SOA Systinet enables you to import these contracts without requiring the request approval process.

You can import a contract if you have write permission for the provider artifact (the owner, a member of
the owning group, a user with ACL write permission, or the administrator).

To import an existing contract:

1 In the Services menu Import section, click Existing Contract.
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The Enter Existing Contract page opens.

2 Select the provider artifact type from the list and then click Next.

3 Use Filter to find the provider artifact.

Select the provider artifact from the list and then click Next.

4 Select the consumer artifact type from the list and then click Next.

5 Use Filter to find the consumer artifact.

Select the consumer artifact from the list and then click Next.

6 If required, select Select Specific SLO, select one from the list, and then click Next.

7 Optionally, modify the name and description of your contract, and then click Next.

8 Review the details and click Finish to create the contract.

Revoking an Active Contract
You may need to cancel an active contract.

You can revoke a contract if you have write permission for the provider artifact (the owner, a member of
the owning group, a user with ACL write permission, or the administrator).

To revoke a contract:

1 In the Services menu View section, click My Contracts to display the list view of active contracts
you provide.

2 Click the contract name to open a view of that contract.

3 Click Revoke to cancel the contract, and then confirm.
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14 Managing Projects

SOA Systinet enables you to organize artifacts into projects and manage them as a whole.

• Creating Projects on page 181

• Adding Project Content on page 182

• Editing Project Content on page 183

• Removing Project Content on page 183

Creating Projects
SOA Systinet enables you to create a project to help manage your service development.

To create a project:

1 In the Tools tab Catalog Browser, click Projects to open the Projects browse page.

2 In the Projects browse page, click New to open the New Project page.

3 In the New Project page enter the following parameters:

DefinitionParameter

The name of the new project.Name

A description of the new project.Description

Click Add Category to select a category from the available taxonomies
(administrator perspective only)

Categories

Optionally, add search terms for the service.Keywords

The initial version number of the project.Version
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DefinitionParameter

The progress of the project.Completion [%]

Use the calendar icon to set a start date for the new projectStart Date

Use the calendar icon to set a projected completion date for the new project.Planned End Date

Use the calendar icon to set the completion date for the new project.End Date

4 Click Save to create the new project and open its detail page.

Adding Project Content
SOA Systinet enables you to add artifacts to a project.

To add artifacts to a project:

• In the Services view of a project, in the Project Content section, place the cursor over Add Artifact
Type and select from the following options:

• Select Add New Artifact Type to create a new artifact as part of the project.

The Create Artifact page for the selected artifact type opens.

For details, see Creating an Artifact on page 274 or the specific creation procedure for that artifact
type:

• Creating an Application on page 122

• Creating Business Services on page 95

• Adding Web Applications on page 108

• Adding XML Services on page 106

• Adding SOAP Services on page 102

• Adding Service Level Objectives on page 117
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• Select From Catalog to open the Browse Catalog section populated with all the artifacts of the
selected type.

Use Filter to locate the artifact and click add to add it to the project.

Editing Project Content
The Services view of a project gives quick access to the edit view of artifacts in the project.

To edit an artifact in a project:

• In the Services view of a project, in the Project Content section, click Edit for the artifact you want to
modify.

The Edit view of that artifact opens.

Removing Project Content
The Services view of a project enables you to remove artifacts from a project and also delete them if required.

To remove an artifact from a project:

1 In the Services view of a project, in the Project Content section, click Remove for the artifact you want
to remove.

2 Do one of the following:

• Click Remove to remove the artifact from the project.

• Click Delete to remove the artifact from the project and open the Delete Artifact page. For details,
see Deleting an Artifact on page 279.
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Part IV. Policies
Policy Manager enables you to implement your company policy in SOA Systinet and verify the compliance
of your service infrastructure. Access the main features of Policy Manager in the Policies tab.

Policy Manager is an additional component of SOA Systinet. If your license does not include
Policy Manager these features are not available.

The following chapters describe Policy Manager features:

• Chapter 15, Policies UI

Navigate the Policies UI.

• Chapter 16, Managing Business Policies

Create and manage business policies.

• Chapter 17, Managing Technical Policies

Create and manage technical policies.

• Chapter 18, Validating Artifacts

Validate documents using your policies.





15 Policies UI

The Policies tab is the central location which shows all information about policies and compliance reports
in one place to provide easy access and simple management.

Figure 42. Policies Tab

The Policies tab is split into the menu on the left and the main view pane, as described in these sections:
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• Policies Menu on page 188

• Areas of Interest on page 191

• Policy Pages on page 194

Policies Menu
The Policies tab menu is split into collapsible segments.

Each segment is described in the following sections:

• Policies View Menu on page 188

Access list views of policy artifacts.

• Policies New Menu on page 189

Create new policy artifacts.

• Validation Menu on page 190

Validate the policy compliance of an artifact.

• Areas of Interest Menu on page 190

Click an Area of Interest to return to or configure the main Polices tab.

• Recent Documents

Quick links to the last few artifacts viewed.

Policies View Menu

The View menu in the Policies tab provides links to list views for policy management.

188



Figure 43. Policies View Menu

The View menu contains the following links:

• Policy List Views

Links to list views for policy artifacts.

For details, see Policy and Report List Views on page 195.

Policies New Menu

The New menu in the Policies tab provides quick links to create new policy artifacts.

Figure 44. Policies View Menu

The New menu links to the following policy artifact creation pages:

• Business Policy

Create a new business policy.

For details. see Creating Business Policies on page 213.

• Technical Policy
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Create a a new technical policy.

For details, see Creating Technical Policies on page 221.

• Trend Report

Create a new trend report.

For details, see Compliance Trends on page 241.

Validation Menu

The Validation menu in the Dashboard and Policies tab links to policy compliance functionality.

Figure 45. Validation Menu

The Validation menu contains the following functionality:

• Validate Compliance

Start policy compliance validation for a resource.

For details, see Custom Validation on page 235.

Areas of Interest Menu

Each Area of Interest selected for display in the Polices tab is shown in the Area of Interest menu.
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Figure 46. Areas of Interest Menu

Click an Area of Interest to return to the main Policies tab and expand that Area of Interest if it is closed.

Click Configure to customize the main Policies tab content.

For details about Areas of Interest and configuration, see Areas of Interest on page 191.

Areas of Interest
When you open the Policies tab, the page displays Areas of Interest in the main view.

Areas of Interest show various aspects of policy management in the form of reports.
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Figure 47. Policies Tab Showing Areas of Interest

You can return to this view and display a specific Area of Interest at any time by clicking it in the Policies
tab Areas of Interest menu.

The information shown in an Area of Interest is generated from the available validation data. You may need
to execute these validations to generate the applicable data.

Areas of Interest do not update when you open them. To see an up-to-date Area of Interest, click Refresh
after you open it. You may need to refresh the Area of Interest more than once to show the results of a recent
action.
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HP Software recommend scheduling a task using the AOI Preparation Tool to perform a daily
update of all areas of interest. As this task is CPU intensive, it should be scheduled for a non-
peak period. See Creating a Task on page 316.

You can select the areas of interest to display. In the Areas of Interest menu, click Configure to view a list
of possible areas of interest as shown in Figure 48, “Configure Areas of Interest”. Select those you want
displayed and click Save.

Figure 48. Configure Areas of Interest

Areas of Interest include the following types:

• My Reports

A report, policy, service, etc. is 'yours' if you own it.

For details, see Changing Artifact Ownership on page 281.
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• Pending Review Reports

Some assertions cannot be resolved automatically and require you to decide whether a validated document
conforms to the requirements of an assertions (for example, quality requirements). These Areas of Interest
list all reports where the final status is pending until manual validation is performed.

For details, see Manual Validation on page 238.

• Policy Statistics Reports and Repository Reports

After you resolve policy violating problems, you can reset the statistics for Areas of Interest. All artifact
detail pages in Services, Policies, and Tools contain a Compliance context menu with the option to Reset
Compliance Statistics. This tool deletes all reports for that artifact, policy, or assertion.

You can also delete all compliance reports in the SOA Systinet repository with the command-line reset
tool.

For details, see "Reset Tool" in the HP SOA Systinet Administrator Guide.

Policy Pages
The Policies tab includes several view pages, described in the following sections:

• Policy and Report List Views on page 195

Index views of policies, reports and assertions.

• Business Policy View on page 196

The business policy detail page.

• Technical Policy View on page 199

The technical policy detail page.

• Assertion View on page 201

The assertion detail page.

• Report Views on page 203
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The various reports Policy Manager generates.

Policy and Report List Views

Click one of the links in the Polices tab View menu to open a list view of that type of document:

Figure 49. List of Business Policies

You can reduce the list of policy artifacts using Filter.

Click Filter to open a query window:

To filter the list, enter your search parameter, select a column, and then click Search.

Click Clear Filter to remove the filter and restore the list of artifacts, or open the Filter menu and select
Edit Filter to change the filter terms.

All policy list views contain a bulk delete function.

Select the policy artifacts from the list, click Delete, and then confirm.

The following functionality is specific to each policy artifact type:

• Compliance Reports

Validate Compliance enables you to execute a new compliance check.

For details, see Chapter 18, Validating Artifacts.

• Business and Technical Policies
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New Business Policy or New Technical Policy enable you to create new policy artifacts.

For details, see Creating Business Policies on page 213 and Creating Technical Policies on page 221.

Business Policy View

Click the name of a business policy to open the business policy detail view:

Figure 50. Business Policy Details

The business policy detail view lists the technical policies and association rules of the business policy.

This following sections describe the content and functionality of these pages:

• Business Policy Page Context Actions on page 197

• Business Policy Page Content on page 198
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Business Policy Page Context Actions

The grey bar contains the following context action menus and functions:

• Views:

• Revisions

View the revision history of the artifact.

For details, see Revision and Version History on page 270.

• Advanced View

Switches to the detailed view of the artifact in the Tools tab.

For details, see Tools View on page 262

• Tools:

• All Governed Documents

Lists all documents associated with the business policy. You can run a business policy validation from
this view.

For details, see Business Policy Validation on page 234.

• Reset Compliance Statistics

Deletes compliance reports for this policy, which resets the relevant Area of Interest statistics.

• Compliance Status

View the current compliance status of all artifacts associated with the business policy.

For details, see Business Policy Summary Reports on page 204.

• Validate Compliance

Validate the documents associated with the business policy against all its technical policies.
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For details, see Business Policy Validation on page 234.

If a specified Additional Artifact associated with the business policy is missing from the
repository, you are warned in the detail view. Validations performed on such a policy will
automatically fail.

• Edit

Open the Edit view of the business policy.

For details, see Editing Business Policies on page 218.

• Delete

Delete the business policy.

Policy deletion is permanent. Deleted polices cannot be recovered.

Business Policy Page Content

The Association Rules section includes the following information:

Table 3. Association Rules

The type of artifact to which the policy applies.Artifact Type

The business policy applies to only those artifacts with the selected values in the
selected categories.

In Categories

As In Categories, except the business policy does not apply to those artifacts with
the selected values in the selected category.

Not In Category

The business policy does not apply to these specific artifacts.Exclude

The business policy applies to these specific artifacts even if the category rules would
exclude them.

Additional
Artifacts
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The Technical Policies section lists all technical policies associated with an artifact. Click the name of a
technical policy to open its detail view.

For details, see Technical Policy View on page 199.

Technical Policy View

Click the name of a technical policy to open the technical policy detail view, shown in Figure 51, “Technical
Policy Details”. The detail view lists the policy's assertions and policy references.

Figure 51. Technical Policy Details

This following sections describe the content and functionality of these pages:

• Technical Policy Page Context Actions on page 200
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• Technical Policy Page Content on page 201

Technical Policy Page Context Actions

The grey bar contains the following context action menus and functions:

• Views

• Revisions

View the revision history of the artifact.

For details, see Revision and Version History on page 270.

• Advanced View

Switches to the detailed view of the artifact in the Tools tab.

For details, see Tools View on page 262

• Validate Compliance

Run a compliance check of the technical policy against artifacts. The artifact types to which the policy
may apply are listed in the General section as Applicable to.

For details, see Custom Validation on page 235.

• Edit

Opens a view in to edit the technical policy.

For details, see Editing Technical Policies on page 225.

• Delete

Delete the technical policy.

Policy deletion is permanent. Deleted polices cannot be recovered.
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Technical Policy Page Content

The content of the technical policy detail page is divided into the following sections:

• General

The Applicable to field shows the source types of documents to which the technical policy applies.

• Policy References

A table of other referenced technical policies.

• Assertions

A table of all assertions included in the technical policy, the severity of their violation, and their
descriptions. Click the name of an assertion to open its detail view.

Assertion View

Click the name of an assertion in the Assertions list to open that assertion's detail view, shown in Figure 52,
“Assertion Detail”.
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Figure 52. Assertion Detail

An assertion detail view shows what types of document the assertion applies to, when it was last modified,
and the categories to which it belongs. Assertion detail views include a toolbar with the following buttons
and context action menus:

• Edit. Click this to change the assertion's name or description. You cannot change any of the assertion's
technical details in SOA Systinet. HP provides the HP SOA Systinet Assertion Editor tool for this purpose.

• Delete. Click this to delete the assertion. Deleted assertions are unrecoverable.

• Views. The options in this menu are to see the Revision History or the Advanced View. The Advanced
View is the assertion's detail page in the Tools tab, as described in Tools View on page 262. The assertion
detail reopens in the last view you selected.
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• Tools. The only available tool is Reset Compliance Statistics. This deletes compliance reports for this
assertion, which resets the relevant Area of Interest statistics.

The Technical Details of an assertion include the reference template, validation handlers, and parameter
definitions. These details are explained in the Assertion Schema chapter of the Reference Guide.

Report Views

Compliance checks generate the following reports:

• Business Policy Summary Report

Running a business policy validation generates a business policy summary report. This report lists a
business policy's associated artifacts, says whether they complied with all of the associated technical
policies, and gives a breakdown of how many assertions the artifact complied with, how many it violated
and how many require manual review. It includes links to reports for each document.

For details, see Business Policy Validation on page 234 and Business Policy Summary Reports on page
204.

• Document Summary Report

Validating an artifact against its associated business policies generates a document summary report. This
lists an artifact's governing business policies, says whether the artifact complied with them, and gives a
breakdown of how many assertions the artifact complied with, how many it violated and how many
require manual review. It includes links to reports for each business policy.

For details, see Document Summary Reports on page 205

• Document Report

A document report describes the compliance of an artifact and its related artifacts with the assertions
contained in the policies used to validate the artifact.

For details, see Document Reports on page 207.

• Business Policy Report
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A business policy report describes the compliance of all artifacts associated with a business policy with
the policy's constituent assertions.

For details, see Business Policy Reports on page 211.

Business Policy Summary Reports

A business policy validation, where all associated documents are validated against the business policy (see
Business Policy Validation on page 234), produces a business policy summary report. Business policy
summary reports show how many of the business policy's associated documents complied with all of its
technical policies at the time of validation. Figure 53, “Business Policy Summary Example” shows the
summary report for a business policy with three associated documents.

Figure 53. Business Policy Summary Example
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Business policy summary reports feature the name of the business policy, the compliance status of its
documents, the time of validation and a pie chart with the percentage of tested documents that complied
with all the technical policies. The name of the policy is a link to its detail view. If the business policy was
altered after the compliance validation was run, the version used for the validation is next to the name.

Business policy summary reports include a toolbar with the following buttons and context menus:

• Views. The Standard View only lists business policies. The Detailed View lists all violated and pending
assertions for each business policy. The Responsibilities View shows the owner and the last modifier of
each validated document. When you select a view and then close and reopen a report, it reopens displaying
the last view you selected.

• Tools. Only the Revalidate tool is available. This tool validates the document against all associated
business policies.

• Export. You can export the report as a PDF or CSV file.

• Delete. Deletes the report.

A table of tested documents occupies the bottom of business policy reports. The name of each document
is a link to its detail page (see Tools View on page 262). You can see whether a document passed the latest
validation, how many assertions it violated (Failed), how many it complied with (Passed) and how many
still require manual validation (To review). Clicking report for a document opens its document report.

If the documents or policies changed since the validation generating the report was run, the report is no
longer up to date. Click Verify Status, between the toolbar and the pie chart, to make sure the report is
current.

Document Summary Reports

Validating a document against its associated business policies produces a document summary report.
Document summary reports show how many business policies the document complied with at the time of
validation. Figure 54, “Document Summary Example” shows the summary report for a document validated
against three business policies.
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Figure 54. Document Summary Example

Document summary reports feature the name of the document, its compliance status, the time of validation
and a pie chart with the percentage of business policies with which it complies. The name of the document
is a link to its detail view (see Tools View on page 262). If the document was altered after the compliance
validation was run, the version used for the validation is next to the name.

Document summary reports include a toolbar with the following buttons and context menus:

• Views. The Standard View only lists business policies. The Detailed View lists all violated and pending
assertions for each business policy. Business policy validation reports also have a Responsibilities View,
which shows the owner and the last modifier of each validated document. When you select a view and
then close and reopen a report, it reopens displaying the last view you selected.
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• Tools. Only the Revalidate tool is available. This tool validates the document against all associated
business policies.

• Export. You can export the report as a PDF or .csv file.

• Delete. Deletes the report.

Document summary reports include a table of business policies. (In the Detailed View, the violated and
pending assertions are also listed under each policy.) The name of each policy is a link to its detail page
(see Business Policy View on page 196). You can see whether the document complied with each policy, and
for each policy how many assertions it violated (Failed), how many it complied with (Passed) and how
many still require manual validation (To review). Clicking report for a business policy opens its detail
report.

If the documents or policies changed since the validation generating the report was run, the report is no
longer up to date. Click Verify Status to make sure the report is current.

Document Reports

A document report describes the compliance of a document with business and/or technical policies. Document
reports are generated in the following cases:

• During business policy validation. They are listed in the business policy summary report.

For details, see Business Policy Summary Reports on page 204.

• When a single resource is validated.

The report in Figure 55, “Document Report Example” was generated by a business policy validation using
the Production Business Services Policy. It is listed in the business policy summary report for that validation.
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Figure 55. Document Report Example

Document reports feature the name of the document, its compliance status, the time of validation and a pie
chart with the percentage of assertions with which it complies. (Compare to the document summary report,
Figure 54, “Document Summary Example”, which gives the percentage of business policies with which it
complies.) The name of the document is a link to its detail page (see Tools View on page 262). If the document
was altered after the compliance validation was run, the version used for the validation is next to the name.

Above the pie chart is a toolbar with the following buttons and context menus:
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• Views

The Standard View only lists failed and pending assertions. The Full View lists all assertions for each
business policy. When you select a view and then close and reopen a report, it reopens displaying the
last view you selected.

• Export

You can export the report as a PDF or .csv file.

• Delete

Deletes the report.

All violated and pending assertions are listed in a table beneath the pie chart. (In the Full View, passed
assertions are listed as well.) For each assertion, the table shows:

• The name of the assertion. Clicking this opens the compliance status view of the assertion. Figure 56,
“BP 2122 Compliance Status View” shows the compliance status of the BP 2122 assertion when validating
the GoogleSearch WSDL. It includes a copy of the WSDL document with the violation highlighted in
red.

• The severity of the assertion.

• The specific document that violated the assertion.

• The type of document that violated the assertion.

• The line in the document where the violation occurred. Due to length, this appears beneath the other
entries in the row.
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The policies used to validate the document are listed in the Validated Documents and Policies table. Each
name is a link to the policy, document or document detail page. The order in which these items is listed is,
from top to bottom:

• Business policy used for validation, if applicable.

• Technical policies. If validation used a business policy, these technical policies are associated with that
business policy.

• The document's name and type.

• Any other documents associated with the document and their types.

Figure 56. BP 2122 Compliance Status View
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Business Policy Reports

A business policy report describes the degree to which a business policy's associated documents violate its
constituent assertions. Business policy reports are generated when an document is validated against the
business policies which govern it. In all other respects business policy reports are identical to document
reports. See Document Reports on page 207 for details.
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16 Managing Business Policies

Business policies are sets of documents with the technical policies with which they must comply. The
procedures for managing business policies are covered in the following sections:

• Creating Business Policies on page 213

• Editing Business Policies on page 218

• Deleting Business Policies on page 219

Creating Business Policies
You can create business policies from the menu on the left side of the Dashboard and Policies tabs and
from the business policy list view.

To create a business policy:

1 Do one of the following:

• In the Policies or Dashboard New menu, click Business Policy.

• In the list view of business policies, click New.

The New Business Policy page opens:
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2 Input a name and description for the new business policy.

3 Do any of the following:

• Click Save to create a draft policy. You can add association rules and technical policies later by
editing the policy.

For details, see Editing Business Policies on page 218.

• Add Association Rules.

For details, see Adding Association Rules to a Business Policy.

• Add Technical Policies.

For details, see Adding Technical Policies to a Business Policy.
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Adding Association Rules to a Business Policy

1 In the New Business Policy or Edit Business Policy view, in the Association Rules section, click Select.

A list of document types appears.

2 Use Quick Find or the scroll bar to find the artifact type and then click the artifact type to select it.

By default, the business policy applies to all artifacts of this type.

3 After selecting an artifact type there are a number of options available in the Association Rules section:
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These options enable you to further filter the selection of artifacts that the policy applies to as follows:

UseOption

Click Change to reopen the list of artifact types. Select a new one if required.Artifact Type

Click Add Taxonomy to open a list of taxonomies that apply to the selected
artifact type.

In Categories

Select a taxonomy to open a list of category values.

Click add next to a category to apply the business policy to artifacts with that
category.

After you add category from a particular taxonomy use Add Category to add
further categories from that taxonomy.

The business policy only applies to artifacts with the selected category values.

The functionality is identical to In Categories.Not In Category

The business policy does not apply to artifacts with the selected values.

Click Add Artifact to open a list of all artifacts for the selected artifact types.Exclude
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Use Filter to locate the artifact and click add next to the artifacts you want to
exclude.

The business policy does not apply to these artifacts.

UseOption

The functionality is identical to Exclude.Additional
Artifacts

Use this feature to add artifacts that would otherwise be excluded by another rule.
For example to include a specific business policy regardless of it's Failure Impact
category as well as business policies in a Failure Impact category specified in In
Categories.

4 Click Save.

Adding Technical Policies to a Business Policy

1 In the New Business Policy or Edit Business Policy view, in the Technical Policies section, click Add
Technical Policy.

A list of technical policies appears.
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2 Use Filter to locate the technical policy and click add for the technical polices you want to associate
with the business policy.

3 Click Save.

Editing Business Policies
Business policies can be edited from their detail views, described in Business Policy View on page 196.

To edit an existing business policy:

1 In the business policies list view (see Business Policy View on page 196), find the business policy.
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2 Click the name of the policy to open its detail view.

3 Click Edit in the detail view. The Edit page for that business policy opens.

4 You can now change the name, association rules and technical policies of the business policy. The
procedure is identical to creating a business policy. See Creating Business Policies on page 213, starting
at Step 2.

The Revision History records all changes made to a business policy. The Revision History can be viewed
from a context action in the business policy's detail view. See Business Policy View on page 196.

Deleting Business Policies
You can delete a business policy either from the business policy list view or the policy's detail view (see
Policy and Report List Views on page 195 and Business Policy View on page 196).

• In the business policy list view, select the business policies you wish to delete and click Delete Selected.

• In the business policy's detail view, click Delete in the toolbar.

Deleted policies are unrecoverable! (Equivalent to --purge on the command line)
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17 Managing Technical Policies

The procedures for managing technical policies are covered in the following sections:

• Creating Technical Policies on page 221

• Editing Technical Policies on page 225

• Deleting Technical Policies on page 226

• SOA Systinet Technical Policies on page 226

Creating Technical Policies
You can create technical policies from the menu on the left side of the Policies tab and from the technical
policy list view.

To create a technical policy:

1 Do one of the following:

• In the Policies New menu, click Technical Policy.

• In the list view of technical policies, click New.

The New Technical Policy page opens:
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2 Input a name and description for the new technical policy.

3 Do any of the following:

• Click Save to create a draft policy. You can add policy references and assertions later by editing
the policy.

For details, see Editing Technical Policies on page 225.

• Add Policy References.

For details, see Adding Policy References to a Technical Policy.

• Add Assertions.
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For details, see Adding Assertions to a Technical Policy.

Adding Policy References to a Technical Policy

1 In the New Technical Policy or Edit Technical Policy view, in the Policy References section, click
Add Policy Reference.

A list of technical policies opens.

2 Use Filter to locate the technical policy and click add for the technical polices you want to add
references to.
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3 Click Save.

Adding Assertions to a Technical Policy

1 In the New Technical Policy or Edit Technical Policy view, in the Assertions section, click Add
Assertion.

A list of assertions opens.

2 Use Filter to locate the technical policy and click add for the assertions you want to add.

3 After adding assertions, select a Severity value for each assertion.
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4 If an assertion includes parameters, you can change or set their values.

Parameters inherit any default values set in the assertion template and any non-optional parameters
must be set.

For more details, see "Assertion Schema" in the HP SOA Systinet Reference Guide.

5 Click Save.

Editing Technical Policies
Edit a technical policy to add or delete assertions and policy references or set the value of assertion
parameters.

To edit a technical policy:

1 Find the technical policy in the list view of technical policies (see Policy and Report List Views on
page 195).

2 Click the name of the policy to open its detail view.

3 Click Edit in the detail view. The Edit page for that technical policy opens.

4 Add or delete policy references and assertions.

5 To view an assertion's detail view, click its name.
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6 Change the severity level of an assertion and/or the value of any parameters it has as when creating a
technical policy, described in Creating Technical Policies on page 221.

7 Click Save.

Deleting Technical Policies
You can delete a technical policy either from the technical policy list view or the policy's detail view (see
Policy and Report List Views on page 195 and Technical Policy View on page 199).

• In the technical policy list view, select the technical policies you wish to delete and click Delete Selected.

• In the technical policy's detail view, click Delete in the toolbar.

Deleted policies are unrecoverable! (Equivalent to --purge on the command line)

SOA Systinet Technical Policies
SOA Systinet includes a prepackaged set of technical polices.

These technical polices are described in the following tables organised by the type of validation they perform:

• Table 4, "Related Artifact Validity"

Policies that verify that relevant related artifacts are present for a business service, such as documentation.

• Table 5, "Business Service Property Validity"

Policies that verify properties of a business service.

• Table 6, "Governance Process Dependency Validity"

Policies for governance processes that verify the lifecycle stage of constituent artifacts governed by other
processes.

• Table 7, "WSDL and SOAP Message Validity"
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Policies that verify WSDL and SOAP conformance with standard schema.

• Table 8, "Business Service Status Validity"

Policies that verify the status of business services.

• Table 9, "Service Test Management Policies"

• Policies to verify the status of business services in conjunction with HP Service Test Management (STM)
integration. For more details about STM integration, see Service Test Manager Integration Features on
page 91.

Table 4. Related Artifact Validity

DefinitionTechnical Policy

Verifies that an artifact has a business requirements document.Has Business
Requirements

Verifies that an artifact has a project plan document.Has Project Plan

Verifies that a business service has a detailed design document.Has Detailed Design

Verifies that a business service has a functional specification document.Has Functional
Specification

Verifies that a business service has an installation instruction document.Has Installation
Instructions

Verifies that a business service has a technical specification document.Has Technical
Specification

Verifies that a business service has a user manual document.Has User Manual

Verifies that a business service has an implementation.Has Implementation

Verifies that a business service has a service level agreement.Has SLO

Verifies that a project artifact has an analysis document.Project Has Analysis
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Table 5. Business Service Property Validity

DefinitionTechnical Policy

Verifies that a business service is not consumable.Consumption Is Not
Allowed

Verifies that a business service is consumableIs Consumable

Verifies that a contact is assigned for a business service.Contact Person Is
Assigned

Verifies that a failure impact status is set for a business service.Failure Impact Is Set

Verifies that keywords describing the business service are set.Is Described By
Keywords

Table 6. Governance Process Dependency Validity

DefinitionTechnical Policy

Verifies that the constituent artifacts of an application are all approved at the
Deprecated stage.

All Application
Components Deprecated

Verifies that the constituent artifacts of an application are all approved at the
Development stage.

All Application
Components Developed

Verifies that the constituent artifacts of an application are all approved at the
Retired stage.

All Application
Components Retired

Verifies that the constituent artifacts of an application are all approved at the
Production stage.

All Application
Components in
Production

Verifies that all referenced process implementations are approved at the
Deprecated stage.

All Process
Implementations
Deprecated

Verifies that all referenced process implementations are approved at the Retired
stage.

All Process
Implementations Retired

Verifies that the constituent artifacts of a project are all approved at the
Development stage.

All Project Artifacts
Developed
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DefinitionTechnical Policy

Verifies that the constituent artifacts of a project are all approved at the
Production stage.

All Project Artifacts in
Production

Verifies that all referenced service implementations are approved at the
Deprecated stage.

All Service
Implementations
Deprecated

Verifies that all referenced service implementations are approved at the Retired
stage.

All Service
Implementations Retired

Verifies that all referenced sub-processes are approved at the Development
stage.

All Sub-Processes
Developed

Verifies that all referenced sub-processes are approved at the Production stage.All Sub-Processes in
Production

Verifies that all referenced sub-services are approved at the Development stage.All Sub-Processes
Developed

Verifies that all referenced sub-services are approved at the Production stage.All Sub-Processes in
Production

Verifies that at least one referenced process implementation is approved at the
Production stage.

Process Implementation
in Production

Verifies that at least one referenced process implementation is approved at the
Testing stage.

Process Implementation
in Testing

Verifies that at least one referenced service implementation is approved at the
Production stage.

Service Implementation
in Production

Verifies that at least one referenced service implementation is approved at the
Testing stage.

Service Implementation
in Testing

Table 7. WSDL and SOAP Message Validity

DefinitionTechnical Policy

Verifies that a WSDL is compliant with the WSDL 1.1 XML Schema, that all
references to external WSDL descriptions and schemas are valid, and that the
WSDL is compliant with WS-I Basic Profile 1.1.

WSDL Validity Policy

Verifies that a WSDL or SOAP message complies with WS-I Basic Profile 1.1.WS-I Basic Profile Policy
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DefinitionTechnical Policy

Checks that an XML Schema is valid and that all contained references are
resolvable.

XSD Validity Policy

Verifies that SOAP messages are compliant with SOAP 1.1 XML Schema and
WS-I Basic Profile 1.1.

SOAP Validity Policy

Table 8. Business Service Status Validity

DefinitionTechnical Policy

Verifies that a business service has contact information, is documented, has an
implementation, is described with keywords, and that its associated WSDL

Business Service In
Production Stage

documents and XML schema comply with WS-I Basic Profile 1.1 and the
"Systinet Best Practices" policy (see below).

Verifies that a business service has an implementation and that associated WSDL
documents and XML schemas comply with WS-I Basic Profile 1.1 and the
"Systinet Best Practices" policy (see below).

Business Service In
Testing Stage

Verifies the basic requirements of production business service; that it has contact
information, is documented, has an implementation, and is described with

Business Service
Minimum Production
Requirements keywords. The associated WSDL documents and XML schemas must comply

with WSDL and XML schema specifications and all references to types can be
resolved.

Verifies that WSDL documents XML schemas have correct extensions, that
names contain valid characters, that schema use XML schema 2001, namespace
prefix "xs", that types and elements are annotated, etc.

Systinet Best Practices

Table 9. Service Test Management Policies

DefinitionTechnical Policy

Verifies that a business service is registered in STM.Service Registered in
STM

Verifies that a business service is registered in STM and that there are no critical
defects outstanding for the service.

Service Has No Pending
Critical Defects

Verifies that a business service is registered in STM and that there are test
requirements and tests defined for the service in STM.

Service Has Test
Requirements and Tests
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DefinitionTechnical Policy

Verifies that a business service is registered in STM and that the test requirements
report meets the criteria defined in STM.

Test Requirements
Covered
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18 Validating Artifacts

Validation is the process of checking artifacts against policies to verify their compliance.

You can perform validation is a number of different ways as described in the following sections:

• Artifact Validation on page 234

Validate a single artifact against all the business policies associated with it.

• Business Policy Validation on page 234

Validate all artifacts associated with a particular business policy.

• Custom Validation on page 235

Validate a single artifact against selected technical policies, for test purposes.

• Manual Validation on page 238

Some assertions require a manual review of the artifact to determine its compliance.

• Compliance Status on page 239

Validate a single artifact against all the business polices directly associated with it and against any policies
governing the current lifecycle stage for the artifact. This validation also generates a compliance status
percentage for the artifact.

• Compliance Trends on page 241

Collate and track compliance status over time to detect compliance trends.

• Validation Tasks on page 245

Creating automatic validation tasks.
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• Deleting Policy Reports on page 245

Deleting reports.

Artifact Validation
An individual artifact may be associated with a number of business policies. You can perform a validation
of the artifact against these policies.

To validate a artifact against all associated business policies:

1 Do one of the following:

• From the Services tab, open the service view for the artifact.

• From the Tools tab, open the detail view for the artifact.

2 Open the Compliance context action menu and select Validate Compliance.

3 Validation runs automatically, generating a document summary report as described in Document
Summary Reports on page 205.

You can schedule artifact validation to run automatically as an SOA Systinet task. For details, see Validation
Tasks on page 245.

Business Policy Validation
A business policy may be associated with a number of artifacts. You can perform a validation of these
artifacts against the business policy.

To validate all artifacts against a business policy:

1 Open the policy view of the business policy to validate.

2 Click Validate Compliance.

Validation runs automatically, generating a business policy summary report as described in Business Policy
Summary Reports on page 204.
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You can schedule policy validation to run automatically as an SOA Systinet task. For details, see Validation
Tasks on page 245.

You can run a business policy validation from a remote client with the client server-validate tool. For details,
see "Validating Against Policy On Server" in the HP SOA Systinet Developer Guide.

Custom Validation
Select a single resource to check for compliance against one or more technical policies. This can be useful
for testing purposes during resource or policy development.

To check the compliance of a single resource:

1 Do one of the following:

• From the Policies or Dashboard menu, select Validate Compliance.

• From the policy view of a technical policy, click Validate Compliance.

The Validate Compliance page opens.
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2 Do one of the following:

• To validate a repository artifact:

1 Click Select Artifact in the Repository Artifact tab.

A list of document types appears.
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2 You can narrow the list by typing part of the artifact type name in the Quick Find field.

3 Select an artifact type by clicking on it. A list appears of artifacts of this type. You can narrow
down this list by clicking Find, which opens a filter dialog box, and typing a partial name.

4 Click select for the artifact you want to validate. Only one artifact can be selected.

• To validate an external resource:

1 Click the External Document tab to open it.

2 Type or paste the document URL.

3 If the document is secure, select This resource requires authentication, and type the username
and password.

3 To select the technical policies to be used for the validation, click Add Technical Policy.
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A list of technical policies appears.

4 You can narrow down this list by clicking Find, which opens a filter dialog box, and typing a partial
name or selecting a category. If you launched the validation from a technical policy detail page in Step
1, that technical policy is already selected.

5 Click add for the technical policies you want to use.

6 Click Run to execute the validation.

Validation generates a document report as described in Document Reports on page 207.

Manual Validation
Some assertions cannot be enforced automatically. They require a manual review of the artifact or resource
being validated. When a validation is executed that involves such an assertion, Policy Manager informs
you in these ways:

• The Latest Pending Reviews and Pending Reviews Older than Week areas of interest list the assertions
requiring manual document review. For details, see Areas of Interest on page 191.

• The artifact reports or business policy reports that include the assertion list under Assertions to Review.

For details, see Document Reports on page 207 and Business Policy Reports on page 211.

To manually review a document:

1 In either the report or the Pending Reviews area of interest, click the assertion name. The assertion
compliance status page opens.

To open the detail page of an artifact under review, click its name under Documents. You can also
read the assertion or technical policy detail pages by clicking their names under Assertion Details.

2 To perform the review, click Review. The assertion's review page opens.

To open the detail page of a artifactunder review (see Tools View on page 262 and Service View on
page 75), click its name under Review Instructions
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Depending on the conditions of the assertion, you may want to see an advanced view of
the detail page. From the Advanced View you can open the XML View. All views are
accessible from the Views context action menu.

3 After reviewing the artifacts, select Pass or Fail in the assertion review page. If you select Fail, type
in an explanation of why the artifact fails validation in the Explanation field.

4 Click Save. The document or business policy report page opens.

Compliance Status
In addition to business policies directly associated with an artifact, there may be additional technical policies
associated with a governance process lifecycle stage. When the artifact is at a particular lifecycle stage,
these technical policies also apply to it.

The summation of these policy validations gives a compliance status for an artifact, expressed in terms of
a percentage of policies that the artifact complies with.

SOA Systinet executes a Policy Compliance Task which performs a validation of all artifacts with applicable
policies.

This task sets a new compliance status based on the results with an accompanying compliance status report.
The compliance status is displayed in the artifact view sidebar and in all list views or tables of artifacts.

When an artifact changes, the compliance status becomes obsolete, indicated by parentheses. You can
manually execute a compliance status validation.

To execute a manual compliance status validation:

• Do one of the following:

• In the Services or Tools detail view of an artifact, open the Sidebar to view the Compliance Status.

For details, see Sidebar on page 83.

In the Compliance Status section, click Recalculate.
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• In the Policies tab My Compliance Status area of interest, click the artifact name to open the
Compliance Status page, open the Tools menu, and select Recalculate.

The artifact is revalidated and a new compliance status calculated. The Compliance Status page opens to
display the new results.

The compliance status report contains a graph showing the overall compliance and the following sections:

• Governing Business Polices

Displays the compliance status of the artifact for each business policy directly associated with the artifact
with assertion status details.

• Governing Lifecycle Policies

Displays the compliance status of the artifact for each technical policy associated with the current lifecycle
stage for the artifact with assertion status details.

Click Report for a policy to view the validation report for the artifact against that policy.
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You can collate and track compliance over time in order to evaluate compliance trends. For details, see
Compliance Trends on page 241.

Compliance Trends
Based on the compliance of artifacts generated on a daily basis, you can create a compliance trend report.
For more details about compliance status, see Compliance Status on page 239.

To create a compliance trend report:

1 In the New menu of the Polices tab, click Trend Report to open the New Trend Report page, as shown
in Figure 57, “New Trend Report”.

Figure 57. New Trend Report

2 In the Artifact Type field, the default artifact is Business Service. To change the artifact type, click
Change to open the Change Artifact Type view and select the new artifact type.

3 To restrict the trend report to specific lifecycle stages, in the Stage field, click Select to open the Select
Lifecycle Stages section.
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Select the lifecycle stages you require and click OK.

4 To restrict the trend report to artifacts governed by a particular governance process, in the Governance
Process field, click Select to open the Select Governance Process section.

In the Governance Process field, click Select to open the Select Governance Process view, and then
do one of the following:

Click Select next to the process you require.

5 To restrict the trend report to artifacts categorized by specific taxonomic categories, in the In Categories
field, click Add Taxonomy to open the Select Taxonomy section.

Click the taxonomy you require to view the available categories.

Click Add next to each category you require.

6 In the Policies field, select which policies to evaluate the compliance status trend for.

7 In the Period field, do one of the following:

• Specify a number of days, weeks, months, or years.

• Specify from and until dates.

8 Click Run.

The result is displayed in the Trend Report view.
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Figure 58. Trend Report Summary

To save or edit the trend report parameters, click Save or Edit to re-open the Trend Report parameters view.

Enter the required parameters and click Save.

When you save a trend report, it executes automatically every night and is available as an
Area of Interest on the main Policies page. For details, see Areas of Interest on page 191.
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The trend report summary consists of two graphs. The top graph displays the overall compliance of artifacts
for each day over the specified time period and the bottom graph displays the number of artifacts used to
calculate the compliance figure for a particular day.

The compliance figure is a percentage of fully compliant artifacts. If an artifact fails any policy
validation, it is non-compliant.

For longer time periods, the report does not display every day during the period. For example,
for a report over three months, each entry in the graph is two or three days later than the
previous one.

Both graphs enable you to drill down to the detail for a particular day.

Click a bar in the top graph or a plotted point in the bottom graph to open the Trend Report Detail page for
the selected date.

Figure 59. Trend Report Summary
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This report displays a compliance chart for the day and a table of validated artifacts with their compliance.

Validation Tasks
You can create a task to perform a particular validation for manual execution or for scheduled at a particular
time or on a periodic basis.

To create a validation task:

1 Follow the procedure for creating a task described in Creating a Task on page 316, using the following
steps as inputs.

2 Select the Validate Compliance tool.

3 Do one of the following:

• To create an artifact validation task, select the set of artifacts to validate.

The task validates each artifact against any policies associated with it.

• To create a policy validation task, select a set of policies to validate.

The task validates all artifacts associated with the selected policies.

Deleting Policy Reports
On the Compliance Reports view page, you can select and delete individual reports. Every summary report
and document report also has a Delete button for deleting that report.

Each Business Policy detail page and Assertion detail page has a Reset Compliance Statistics link in the
Tools drop down menu. This tool deletes all reports for that policy or assertion. Similarly, every artifact in
the Tools tab except technical policies has a Reset Compliance Statistics link in its Tools dropdown menu.
Click this link to delete all reports for that artifact.
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Part V. Tools
• This part explains the features and use of the Tools tab, which is the place to organise and manage your

SOA content. It includes the following sections:

• Chapter 19, Tools UI

Describes the user interface elements of the Tools tab.

• Chapter 20, Managing Content

Explains the procedures for managing the content of SOA Systinet.

• Chapter 21, Governance Tools

Describes the use of SOA Systinet governance tools, tasks and reports.

• Chapter 22, Advanced Searches

Describes the advanced search facilities of SOA Systinet.





19 Tools UI

The Tools tab gives access to Information Management offering a generic view of the content of SOA
Systinet and access to administration and governance tools:

Figure 60. The Tools Tab

The Tools tab is split into the menu on the left, the Catalog Browser and a number of portlets in the main
section of the page.

Each feature is explained in detail in the following sections:

• Tools Menu on page 250
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A description of the items in the Tools Menu.

• Catalog Browser on page 254

The index portlet of artifact types in the repository.

• Tasks and Reports Portlet on page 255

A portlet to access tasks and the reports on the results of those tasks.

• Report Launcher Portlet on page 256

An access portlet for customized reporting tools.

The portlets in the Tools tab can be moved in the same way as described in Chapter 6,
Dashboard UI.

Tools Menu
The Services menu is split into collapsible segments.

Each segment is described in the following sections:

• Tools View Menu on page 251

A set of links to artifact browse pages showing an index of the artifacts in the repository.

• Tools New Menu on page 252

A set of links to create new artifacts:

• Administration Menu on page 253

A set of administration links.

• Registry Content Menu on page 253

Import content from a UDDI registry.
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• Recent Documents

Quick links to the last few artifacts viewed.

Tools View Menu

The View menu in the Tools tab provides links to artifact browse pages.

Figure 61. Tools View Menu

The View menu contains the following links:

• Categories

Browse the repository by taxonomic category.

For details, see Category Browsing on page 27.

• Artifact Names and List Views

Click to view an index of that artifact type or a list view in the Service tab.

For details, see Browse Artifact Pages on page 258 and List Views on page 73.

• WSIL Document

Access a Web Service Inspection Language (WSIL) format query view of the current Tools page.
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This format can be passed to other products, for example MS Visual Studio, for the purpose of service
discovery.

The query for the Tools tab itself generates a view of the published WSDLs in the repository.

Tools New Menu

The New menu in the Tools provides quick links to create new artifacts.

Figure 62. Tools New Menu

The New menu links to the following artifact creation pages:

• Upload Data Content

Import a service infrastructure from a service definition document.

For details. see Publishing Services on page 127.

• Artifact Type Names

Create a new service artifact of the relevant type.

For details, see Creating an Artifact on page 274.

• Task
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Create a new task to execute a governance tool.

For details, see Creating a Task on page 316.

Administration Menu

The Administration menu enables you to browse integrated registries.

Figure 63. Registry Content Menu

The Administration menu contains the following link:

• Registries

View a list of registries integrated with SOA Systinet.

• Governance Process View the list of governance processes for lifecycle management.

The administrator has additional options available in this menu. For details, see "Administering
SOA Systinet" in the HP SOA Systinet Administrator Guide.

Registry Content Menu

The Registry Content menu enables you to import content from a UDDI Registry.

Figure 64. Registry Content Menu

The Registry Content menu contains the following link:

253



• Import Registry Content

Import a content from a UDDI Registry into the SOA Systinet repository.

For details, see Importing Services from Registries on page 134.

Tools Tab Portlets

Catalog Browser

The Catalog Browser is the entry point to the repository. From here all artifacts in the repository can be
viewed:

Figure 65. Catalog Browser Portlet

The browser is split into the following sections matching the structure of the SDM described in the "SOA
Definition Model" section in the HP SOA Systinet Reference Guide:

• SOA
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Artifact types for business services,processes, implementations, and policies.

• Content

Artifact types associated with services such as documentation and metadata.

• System

Artifact types related to integration and governance tools and tasks.

To expand branches in the browser, click [+].

Click an artifact type to open its browse page.

For details, see Tools View on page 262.

Tasks and Reports Portlet

The Tasks and Reports portlet on the Tools and Dashboard (administrator perspective only) tabs is the
quickest access point to your SOA governance tasks and the results of their execution.

Figure 66. Tasks and Reports Portlet

The portlet includes the following sections:
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• View Reports enables you to view reports according to the following categories:

• All displays all the reports in the repository, as described in Reports on page 321.

• Successful opens a browse view of all successful reports.

• Failed opens a browse view of all failed reports.

• Today's opens a browse view of all reports created today, today's successful reports, or today's failed
reports.

• View Tasks enables you to view tasks according to the following categories:

• All opens a browse view of all tasks in the repository.

• Currently Running opens a browse view of tasks currently being executed.

• Completed Today opens a browse view of all tasks completed today.

• Scheduled Today opens a browse view of all tasks scheduled today.

• New Task. Click to create a new governance task, as described in Creating a Task on page 316.

Closing the portlet in the Dashboard adds a link to the Add section of the dashboard menu enabling you
to restore the portlet to the Dashboard at any time.

Report Launcher Portlet

The Tools tab contains a portlet specifically for reports generated by reporting tools. It contains default
tools created by HP Software and user created tools with valid report definitions on the reporting server.
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Figure 67. Report Launcher Portlet

Click the report name to open the last report of its execution in html format.

Click pdf to view the report in that format.

generate executes the tool and switches to a view of the newly generated report.

configure opens the detail view of the associated reporting tool. Click Edit to make changes.

The default reporting tools are:

• Provider Consumption

Generates an overview of artifact consumption in the repository organized by the owner of the provided
artifact..

• Provider Portfolio
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Generates an overview of the artifacts in the repository that are potentially consumable.

• Providers

Generates an overview of the artifacts in the repository that are available for consumption.

• Service Lifecycle Statistics

Generates a summary of governed artifacts for each stage in the service lifecycle.

• Top 10

Generates a summary of the top consumers and publishers of services and the services with the most
users.

Click New Reporting Tool to create a new reporting tool.

For details, see Creating a Reporting Tool on page 309.

Tools Pages
In the Tools tab there are a number of different pages describing the artifacts in the repository. This chapter
describes:

• Browse Artifact Pages on page 258

Are the index views of artifacts.

• Tools View on page 262

Are the detailed view of artifacts in the repository.

• Revision and Version History on page 270

Displays previous revisions of artifacts.

Browse Artifact Pages

From the Catalog Browser of the Tools tab, click an artifact type to open the browse artifact page:
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Figure 68. Browse WSDLs Page

These pages list all the artifacts of the selected artifact type.

Click Filter to filter the list by column headings or artifact categories.

To filter the list, click one of the listed taxonomic categories, or enter your search parameter, select a column,
and then click Find.
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Click Clear Filter to remove the filter and restore the list of artifacts, or open the Filter menu and select
Edit Filter to change the filter terms.

The Views menu offers a set of alternative views of the artifact type:

• Approved

Select Approved to only show the latest revisions of the artifacts approved in lifecycle management.

For details, see Chapter 12, Lifecycle Governance.

• Latest

Select Latest to show the latest revisions of the artifact type collection.

• Deleted

Select Deleted to show deleted revisions of the artifact type collection.

• XML View

Opens an XML view of the page in the REST interface.

• RSS View

Opens an RSS view of the page that can be used to create an RSS content feed for the Dashboard.

• Access Rights

Open a view of the access permissions for the artifact type collection.

Click an artifact to open its detail view. For details, see Tools View on page 262.

The available functions vary depending on the artifact type and they include:

• New

Open the Create New Artifact page allowing the creation of a new artifact.

For details, see Creating an Artifact on page 274.
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• Upload

Create artifacts based on the content of an external resource and import the document the repository.

For details, see Publishing Services on page 127.

• New Link

Create an artifact representing an external resource with only a link to the external resource. The resource
is not imported to the repository.

For details, see Adding Documentation on page 288.

• Search

Create an advanced search for the artifact type.

For details, see Chapter 22, Advanced Searches.

Browse views also enable you to carry out bulk operations on selected artifacts using the Actions menu.

The available bulk operations vary depending on the artifact type.

To perform a bulk operation:

• Select the service artifacts you require, and open the Select Actions menu.

The menu offers the following bulk operations:

• Edit Access Rights

The owner of an artifact or administrator can edit the permissions of selected artifacts.

For details, see "Access Rights" in the HP SOA Systinet Administrator Guide.

• Edit Category Bag

Change the categorization for the selected artifacts.
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For details, see Categorizing Artifacts on page 284.

• Change Owner

Change the person or group responsible for the artifact.

For details, see To manually change artifact ownership:.

• Synchronize

Perform change management on the selected artifacts.

For details, see Running the Synchronization Tool on page 311.

• Change Version

Create new versions of the selected artifacts.

For details, see Managing Versions on page 291.

• Delete

Mark the selected artifacts as deleted.

For details, see Deleting an Artifact on page 279.

• Export to Registry

Export the selected artifacts to an integrated UDDI Registry.

For details, see Exporting Data To Registries on page 297.

Tools View

Clicking an artifact name in the Tools tab opens a detailed artifact view for that artifact:
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Figure 69. Phone Service Details

This detail view contains all the information about that artifact with options to edit, delete and add
relationships.

This following sections describe the content and functionality of these pages:

• Tools View Context Actions on page 264
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• Tools View Page Content on page 268

The Sidebar is also available in the Tools detail view. For details, see Sidebar on page 83.

Tools View Context Actions

The grey bar contains a set of context action menus and functions.

The actions vary depending on the artifact but they include:

• Views:

• Consumer View

Switches to the Services view of the last approved revision of the artifact for artifacts subject to lifecycle
management.

For more details, see Chapter 12, Lifecycle Governance.

• Services View

Switches to the service view of the artifact in the Services tab.

For details, see Service View on page 75.

• Revisions

View the revision history of the artifact.

For details, see Revision and Version History on page 270.

• XML View

Opens an XML view of the page in the REST interface.

• RSS View

Opens an RSS view of the page that can be used to create an RSS content feed for the dashboard.

• Atom View
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Opens an Atom view of the page.

• Access Rights

Opens a view of the access permissions for the artifact.

For details, see "Edit Access Rights" in the HP SOA Systinet Administrator Guide.

• Tools:

• Associated Reports

A list of the reports related to this artifact.

For details, see Reports on page 321.

• Dependency Analysis and Impact Analysis

Execute the impact management tool on the artifact.

For details, see Impact Tools on page 304.

• Impact Analysis (Navigator)

Open the Graphical Navigator showing a visual representation of the impact of the artifact. For details,
see Navigator Impact View on page 40.

• Add Documentation

Add an associated document.

For details, see Attaching Documentation to Artifacts on page 289.

• Change Owner

The administrator or owner of the artifact to can transfer ownership to a different user.

For details, see Changing Artifact Ownership on page 281.

• Notify
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Send a notification email to selected stakeholders for the artifact.

For details, see Notifications on page 285.

• Download Content

Create an archive containing all the service infrastructure referenced by a single definition document,
for example a WSDL. Any artifacts

This functionality is effectively the reverse operation compared to Upload Content. For details of the
relevant definition document types, see Publishing Services on page 127.

• Compliance:

• Validate Compliance

Validate the policy compliance of an artifact.

For details, see Chapter 18, Validating Artifacts.

• Compliance Status

View the compliance status of the artifact.

For details, see Report Views on page 203.

• Effective Policies

View the business policies associated with the service artifact.

• Reset Compliance Statistics

Delete all compliance reports associated with the artifact.

• Version:

• Versions

View the version history for the artifact.
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For details, see Revision and Version History on page 270.

• Version Navigation

Open specific next, previous, or last versions of the artifact.

• Governance

• Start Governance

Enter the artifact into a lifecycle process.

For details, see Starting Artifact Governance on page 164.

• Request Approval

Request approval for the current lifecycle stage.

For details, see Submitting an Approval Request on page 166.

• View Stage Details

View the page showing the details for the current lifecycle stage.

• History

View the governance history of the artifact.

• Consumption:

• Pending Requests

View the list of outstanding consumption requests for the artifact.

• Accepted Requests

View the list of accepted consumption requests for the artifact.

• Rejected Requests

View the list of rejected requests for the artifact.
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• Navigator

Opens a graphical representation of the artifact and its relationships.

For details, see Chapter 5, Graphical Navigator.

• Edit

Change the attributes of the artifact.

• New Version

Create a new version of the artifact.

For details, see Managing Versions on page 291.

• Delete

Mark the artifact as deleted with a further option to purge it from the repository.

Tools View Page Content

Other information on the page varies, depending on the artifact type. Information categories include:

• General

displays the taxonomic categories of the artifact, the version with a link to the revision history, the owner
of the artifact and its last modified date.

• Governance

Service artifacts subject to lifecycle management display the last approved stage and the current stage
with options to view the stage details, view changes since the last approved version, and to start promotion
to the next lifecycle stage.

For details, see Chapter 12, Lifecycle Governance.

• Details

Lifecycle, failure impact, version, and contract information for artifacts.
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• Data

Artifacts associated with external documents display the location of the associated resource. Click the
resource name to view it, click View Server Folder to view that repository location, or click
Update/Upload to change the associated resource.

For artifacts subject to change management the synchronization status is also shown with options to
update the cached version.

For details, see Running the Synchronization Tool on page 311.

• Related Repository Artifacts

The relationships that the artifact has with other repository content. Add Relationship allows you to
associate the artifact with another in the repository.

For details, see Adding a Relationship on page 280.

• Service Quality

If you integrate SOA Systinet with HP Service Test Manager (STM), SOAP Services display a section
for service quality statistics from STM.

This section enables you to register a service with STM and then displays information about requirements,
tests, and defects from STM.

For details, see Service Test Manager Integration Features on page 91.

• Performance and Availability

The content of this section depends on which product you integrate SOA Systinet with.

• If you integrate SOA Systinet with HP Business Availability Center (BAC), this section displays
statistics generated by BAC and enables you to open the BAC view of the service artifact.

For integration details, see "Setting Up BAC/UCMDB Integration" in the HP SOA Systinet Administrator
Guide.

For feature details, see BAC/UCMDB Integration Features on page 86.
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• If you integrate SOA Systinet with HP SOA Policy Enforcer (SPE), this section enables you to open
the SPE view of the service artifact if it is shared with SPE.

For integration details, see "Setting Up SOA Policy Enforcer Integration" in the HP SOA Systinet
Administrator Guide.

For feature details, see SOA Policy Enforcer Integration Features on page 89.

• Service Discovery

If you import a service artifact from an external source, such as HP Business Availability Center (BAC),
this section displays the source of the original service and its change management status. There are options
to display the discovery details, or import changes.

For details, see Synchronizing Discovered Services on page 143.

• Registry Synchronization

If you integrate SOA Systinet with UDDI Registries, this section displays each registry and the status of
the service artifact compared to that registry. There are synchronization options depending on the relative
status of the artifact with each registry.

For details, see Registry Integration on page 295.

Revision and Version History

During the lifecycle of resources and artifacts stored in the database, their properties or content may change.
SOA Systinet supports revisions and versions.

Any update of a resource automatically increments its revision number. A resource may be updated by the
Synchronization Tool or by a user changing any property such as the name, description, etc.

The version number is manually controlled.

For details, see Managing Versions on page 291.

To open the revision history of an artifact:

• Do one of the following:
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In the Tools view of an artifact, in the General section click history, next to the revision number.•

• In the Services view or the Tools view of an artifact, open the View context menu and click Revision
History.

To open the version history of an artifact:

• Do one of the following:

• In the Tools view of an artifact, in the Details section click history, next to the version number.

• In the Services view or the Tools view of an artifact, open the Version context menu and click
Versions.

Figure 70. Account SOAP Service Revision History

To compare versions or revisions, select two from the list and click Compare.

To view the content of a past revision or version, click the revision or version number.

In the view of an older revision or version, click Latest Revision to view the latest revision of the artifact
or open the Views menu to navigate through revisions.
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In the version history, open the Views menu and select Approved Versions to only show the list of versions
approved in Lifecycle Management.

In the view of an older version, open the Versions menu to navigate through versions.

In the view of an older revision, the Views menu contains the context action Copy as New Revision. This
enables you to create a new revision of the resource with the content of the old revision you are viewing.
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20 Managing Content

There are four main types of content in SOA Systinet

• Artifacts

All entities in the repository are artifacts and there are generic procedures for most artifacts described in
Managing Artifacts on page 273.

• Documentation

Many artifacts require additional documents describing their purpose or use. Managing Documentation
on page 287 describes the procedures for adding and using documentation.

• Metadata

Information about the structure and format of the data in your repository can also be published as described
in Managing Definition Data on page 290.

• Taxonomies

Using categorization groups allows you to further organize the content of your repository. The SOA
Systinet UI can be used to manage taxonomies in the same way as other artifacts but we recommend
using HP SOA Systinet Taxonomy Editor.

Managing Artifacts
The main artifact management procedures are:

• Creating an Artifact on page 274

• Editing an Artifact on page 275

• Deleting an Artifact on page 279
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• Adding a Relationship on page 280

• Changing Artifact Ownership on page 281

• Categorizing Artifacts on page 284

• Notifications on page 285

Creating an Artifact

The process of creating an artifact is very similar for most artifact types.

To create an artifact:

1 From the browse page of any artifact type, click New to start the artifact creation process.

By default, the New button in browse screens is disabled for artifacts with associated
data content. These artifact types have an Upload button which uses the publisher
functionality.

For details, see Publishing Services on page 127.

The administrator can enable the creation of these artifact types without uploading the
associated data content.

For details, see "Configuration Options" in the HP SOA Systinet Administrator Guide.

2 The exact details for each artifact type differ.

Input the artifact details, and then click Save.

To start governance of the artifact, see Starting Artifact Governance on page 164.
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Editing an Artifact

You can edit artifacts.

Editing is not available for governed artifacts awaiting promotion or rollback approval. For
details, see Governing Artifacts on page 163.

To edit an artifact:

1 In the detail view of an artifact, click Edit to open the edit view of the artifact.

2 Change any parameters and use the functionality in the Related Repository Artifacts section to
manage relationships.

3 Click Save to commit your changes and create a new revision of the artifact. See Revision and Version
History on page 270 for details.

Bulk Operations

Many artifact management tasks may be performed in bulk as well as individually.

Wherever there is a list of artifacts (for example in list views, browse pages, and tables of search results)
there are a set of options enabling bulk operations as shown in Figure 71, “Bulk Operations”.

Figure 71. Bulk Operations
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The overall process for bulk operations is the same for each different action:

To perform a bulk operation:

1 In the table of artifacts, select the artifacts to perform the bulk operation on.

2 Click the Select Action drop-down arrow and select from the following actions:

• Edit Access Rights

The owner of an artifact or administrator can edit the permissions of selected artifacts.

For details, see "Access Rights" in the HP SOA Systinet Administrator Guide.

• Edit Category Bag

Change the categorization for the selected artifacts.

For details, see Categorizing Artifacts on page 284.

• Change Owner

Change the person or group responsible for the artifact.

For details, see Changing Artifact Ownership on page 281.

• Synchronize

Perform change management on the selected artifacts.

For details, see Running the Synchronization Tool on page 311.

• Change Version

Create new versions of the selected artifacts.

For details, see Managing Versions on page 291.

• Delete
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Mark the selected artifacts as deleted.

For details, see Deleting an Artifact on page 279.

• Export to Registry

Export the selected artifacts to an integrated UDDI Registry.

For details, see Exporting Data To Registries on page 297.

3 The exact details for executing each action vary but they execute in the same way.

Bulk operations may involve large numbers of artifacts. SOA Systinet executes these operations as
asynchronous tasks.

When the operation starts, the original page opens with an information bar showing the progress of
the task.

4 Bulk operations execute asynchronously so you can continue with other work while the task finishes.
Each bulk operation offers the option to receive a notification e-mail when the task completes.

You can monitor tasks in progress in the Dashboard My Task Results portlet. For details, see My Task
Results Portlet on page 54.

Alternatively, select Click here for a detailed report to view the task in progress or the finished
report.
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5 The Bulk Operation Report displays the current status of the task, with an option to Stop the task if
required.
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Stopping a task may take some time as all unprocessed artifacts are added to the final
report. Stopping a task is also asynchronous so you can continue with other work. If you
requested a notification it is sent on completion of the report.

The Report Data section displays the results for each artifact subject to the bulk operation.

Deleting an Artifact

You can delete artifacts individually or in bulk.

Deletion is not available for governed artifacts awaiting promotion or rollback approval. For
details, see Governing Artifacts on page 163.

To delete artifacts:

1 Do one of the following:

• In Services or Tools browse pages select the artifacts to delete, open the Actions menu and select
Delete.

• In Services or Tools artifact views, click Delete.

The Delete Artifacts page opens.

2 Select Delete Subartifacts if you want to delete related sub-artifacts from the same lifecycle process
as well.

3 Select Ignore Incoming References to delete the artifact even if there are incoming relationships from
other artifacts in the repository. For example a SOAP service referenced from a Business Service.

4 Select Non-Recoverable Deletion to purge the artifacts from the repository instead of just marking
them as deleted.

5 Select Notify on Completion to receive an e-mail when the task completes.

6 Click Delete to delete the selected artifacts.

279



Adding a Relationship

At the heart of SOA Systinet is the ability to link artifacts together with relationships.

To add a relationship to an artifact:

1 Click Add Relationship in any detail view to open the Add Relationship page:

There are numerous types of relationships, the choices available depend on the particular artifact type.

2 Select the relationship type and click Next.

3 The format of this choice will depend on the artifact and relationship type.

Do one of the following:

• Use Filter function to search for the required artifact.

• Click New, Upload, or New Link to create a new artifact to be the object of the relationship.

For details, see Creating an Artifact on page 274.
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• Click Upload to create a new artifact with associated external content to be the object of the
relationship.

For details, see Publishing Services on page 127.

• Click New Link to create a new documentation artifact with a link to external content to be th object
of the relationship.

Select the artifacts to associate and then click Next to continue.

4 Review the details and click Finish to create both the relationship and the inverse relationship.

Changing Artifact Ownership

You can change the ownership of artifacts to other users or groups, changing ownership is available manually
for a single artifact and as a bulk operation for a set of artifacts. You can also set up an automatic action to
change artifact ownership as a result of a lifecycle change.

To manually change artifact ownership:

1 Do one of the following:

• To change the owner of a single artifact:

From the View page of the artifact, select Tools→Change Owner.

The Change Owner action is only available for the administrator or owner of the
artifact.

The Change Owner – Select Documents page opens showing the artifact and any related child
artifacts.

• To change the owner of multiple artifacts:

From the browse page of an artifact type, select the artifacts to change, and select Select
Action→Change Owner.

The Change Owner – Select New Owner page opens.
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Skip to Step 3.

2 In the Select Documents page, if the artifact is governed by a lifecycle process, select whether to
Restrict to Governed Artifacts.

Select the artifacts to change ownership, and click Next.

The Change Owner – Select New Owner page opens.

3 In the Select New Owner page, select the Group or User tab, and enter a search term in the Search
For input, and then click Go.

Use asterisk (*) as a wildcard.

Matching users or groups are listed.

4 Click Select next to a user or group to select it as the new owner, and then click Next.

The Change Owner – Summary page opens.

5 In the Summary page, do any of the following:

• For multiple artifacts governed by a lifecycle process, select Include Subartifacts to include related
sub-artifacts in the change of ownership.

For bulk change ownership, if you are not the administrator, only artifacts that you
own change to the new owner.

• Select Send Notification E-mails to notify users of the ownership change.

SOA Systinet notifies original owner and the new owner of the artifact.

6 Click Finish.
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To define an automatic change owner action:

1 To set up an automatic lifecycle change owner action, in the Stage Definition page of a governance
process, expand Add Action and select Change Owner.

The Change Owner page opens.

For details about setting a Stage Definition, see Defining Lifecycle Stages on page 152.

2 Select Include Sub-Artifacts to apply the ownership change to associated sub-artifacts as well.

3 Select Send Notification E-mails to automatically send mails to the old and new owners.

4 In the New Owner section, click Select.

The Select User or Group pane opens.

5 In the Select User or Group pane, do any of the following:

• To select a user:

1 Select the Users tab.

2 In the Search for field, enter the user name to locate (use an asterisk (*) as a wildcard), and then
select whether you want to search by Full Name or Login Name from the drop down menu.

3 Click Go to show matching search results.

4 Click Select next to the user name.

The selected user is used as the new owner.

• To select a group:

1 Select the Groups tab.

2 In the Search for field, enter the group name to locate (use an asterisk (*) as a wildcard).

3 Click Go to show matching search results.
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4 Click Select next to the group.

The selected group is used as the new owner.

6 Click OK to return to the Stage Definition page.

The new Change Owner action is added to the Actions list.

Categorizing Artifacts

SOA Systinet enables you to apply taxonomic categories to artifacts.

To categorize an artifact:

1 In the Tools view of an artifact, click Edit to open the edit view of the artifact.

The categories are organized by taxonomy in the General section.

2 In the Edit view, do any of the following:

• To add a category from a new taxonomy. click Add Category to open a list of taxonomies. Select
a taxonomy, and click Add to select a category from that taxonomy.

• To add a category from an existing taxonomy, click Add under the taxonomy box, and click Add
to select the category.

• To remove a category, click the red X next to the category.

• To remove all categories in a taxonomy, click Remove All under the taxonomy box.

3 Click Save to commit your changes and create a new revision of the artifact.

To categorize a set of artifacts:

1 In a Services list view or Tools browse view for a set of artifacts, select the artifacts to edit.

2 Open the Select Actions menu, and select Edit Category Bag.
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The Edit Category Bags page opens.

3 In the Edit Category Bags page, do any of the following:

• Select Include Subartifacts to apply the changes to related sub-artifacts in the same lifecycle
process.

• Select Update to amend the current categories, or Replace all Categories to remove all existing
categories.

• Select Notify on Completion to receive an e-mail notification when the task completes.

• To add or remove categories, use Add Category open a list of taxonomies. Select the taxonomy
and then click Add to add a specific catagory.

4 Click Save to make your changes.

Notifications

SOA Systinet enables you to send e-mail notifications to artifact stakeholders. You can send manual
notifications or set up automatic notifications to be sent as a result of lifecycle changes.

The possible recipients of the notification are described in Table 10, "Notification Recipients". For manual
notifications, the recipient groups can be refined into selectable roles and then to individual users.

Table 10. Notification Recipients

DescriptionRecipient

The user or group that owns the artifact. For details, see
Changing Artifact Ownership on page 281.

Owner

For policy compliance reports this option is called
Artifact Owner and refers to the owner of the
artifact that the report is about.

Users and groups with write permission for the artifact.Maintainers
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DescriptionRecipient

Users and groups associated with the artifact by the contact
relationship or listed in the artifact stakeholder property. For

Contacts

details, see Adding Contacts on page 97. The selection of
contacts can be refined by selecting By Role, and selecting from
the available roles.

Users and groups who maintain consuming artifacts. For details,
see Chapter 13, Managing Contracts. The selection of contractors

Contractors

can be refined by selecting By Contract, and selecting from
the available contracts.

Users and groups who maintain the providing artifacts. For
details, see Chapter 13, Managing Contracts. The selection of

Providers

providers can be refined by selecting By Contract, and selecting
from the available contracts.

Click Select and use the user and group search feature to add
any other required recipients.

Other Recipients

Expand Show Advanced Options and select Include Recipients
from Previous Major Versions to notify stakeholders from

Previous Stakeholders

previous versions of the artifact about changes to a newer
version.

The stakeholders notified by this option match
those for the current artifact version. For example,
if Contractors is selected, then the contractors
for previous versions are notified.

To send or set up notifications:

1 Do one of the following:

• To send a manual notification, in the artifact or report view, select Tools→Notify or click an email
address of a contact.
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The Notify page opens.

• To set up an automatic notification, in the Stage Definition page of a governance process, expand
Add Action and select Notify.

The Notification Message page opens.

For details about setting a Stage Definition, see Defining Lifecycle Stages on page 152.

2 For automatic notifications, select the event to trigger the notification from the Send When: drop-
down list.

For details, see Table 2, "Automatic Action Triggers".

3 Select the recipient groups to notify.

For details, see Table 10, "Notification Recipients".

For manual notifications, the groups resolve to sub-groups which you can notify instead of the whole
group.

4 Enter a message subject for the mail.

5 For automatic notifications, select Lifecycle Status and Compliance Status to include sections
containing this information in the mail.

For policy compliance reports, select Compliance Status to include the compliance graph in the
notification.

6 Enter the message text for the mail.

7 Click Preview to view a draft of the mail message.

8 Click Send to send the notification or OK to save the notification action.

Managing Documentation
The main document management procedures are:
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• Add a new document to the repository, as described in Adding Documentation on page 288.

• Attach documentation to an artifact, as described in Attaching Documentation to Artifacts on page 289.

• Edit the source document, as described in Editing Documentation on page 290.

Adding Documentation

You may want to store documents in the SOA Systinet repository or create documentation artifacts linked
to external documents.

To create a new documentation artifact:

1 In the Tools tab Catalog Browser click Documentation to open the Documentation page.

2 Do one of the following:

• Click Upload to use the SOA Systinet publisher functionality to create a documentation artifact
with associated data content.

For details, see Publishing Services on page 127.

• Click New Link to create a link to a document on a remote location.

For details, see To create a documentation artifact with a link to external content:.

• Click New to create a documentation artifact without cached content or a link to an external document.

For details, see Creating an Artifact on page 274.

This option is only available if enabled by the administrator.

For details, see "Configuration Options" in the HP SOA Systinet Administrator Guide.
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To create a documentation artifact with a link to external content:

1 In the Tools tab Catalog Browser click Documentation to open the Documentation page.

2 Click New Link to open the New Link page.

3 In the New Link page, input the following parameters:

DefinitionParameter

The location of the document to link the new artifact to.URL

Select a document type from the drop-down list.Type

The name of the new documentation artifact.Link Text

A description for the new artifact.Description

Attaching Documentation to Artifacts

Once a documentation item is stored in the repository it can be attached to other repository resources with
a documentation relationship.

To attach a document to an artifact:

1 In the detail view of the artifact click Add Relationship.

2 Select Documentation and click Next.

Not all artifacts types have Documentation as an available relationship type.

3 Do one of the following:

• Use Filter to search for the required document in the repository.

• Click New, Upload, or New Link to add a new document as described in Adding Documentation
on page 288.
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4 Select the document from the list and click Next.

5 Review the relationship and click Finish to create it.

If you later want to detach documentation from the artifact, edit the artifact and remove the relationship as
described in Editing an Artifact on page 275.

This procedure can be used to add documentation to a business service but an alternative is
provided in the Services tab as described in Adding Service Documentation on page 97.

Editing Documentation

Both the properties and the source of a documentation artifact can be edited.

To edit a documentation artifact:

1 In the detail view of the documentation artifact, click Edit.

2 Change any artifact attributes as required.

3 Click Save to confirm your changes.

To change the external source document:

1 In the detail view Data section of the documentation, click Update.

2 Input or use Browse to select a new source document.

3 Select a new Server Folder if you want to change the repository storage location.

4 Click Save to upload the new document.

Managing Definition Data
SOA Systinet includes extended support for SOA specific resources, such as WSDL documents and XML
schemas. This support includes features such as automatic import resolution during publishing and updates,
and change management support based on synchronization policies.
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Supported definition formats are:

• WSDL documents

• XML schema documents

• DTD documents

• XSLT stylesheets

• SCA Definitions

• BPEL Process Definitions

To publish a resource artifact:

1 In the Tools tab Catalog Browser click the relevant artifact type to open the browse page.

2 Click Upload to use the SOA Systinet publisher functionality to create a definition artifact with
associated data content.

For details, see Publishing Services on page 127.

Definition documents are updated and edited in the same way as documentation.

For details, see Editing Documentation on page 290. In the procedure replace documentation with the relevant
definition artifact types.

Managing Versions
SOA Systinet enables you to create new versions of artifacts individually or in bulk. Two types of version
can be created, depending on the significance of the change to the artifact:

• New Branch

A version created as a result of a major change to an artifact, which requires the commencement of a
new artifact lifecycle.
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When a new major version of an artifact is created, SOA Systinet; creates a new copy of the original
artifact, with it's own independent lifecycle. This makes it possible to have multiple versions of the same
artifact in different lifecycle stages in the same repository.

For example, version 1.0 of an implementation artifact can describe a service approved for production
use, while version 2.0 of the same implementation artifact can be in development.

New Branches may only be initiated from an individual artifact view. Bulk versioning only
allows a Version Number Update.

• Version Number Update

A version created as a result of a minor change in the data or metadata of the artifact, which does not
require the creation of a new artifact. Only the value of the version property changes and a new revision
created.

To create a new branch version of an artifact:

1 In the Services or Tools view of an artifact click New Version.

The New Version page opens.

2 Select New Branch.

3 Select Notify on Completion to receive an e-mail notification when the task completes.

4 Expand Show Advanced Options and optionally select from the following options:

• Select Backwards Compatible if you want to mark the new version as compatible with the current
version.

• By default, if the current version of the artifact is subject to governance, the new version of the
artifact is entered into the same governance process as the current version but at the starting stage
of the process.

To enter the new version into a different governance process, select Change Lifecycle Process and
select the governance process to use.
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• If the artifact is governed by a lifecycle process, select Include Subartifacts to open a list of related
child artifacts related to the current version.

For each subartifact toggle the check-box to select the following options in the Action column:

• Skip

A new version of the subartifact is not created and no relationship is created with the new version
of the parent artifact.

• New Version

A new version of the subartifact is created and associated with the new version of the parent
artifact.

• Reuse

The existing subartifact is associated with the new version of the parent artifact.

To create a new version for all subartifacts, click Select All.

To remove a selection for all subartifacts, click Deselect All.

5 Click Save.

When creating a New Branch, for each new version of an artifact, a new artifact is created with the specified
version number and required properties copied from the current version. Child relationships are determined
by the options chosen for subartifacts.

For service implementations the new version of the implementation copies any relationship
with parent business services.

To update the version number of an artifact:

1 In the Services or Tools view of an artifact click New Version.

The New Version page opens.
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2 Select Version Number Update.

3 Enter the new version number.

4 If the artifact is governed by a lifecycle process and you want the version number update to be applied
to subartifacts, expand, Show Advanced Options, and select Include Subartifacts to open a list of
related sub artifacts. Otherwise, proceed to Step 6.

5 Select the subartifacts you want to apply the new version number to.

To select all subartifacts in the tree, click Select All.

Selecting a subartifact changes the status in the Action column to New Version.
Subartifacts which have not been selected retain the status Skip.

6 Click Save.

For Version Number Updates, the version number of the selected artifacts is modified and all relationships
maintained.

To create new versions for a set of artifacts:

1 In a list view or table of artifacts, select the artifacts to version.

2 Expand Select Actions and select Change Version.

The Change Version page opens.

3 Select Include Subartifacts to apply the changes to related sub-artifacts in the same governance
process.

There is no option to select which subartifacts to apply the version number update to for
bulk versioning.

4 Input the new version number.
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5 Select Notify on Completion if you want to receive an e-mail when the versioning task is complete.

6 Click Change Version to apply your changes.

Bulk versioning executes as an asynchronous task allowing you to continue with other work. The task can
be monitored or stopped. For details, see Bulk Operations on page 275.

The version history of an artifact is available in the Service and Tools view of an artifact. Open the Version
menu and select Version.

For details, see Revision and Version History on page 270.

Registry Integration
SOA Systinet provides customizable mapping between UDDI entities and SDM artifacts. Mapping of the
basic structures (types) is predefined, but several aspects can be significantly changed by mapping additional
artifact properties to UDDI keyed references and vice versa.

Before any data transfer takes place between SOA Systinet and a UDDI registry, a registry
artifact must be created, registry certificates must be imported to SOA Systinet, and the
taxonomies must be synchronized.

For details, see "Setting Up Registry Integration" in the HP SOA Systinet Administrator Guide.

SOA Systinet artifacts correspond to registry entities as follows:

Registry EntitySOA Systinet Artifact

Business entityOrganization unit

tModelBusiness service

Business serviceImplementation

Binding templateEndpoint

tModelCustom (WS-Policy)

This section describes:
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• Registry Synchronization on page 296

• Exporting Data To Registries on page 297

• Deleting Data From a Registry on page 300

Importing Services from Registries on page 134 explains how to import registry data as part of "Service
Discovery".

Registry Synchronization

Each artifact that corresponds to a UDDI entity contains a Registry Synchronization section in its detail
view:

Figure 72. Registry Synchronization Details

Its synchronization status is shown and synchronization actions (export/import/delete) are offered for each
known UDDI Registry.

Table 11. Synchronization Status

DescriptionSynchronization Status

SOA Systinet artifact does not correspond to any UDDI entity. It is not exported
to UDDI or imported from UDDI. This synchronization status corresponds to
the NEW resource status.

Not Synchronized

SOA Systinet artifact and corresponding UDDI entity are semantically the
same, both are the same since the last synchronization. This synchronization
status corresponds to the IDENTICAL resource status.

Synchronized

SOA Systinet artifact has changed (while the corresponding UDDI entity has
not) since the last synchronization. This synchronization status corresponds to
the LOCAL CHANGE resource status.

Local change
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DescriptionSynchronization Status

The corresponding UDDI entity has changed since the last synchronization.
This synchronization status corresponds to the REMOTE CHANGE resource
status.

Remote change

Both the SOA Systinet artifact and the corresponding UDDI entity have changed
since the last synchronization. This synchronization status corresponds to the
NEEDS MERGE resource status.

Local+Remote change

The UDDI registry is unreachable to check the synchronization status. This
synchronization status corresponds to the UNREACHABLE resource status.

Unreachable

Exporting Data To Registries

You can export artifacts to an integrated registry individually or in bulk.

To export an individual artifact to a UDDI registry:

1 In the Registry Synchronization section of the detail view of the artifact, click export for the registry
that you want to export the artifact to.

Only organizational unit, business service, implementation and WS-policy artifacts can
be exported directly.

2 Provide the login name and password of the UDDI registry account where the data will be exported,
and then click Next.

For a successful export, the credentials used for registry sign-on must have the appropriate
write permissions for the registry entities being created or amended.

3 Select the associated artifacts to export on the summary page. If you are exporting a business service,
all its implementations can be exported as well and if you are exporting an organizational unit, all its
business services can also be exported.
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If the registry server artifact has specified environment categories, then only uncategorized
endpoints or endpoints with matching environments are listed. Uncategorized endpoints
are not selected for export by default. On export, if only one environment category is set
for the registry server artifact, uncategorized endpoints are assigned the same environment
category as the registry server artifact.

4 Click Finish to export the selected artifacts.

When the export process begins, an export report is created. The export process may take some time, so
click Refresh. You may have do this several times until the report is complete (and Refresh disappears).

The most important part of the report is the Report Data section within the sub-report:

It shows exactly what was exported, and the export status of all the exported items.

DefinitionParameter

DescriptionStatestate

The item was successfully imported.IMPORTED

The item was successfully exported.EXPORTED

The item (Business Service or Binding Template) was deleted
from the UDDI registry during export because the
corresponding artifact had been deleted in SOA Systinet.

DELETED

An error occurred during the export/import of the item.FAILED
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DefinitionParameter

the UDDI entity type: Business Entity, Business Service, SOAP Service, etc.artifact type

the SOA Systinet artifact nameartifact name

the unique id of the corresponding UDDI entityuddi registry key

the synchronization status before the import/export was performedstatus

To export a set of artifacts to a UDDI registry:

1 In any list view or table of artifacts, select the artifacts to export, and then select Select Action→Export
to Registry.

The Export Artifact to Registry page opens.

Artifacts associated with the selected artifacts are included in the export with the exception
of endpoints. Only endpoints with the same environment category as the registry server
artifact are exported.

2 Select the registry to export to and input the credentials to use.

3 Select Notify on Completion if you want to be informed by e-mail when the export is complete., and
then click Next.

4 For bulk export, optionally select a business entity to associate the exported artifacts with, and then
click Finish.

The original page re-opens showing a task bar at the top of the page. The export task executes asynchronously
so you can either wait for the task to complete or continue with other work and return to view the report
later.

Select Click here for detailed report to open the Registry Export - Bulk Operation report.

The Report Data section contains details of the exported artifacts and the export success or failure.
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For exported binding templates, the WSDL repository URL is used by default with the following
exceptions:

• If the registry artifact is categorized for an environment then an environment specific WSDL
URL is used. For details, see the Download WSDL functionality in Adding Endpoints on
page 112.

• If the registry artifact is not categorized for an environment then the WSDL URL from the
repository REST location space is used.

To disable the use of repository URLs for WSDLs and enforce the use of the originURL
(where the WSDL was imported from) set the following property in
SOA_HOME/conf/setup/configuration-properties.xml:

platform.integration.uddi.useRepositoryUrlOnWsdlExport=false

Consider this option if the repository is not your primary artifact store.

Deleting Data From a Registry

Entities in a synchronized registry can be deleted from the registry directly from SOA Systinet.

To delete an entity from a UDDI registry:

1 In the Registry Synchronization section of the detail view of an artifact, click delete for the registry
that you want to delete the artifact from.

The delete functionality is also available from the detail view of artifacts already deleted
from the repository, and in the dialog for deleting an artifact from the repository.

2 Provide the login name and password of the UDDI registry to delete the data from, and then click
Next.
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For a successful delete, the credentials used for registry sign-on must have the appropriate
write permissions for the registry entities being deleted.

3 Review the entities to be deleted. If you are deleting a business service, all its implementations are
also deleted, and if you are deleting an organizational unit, all its business services are also deleted.
Click Finish to delete displayed list of artifacts.
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21 Governance Tools

SOA utilities in the Tools tab consist of three elements:

• Tools on page 303

Are the basic utilities for performing governance actions.

• Tasks and Scheduling on page 316

Enable the use of a tool on an artifact or set of artifacts with the option of periodic or scheduled execution.

• Reports on page 321

Are the result of a task or tool execution.

Tools
SOA Systinet provides the following types of utility in the Tools tab:

• Impact Tools on page 304

Report the potential impact of a change to an artifact on the other artifacts it depends on or impacts.

• Job Tools on page 306

Are customized tools created to perform miscellaneous tasks.

• Reporting Tools on page 308

Use customized reports to query the repository.

• Sync Tools on page 310

Update the repository with the latest versions of externally sourced documents.
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• Policy Compliance Tools on page 316

Verify whether artifacts conform to business policy.

Impact Tools

Impact tools enable you to report on all the related artifacts that may be impacted by a change to a specific
artifact. Using impact tools, you can check the dependency trees or impact trees of an artifact.

In SOA Systinet, a dependency between artifacts is represented by a relationship. Each relationship represents
a dependency between two related artifacts: a source artifact and a target artifact. A relationship is a
unidirectional concept. Each relationship contains references to the source artifact, target artifact, type of
relationship and several other attributes. For example, consider relationship R which has references to source
artifact A and target artifact B. This would mean that artifact A depends on artifact B and that artifact B
has impact on artifact A. Accordingly, there are two types of relationship tree: the impact tree and the
dependency tree. The impact tree of an artifact shows the artifacts that it has impact on. The dependency
tree shows the artifacts on which this artifact depends.

You can create new impact tools or use the Impact Management tool provided with SOA Systinet.

This section describes:

• Running the Impact Management Tool on page 304

• Impact Reports on page 305

• Creating an Impact Tool on page 306

Running the Impact Management Tool

The context action for the Impact Management Tool is available in the detail view and service view of
artifacts (see Tools View on page 262 or Service View on page 75).

To assess the impact of a change to an artifact:

• In the detail view or service view of the artifact, move the cursor over the Tools context menu and select
Impact Analysis or Dependency Analysis depending on which tool you want to execute.
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Impact Reports

Impact reports are generated by running the impact tool as described in Running the Impact Management
Tool on page 304 or the result of automated tasks as described in Tasks and Scheduling on page 316.

To access impact reports, browse the reports as described in Reports on page 321 and filter for report category
Impact Management.

The most important part of the impact report is the Report Data section:

Figure 73. Impact Report Data

Figure 73, “Impact Report Data” shows that Account Service is dependant on the Account SOAP Service
which also has dependencies on an operation and a WSDL.

Phone Service is also a consumer of Account Service, so the dependencies of the Phone Service are displayed
as well.

The links to artifacts in the report always lead to the revision of the artifact at the time the
report was executed.

If you execute the report from the consumer view of an artifact, the artifacts shown in the
report are last approved revisions. Clicking these artifact links opens the consumer view of
these revisions.
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Creating an Impact Tool

Impact tools enable you to assess the potential impact of a change to an artifact.

To create a new impact tool artifact:

1 In the Catalog Browser, click [+] next to Tools to expand it and show the list of tool types.

2 Click Impact Tools to open the Browse Impact Tools page.

3 Click New to open the Publish Impact Tool dialog.

4 Input the following parameters:

DefinitionParameter

The name for the new impact toolName

A description of the impact toolDescription

Select one of the available impact typesChoose impact type

5 Click Save to create the new impact tool.

This new impact tool is now available for selection when creating a task, as described in Creating a Task
on page 316.

Job Tools

Job tools enable you to use customized Java class implementations to perform a variety of actions.

You can create new job tools or use the Report Cleaner Job Tool provided with SOA Systinet.

This section describes:

• Creating a Job Tool on page 307

• Report Cleaner Job Tool on page 307
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Creating a Job Tool

SOA Systinet enables you to create miscellaneous tools in association with your own Java classes.

To create a new job tool artifact:

1 In the Catalog Browser, click [+] next to Tools to expand it and show the list of tool types.

2 Click Job Tools to open the Browse Job Tools page.

3 Click New to open the Publish Job Tool dialog.

4 Input the following parameters:

DefinitionParameter

The name for the new job toolName

A description of the job toolDescription

Click add category to select a category from the available taxonomies
(administrator perspective only)

Categories

The class ID in the server configurationJob Implementation
Class ID

5 Click Save to create the job tool.

This new job tool is now available for selection when creating a task, as described in Creating a Task on
page 316.

Report Cleaner Job Tool

SOA Systinet is installed with the report cleaner tool. This tool is a utility for purging the repository of
deleted and orphaned reports. HP Software recommend that a task be created to run this tool on a periodic
basis to ensure that the repository does not fill up with obsolete reports. See Tasks and Scheduling on page
316 for details.
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Reporting Tools

Reporting tools enable you to access customized reports stored on the reporting server for the purpose of
periodic or timed execution using tasks.

SOA Systinet comes provided with preinstalled reporting tools which are available in the Report Launcher
portlet (see Report Launcher Portlet on page 256).

This section describes:

• Running a Reporting Tool on page 308

• Reporting Tool Reports on page 308

• Creating a Reporting Tool on page 309

Running a Reporting Tool

The context action for reporting tools is available in the Report Launcher portlet for the default reporting
tools provided with SOA Systinet and any user created tools with valid URIs.

To execute a reporting tool:

1 In the Report Launcher portlet click Generate for the required reporting tool.

2 The view switches to the resulting report as described in Reporting Tool Reports on page 308.

Reporting Tool Reports

Reporting tool reports are generated by running one of the default reporting tools as described in Running
a Reporting Tool on page 308 or the result of automated tasks as described in Tasks and Scheduling on page
316.

To access reporting tool reports, browse the reports as described in Reports on page 321 and filter for report
category Reporting.

The most important part of the impact report is the Report Data section:
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Figure 74. Reporting Tool Report Data

This section provides progress and success details of the report and links to rendered versions of the report
on the reporting server.

Creating a Reporting Tool

Reporting tools enable you to utilize custom reports deployed to the reporting server.

The SOA Systinet Report Editor can be used to create and modify report definitions. After
these definitions are deployed to the reporting service, they are then available to be associated
with a reporting tool. See the SOA Systinet Report Editor documentation for more information.

To create a reporting tool artifact:

1 In the Catalog Browser, click [+] next to Tools to expand it and show the list of tool types.

2 Click Reporting Tools to open the Browse Reporting Tools page.

3 Click New to open the Publish Reporting Tool dialog

4 Input the following parameters:

DefinitionParameter

The name for the new reporting toolName

A description of the reporting toolDescription

309



DefinitionParameter

Click add category to select a category from the available taxonomies
(administrator perspective only)

Categories

Select from the list of available report definitions from the reporting serviceReport Definition

Depending on the report definition additional parameters may be inputAdditional Parameters

5 Click Save to create the new reporting tool.

This new reporting tool is now available for selection when creating a task, as described in Creating a Task
on page 316, or for immediate execution as described in Running a Reporting Tool on page 308.

Sync Tools

SOA Systinet stores all resources in its repository. They can be divided into two types: representational
artifacts and local copies of imported resources. Sync tools focus on these imported resources. Such resources
have a cached flag set and the origin URL associated with them. Sync tools are a powerful feature that make
it possible to keep track of original resources, notifying the user about changes to them and maintaining
up-to-date copies.

You can create new sync tools or use the Change Management tool provided with SOA Systinet.

This section describes:

• Synchronization Policy on page 310

• Running the Synchronization Tool on page 311

• Change Management Reports on page 313

• Creating a Sync Tool on page 315

Synchronization Policy

Externally sourced resources may have an associated synchronization policy. Automatic change management
uses this policy to determine the action that should be performed during synchronization.

The following options are available:
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• Automatic

The cached resource is updated automatically if the original resource is changed.

In order for automatic synchronization to function you must create a scheduled change
management task. See Tasks and Scheduling on page 316 for details.

• Manual

The resource is marked with an out-of-sync flag and only updated after user approval. If you want to
approve the change and update the document, run the change management tool as described in Running
the Synchronization Tool on page 311.

• Disabled

The cached resources will not be updated, except by a manual update of a single resource from a context
action.

Resources stored in a database may (and usually do) consist of imports of other resources.
For example a WSDL file may contain imports of other WSDLs and XSDs. XSDs may contain
imports of other XSDs or DTDs, etc. The result is a dependency tree with the WSDL that the
user wants to publish or update at its root. The synchronization policy is usually associated
with the root resource, but it is also applied to the other dependent resources in the tree.

Running the Synchronization Tool

All artifacts that can be checked or updated have an associated Data section in their Tools detail page. These
include WSDLs, XSDs, DTDs and Documentation.
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Figure 75. Data Section

The following actions can be performed on artifacts associated with external documents:

• Available at functionality is available for resources uploaded from local or remote locations.

• Resource name

Click the resource name to open the version stored in the repository.

• View Server Folder

Opens the repository location where SOA Systinet stores the resource.

• Update

Updates a cached resource if the original has changed from the local file to the existing repository
server folder.

Update opens the Update data page, requesting the new file, with an Advanced Option to Remove
Unsynchronized artifacts if they are no longer referenced by the new version of the data content.

• Upload

If the artifact does not have associated data content, Upload enables you to add content from a local
file.

Upload opens the Upload data page, requesting the new file and Server Folder to store the data content.

Remove Unsynchronized can apply if you upload a file to a Server Folder where a file with the same
name already exists.
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• In addition, resources uploaded from remote locations have the following functionality:

• Source name

Click the source name to open it in the remote location.

• Synchronize

The synchronization status is shown. Click Synchronize to start the publishing process.

Select Remove Unsychronized artifacts to remove relationships to artifacts no longer referenced by
the new version of the file, and then click OK to upload the latest version of the remote resource.

From Service list views and Tools browse pages you can synchronize artifacts in bulk.

Select the artifacts to synchronize, open the Actions menu, and select Synchronize.

The Synchronize page opens, review the artifacts to synchronize, select Notify on Completion to receive
an e-mail notification when the task completes, and then click Synchronize.

When performing change management on a collection, only resources with an associated
synchronization policy are checked or updated. If change management is performed on a
single resource, the synchronization policy is not taken into account. Only resources for which
you have write permission are checked or updated.

Change Management Reports

Change management reports are generated by running the change management tool as described in Running
the Synchronization Tool on page 311 or the result of automated tasks as described in Tasks and Scheduling
on page 316.

To access change management reports, browse the reports as described in Reports on page 321 and filter for
report category Change Management or from the Change Management section of browse view or detail
view pages as described in Running the Synchronization Tool on page 311.

Select one of these by clicking the name to view the index report for that change management execution.

313



To view the result for a particular artifact, in the Sub reports section click the Change Management Report
link for the artifact you are interested in.

The most important part of the change management report for an artifact is the Report Data section:

Figure 76. Change Management Report Data

This section displays the name of the artifact, its location in the repository and the location of the external
document it represents and the status of the update or status check.

The possible statuses are:

DefinitionStatus

The resource is newNEW

The cached resource was identical to the originalIDENTICAL

The cached resource was identical to the original and the current user does
not have permission to change it

IDENTICAL (NO-
PERMISSION)
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DefinitionStatus

The original resource is unreachable, possibly due to a network error, or
because the server is not running

UNREACHABLE

The cached resource differed from the original and was not updated. Root
resources with imports (complex resources) are also set to out-of-sync if
any of the imported resources is new, out-of-sync or unreachable

OUT-OF-SYNC

The cached resource differed from the original and was updatedUPDATED

The cached resource differed from the original but was not updatedCHANGED-IGNORED

The cached resource differed from the original but was not updated because
the current user does not have permission

CHANGED-IGNORED
(NO-PERMISSION)

The resource was not updated, because unexpected content was retrieved
from the original location (for example badly formed xml)

CHANGED-IGNORED
(UNEXPECTED-
CONTENT)

The current user does not have permission to change this resourceNO-PERMISSION

The state was unknownUNKNOWN

Creating a Sync Tool

Sync tools enable you to track changes to external documents associated with artifacts in the repository.

To create a sync tool artifact:

1 In the Catalog Browser, click [+] next to Tools to expand it and show the list of tool types.

2 Click Sync Tools to open the Browse Sync Tools page.

3 Click New to open the Publish Sync Tool dialog box.

4 Input the following parameters:

DefinitionParameter

The name for the new sync toolName

A description of the sync toolDescription
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DefinitionParameter

Click add category to select a category from the available taxonomies
(administrator perspective only)

Categories

5 Click Save to create the new sync tool.

This new impact tool is now available for selection when creating a task, as described in Creating a Task
on page 316.

Policy Compliance Tools

Policy compliance tools validate whether artifacts conform with the requirements of one or more business
policies.

Perform a compliance check using the provided Validate Compliance tool and the reports generated are
described in detail in Chapter 18, Validating Artifacts.

Tasks and Scheduling
A task is an artifact which associates other artifacts or resources with a tool. You can imagine it as a tool
prepared for execution. A task is powerful way of performing an action on the same set of resources
repeatedly. The specified resources are used as input when the tool is run. A task can be run manually but
it is more usual to schedule automatic execution.

This section describes:

• Creating a Task on page 316

• Setting a Schedule on page 318

• Running a Task Manually on page 320

Creating a Task

Tasks are the way SOA Systinet associates a particular tool with a set of artifacts to produce reports.
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To create a new task:

1 Do one of the following:

• In the New menu of the Tools tab, click Task.

• Alternatively, in the Tools tab, in the Tasks and Reports portlet (see Tasks and Reports Portlet on
page 255), click New Task.

• Alternatively, in the browse view of tasks click New.

The Publish Task page appears.

2 Use Filter to search for the tool to associate with the task. Select the tool, and then click Next to select
the artifacts to examine.

3 The selector page includes the following options:

• For collections select an artifact type collection from the drop-down list.

• For documents, use Filter to locate the documentation artifacts to associate with the task and check
the radio button to select them, or click Add Documents and follow the wizard to select documents
from a selected collection.

• For saved searches use Filter to locate the saved search containing the artifacts to associate with
the task and check the radio button to select it.

Some tools do not require the selection of artifacts. For example, the report cleaner tool.

Click Next to set scheduling.

4 If you want this task to be executed at a set time or repeated on a periodic basis select Scheduled,
complete the details as described in Setting a Schedule on page 318, and then click Next to set the task
artifact name.

5 Optionally, edit the suggested name and description, and then click Finish to create the new task.
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Setting a Schedule

SOA Systinet enables you to execute tasks on a timed or periodic basis.

SOA Systinet converts and stores any input time to GMT. If you import scheduled tasks from
a data image, review the scheduling to ensure that the tasks execute at the local time that you
require.

To schedule a task:

1 Do one of the following:

• In the detail view of the task click Edit, and then select Scheduled.

• Select Scheduled during task creation.

• On pages allowing asynchronous operations, click Schedule Task.

The schedule parameters appear:
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2 Input the following parameters:

DefinitionParameter

A non-input field indicating whether the task is currently being executedRunning now

The last execution time of the taskLast run time

Select the frequency of execution if the task is to run periodically or none
if the task is to be executed once

Recurrence

Use the calendar to set the date and time for the initial execution of the taskFirst run time

If the task has a recurrence, optionally select Repeat Until, and use the
calendar to select the date and time to stop executing the task.

Repeat Until

If the task has a recurrence, optionally select Repeat Max, and input the
number of times to execute the task. This figure is compared to the

Repeat max

Automatically Repeated figure to determine whether to execute the task
again.

If the task has the Interval recurrence, input the interval.Custom Interval (min.)
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DefinitionParameter

Select to prioritize scheduled execution. If for any reason the task cannot
execute at the scheduled time (for example, if the server is not running),

Ensure scheduled run

then the task executes at the at the earliest opportunity. HP Software
recommend selecting this option for tasks with long recurrence intervals.

Select to prevent the automatic execution of the taskDisabled

Displays the number of scheduled executions (not including manual
executions).

Automatically repeated

To reset this figure, remove the schedule and then create a new
schedule.

3 Do one of the following:

• If you are editing a task, click Save.

• If you are creating a task, click Next and set the task name and description.

Running a Task Manually

You may want to immediately execute a task. If you have sufficient permissions, there is a Run option in
the detail view of the task.

To manually execute a task:

1 In the Tools tab Catalog Browser, expand tasks and click the task you want to execute.

The detail view of the task opens.

2 In the detail view of the task, click Run.

320



Reports
The result of a tool execution is a report. Reports are accessible from:

• The Reports link in the Catalog Browser.

• The Tasks and Reports portlet in the Dashboard and Tools tabs

• The Tools context menu in the detail view and service view of an artifact.

Clicking any of these links opens a report list view:
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Figure 77. Reports List View

Find allows reports to be filtered according to various categories. Simply select the category and the browser
only shows the reports which fulfill the given criteria.

The Report Data section contains output specific to each type of tool and is described in the report section
of each tool in Tools on page 303.
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22 Advanced Searches

You can use SOA Systinet to create customized queries that search the repository. These searches can be
stored and then reused. Saved searches can also be used to define a set of artifacts associated with a task or
used to create an RSS feed for the dashboard.

This chapter describes:

• Creating an Advanced Search on page 323

• Editing a Saved Search on page 326

• Running a Saved Search on page 327

Creating an Advanced Search
Each advanced search is associated with one type of artifact.

To create an advanced search:

1 Do one of the following:

• Click Advanced Search on any page.

• In the Tools browse view of an artifact type click Search.

The Search page opens:

323



2 To select the scope of your search, click Change Scope, and select the artifact types to search. De-
select all artifact types to search all artifacts.

Select Artifacts with Write Permission to restrict the search to artifacts you can modify.

3 Select the search parameters in the Search Criteria section:

DefinitionParameter

Select one of the following:Revisions

• Newest Revisions

Search for the latest revision of each artifact.
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Use Last Modified to locate only artifacts modified within the specified
time limit.

• Approved Revisions

Search the last approved revision of each artifact.

Use Last Approved to locate only artifacts approved within the specified
time limit.

DefinitionParameter

Select a stage to narrow your search to governed artifacts at that lifecycle
stage.

Lifecycle Stage

Select a compliance threshold to limit your search to artifacts within the
specified margin.

Compliance Status

Do one of the following:Match

• Select All these Criteria to find artifacts matching all the specified search
criteria.

• Select Any of these Criteria to find artifacts matching any one of the
specified search criteria.

By default, the page shows search entry criteria for Name. You can add
multiple search terms using Add Property and Add Ownership Criteria.

Search Terms

Select an artifact properties to use as a search parameter from the drop-down
list.

Add Property

The options available depend on the artifact type.

Select an ownership criteria to use as a search criteria from the drop-down
list.

Add Ownership Criteria

Select the output criteria from the drop-down list.Results per page
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4 Click Search to execute your query and view the results.

5 Optionally, click Refine Search to return to Step 2.

6 Optionally, save the search for later use, click Save Search to open the New Saved Search page.

7 If you are storing the search for later use, amend the search name, description, and details, and then
click Save to create the new saved search artifact.

Saved search artifacts are displayed in the Saved Searches section of the Services menu and you can also
access them from the Tools tab Catalog Browser by expanding the Search and Transform branch, and
clicking Saved Searches.

Editing a Saved Search
Although the saved search is persisted it can be modified again. There are two kinds of modification:

• Changing the name and description properties of the saved search.

• Changing the parameters of the search.

To modify a saved search:

1 Do one of the following:

• In the Tools tab Catalog Browser, expand the Search and Transform branch and click Saved Searches.

The Saved Searches page opens.

Click the name of the saved search to edit.

• In the Services tab menu Custom Views section, click the name of the search to edit.

The detail view of the saved search opens.

2 Do one of the following:

• To edit the basic search properties:

1 In the detail view of the saved search, click Edit.
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2 Change the properties as required, and then click Save.

• To modify the search parameters:

1 In the detail view of the saved search, click Redefine.

2 Do any of the following:

• Click Remove to remove criteria from the search.

• Add new conditions or modify the criteria as described in Creating an Advanced Search on
page 323.

3 Click Search to execute the modified search.

4 Click Save Search to save your changes.

Running a Saved Search
1 Do one of the following:

• In the Tools tab Catalog Browser, expand the Search and Transform branch and click Stored
Searches.

The Saved Searches browse page opens.

Click the name of the saved search to run.

• In the Services tab menu Custom Views section, click the name of the search to edit.

The detail view of the saved search opens.

2 In the detail view of the saved search, click Run.

The search results page opens.
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